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Chapter1 . . ..
| ntroduction

The Task Configuration Reference Guide presents detailed technical information about how to
configure FactoryLink tasks. The major audience of this guide includes users of FactoryLink
who need to build a FactoryLink application.

It is recommended that you use this guide as a reference while you are devel oping your
FactoryLink application.
TASKS BY FUNCTION

The tasksin this guide are arranged in alphabetical order. The following table provides a
functional listing of the tasks.

Function Task

Basic Functionality Alarms
Batch Recipe

File Manager

Math and Logic
Persistence

Print Spooler
Programmable Counters

Report Generator

Run-Time Manager
Scaling and Deadbanding
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Tasks by Function

Function

Task

Database Tasks

Database Browser

Database L ogger

Data Point Logger

Database Schemas

Historians
- ODBC
e Oracle
* SQL Server
e Sybase
« dBASEIV

PowerSQL

Graphics and Trending

Client Builder

Trending

Networking

FLLAN

PowerNet

Virtual Real-Time Network and Redundancy
(preferred for new applications)

Scripting

Math and Logic

Simulation

Waveform Generator and Sequencer

Timers and Counters

Event and Interval Timer

Event Time Manager

Programmable Counters
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Using this Guide

USING THIS GUIDE

General

Most of the tasks discussed in this guide use the Configuration Explorer. The information in
this guide identifies the location of the tasks, defines the fields and parameters, and explains
the usage of the tasks. For detailed information about the Configuration Explorer, see the
Configuration Explorer Help.

Procedures that can be done using the Client Builder are mentioned, along with references to
the Client Builder Help for detailed information.

The general organization of this guideis asfollows:

e Overview

 Operating Principles

« Configuration Tables (how to access and field descriptions)
* Program Arguments

e Error Messages

Configuration Tables

Accessing

In the Configuration Explorer, you can work with configuration tablesin the Grid Editor or in
the Form Editor. The principle method of showing the configuration tablesin this guideisin
the Grid Editor, but occasionally the Form Editor is used when it iseasier to explain afunction.
Which editor to useis a user preference.

The Accessing section identifies the path to open the configuration tables. Many of the tables
have a parent/child relationship. After aparent (control) tableis set up, the child table becomes
accessible. You can open the child table using either of these methods:

» Expanding the folders in the configuration tree and opening the appropriate table
 Using the Drill Down or Drill Up buttonsin the toolbar.
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Figure 1-1 Accessing Parent/Child Tables

Drill Down Drill Up
+ ;I ,ﬁ,larm Setup II'IFEIrlTlEltiEII'I Sequencer Control Informativag SHARED ( C:\Fiwgte? ) Q@
L. Er
= alarm Definition Béseex oF FE) 7@’@ I
-;;_u .ﬁ.larm DEFiI’IitiI:II'I CI:II'ItrI:Il Parent Sequence Name Trigger Tag Name Sequenge Count Tag Mame State Tag Mar
. Table ) 1 BATCH  fwavs_sequence_stal sa?/ flwave_seque
+ ETM Event Time Manager .
_\I g Sequence Output Information - SHARED - uence Qutput Inf... Q@
+-__| Waveform Generator FERTY 330 (F=ae o ?
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=148 BATCH o — ,
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+- @] Sequence Oukput Infor 5 [feve soquenes sta 0 8
Child
Table

| »

For detailed information about using the Configuration Explorer and understanding the user
interface, see the Configuration Explorer Help.

Field Descriptions

The Field Descriptions section provides a definition for each field that appearsin the
configuration table. With a configuration table open, you can obtain field-level help by
clicking in afield and then clicking the Help button.

The field descriptions may show the valid entry, valid data types, and default values for the
fields. The fields that do not show adefault value usually are blank. An asterisk (*) before a
field name denotes a field that accepts atag name or constant value as avalid entry.

Tip:  When working in the configuration tables, you can specify the value for
onefield and click the Save button to havethedefault val uesautomatically
appear in the other fields. If arequired field is not specified, a message
identifying the required field appears.

Tag Names and Data Types

The configuration tables may require avalid entry of atag name and avalid datatype. The
FactoryLink tasks use tag names to reference the tags in the real-time database. After atagis
defined, unlimited references can be madetoit. A datatypeidentifies the type of datathat will
be stored in the tag.

The Fundamental s Guide provides recommendations and guidelines for naming tags and a
description about the data types.
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Program Arguments

Program arguments are valid for the current revision of FactoryLink at the time of publishing.

Not all listed arguments and their parameters may be implemented in earlier versions of
FactoryLink.

Error Messages

The Error Messages section identifies the messages that may display on the Run-Time
Manager screen if an error occurs with the task during run time. In some cases, error messages
are also written to alog file. The location of thisfile isidentified in the appropriate tasks.

In some error messages, references to tags and elements are synonymous and are used
interchangeably.

TECHNICAL SUPPORT

If you have questions, contact your authorized Tecnomatix reseller or representative. For
additional support information, go to http://www.support.tecnomatix.com.
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Alarms

The alarmstask is used to define alarms and monitor them throughout an alarm cycle until the
tag value no longer meets the alarm criteria.

Alarming interacts with the historian task to write alarm records to a database. The alarm data
islogged to the relational database and/or to afilein atable or text format. The FactoryLink
Distributed Alarm Logger performslogging as the status of the alarm changes: when the alarm
occurs, when the alarm is acknowledged, or after an alarm has returned to the normal status.

At run time, the alarm task provides the operator the ability to view and manage the alarms
which have met the established alarm criteriain the real -time database.

Alarming offers several useful features:
 Custom configuration of the alarm criteria
« Defining acknowledgment requirements
 Deadband provision in the alarm criteria

» Saving alarm recordsto arelational database or aflat file to preserve the time of alarm and
alarm message for historical purposes

 Viewing alarms from multiple servers

« Customized Alarm Viewer to manage alarms as they occur, return to anormal status, and
are acknowledged

 Enabling arun-time visual accounting of the alarm and the associated factory process using
animations to represent factory subsystems

« Browsing alarm records previously logged to a database

+ An operator logbook allows operators to add notes to an alarm to document why the alarm
occurred, how it was corrected, or what is being doneto correct it. These entries are saved in
therelational database or afile when the alarms are logged.

« Notifying and acknowledging alarms using e-mail. Alarm e-mail notifications are sent to
designated contacts, who are assigned the role of acknowledging alarms or receiving the
notification for information purposes.
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OPERATING PRINCIPLES

The Distributed Alarm Logger task monitors tag values in the real-time database and compares
these values with the criteria defined by the devel oper in the configuration tables for the
Distributed Alarm Logger task. You can establish the criteria that generate an alarm for any
defined tag in the real-time database. If the value for the tag meets the criteria established for
alarming, an alarm message is displayed on the Alarm Viewer for the operator. The operator
monitors the alarm instances throughout the alarm cycle in the Alarm Viewer until the alarm
tag values no longer meet the alarm criteria.

The alarm criteria can be configured to require an acknowledgment from the operator. The
acknowledgment ensures the operator knows the alarm has been generated because the alarm
does not clear from the viewer until it is acknowledged. If you want to preserve the times and
occurrences of alarms, configure the Distributed Alarm Logger task to send the alarm datato a
disk-based relational database using an historian task.

You can configure the Distributed Alarm Logger task to distribute the alarm messages across a
network if you want the alarms to be viewed on more than one workstation. If the alarms are
being logged and acknowledged, the node names where they were acknowledged are included
in the alarm data sent to the relational database.

Alarm Logging Methodology

These steps describe how tags are monitored for alarm conditions and logged to a disk-based
relational database.

1 Thereal-time database receives and stores tag val ues from various sources, such as aremote
device, user input, or computation results from FactoryLink tasks.

2 TheDistributed Alarm Logger task reads and compares the tag values stored in the real-time
database with criteria defined in tables. These tables contain the configuration information for
the Distributed Alarm Logger task.

3 When the value of the tag meets the criteriafor an alarm, the Distributed Alarm Logger task
sends the alarm to the alarm server for display on the Alarm Viewer.

4 Each time the tag value changes, the Distributed Alarm Logger task evaluates the tag. If the
status has changed, the Alarm Viewer is updated.

5 When the value of the tag no longer meets the criteriafor an alarm, the Distributed Alarm
Logger task removes the alarm from the active alarm list. The alarm is cleared from the Alarm
Viewer. However, if the alarm has been configured to require an acknowledgment from the
operator, a status change to the alarm message occurs instead. The alarm is cleared from the
list when it is acknowledged.
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6 If thealarmsare being logged to arelational database, the Distributed Alarm Logger task sends
the alarm data to the relational database using a historian task each time a change occursin the
status of the alarm.

Establishing the Alarm Criteria

When the tag value meets the criteriato trigger an alarm, an alarm message is generated on the
Alarm Viewer for the operator. An example of thisis the alarming of the pressurein afuel
tank. A safe pressure is established as a reading of 0-1000:

« If the pressure exceeds 900, a HI alarm is generated to indicate the pending danger.

« |If the pressure exceeds 950, which could be critical, the alarm generatesa HIHI alarm.

In both cases, the tag condition is greater than (>) but each alarm is different. Asthe pressure
changes, the display is updated to reflect the new readings and messages. When the pressure
drops to 800, the danger passes and the alarms are no longer active.

The tag value must be checked against three components to establish this alarm:

e Limit—Thelimit isthe value the condition is checked against. The exampl e establishes the

limit as 900.

 Condition—The condition that triggers the alarm. In the example, the condition is greater

than.

» Deadband—The deadband is arange above or below the limit. The alarm stays activein this
range. The example uses a deadband of 100 (900-100 = 800).

The Limit and the Deadband can both be set with a constant value or the value from another
tag. Thefollowing valid condition settings generate alarms:

ON
OFF
TGL
HI, GT, HIHI or >

LO, LT, LOLO or <

GE or >=

An aarm istriggered when the value of the tag referenced is ON ().
An aarm istriggered when the value of the tag referenced is OFF (0).

An aarm istriggered when the value of the tag changes, such as a change
from ON (1) to OFF (0), from OFF (0) to ON (1), or if the change-status
bits of the tag are set by aforced write.

An alarm istriggered when the value of an analog or floating-point tag is
greater than the value specified by the Limit.

An alarm istriggered when the value of an analog or floating-point tag is
less than the value specified by the Limit.

An alarm istriggered when the value of an analog or floating-point tag is
greater than or equal to the value specified by the Limit.
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LE or <= Anaarm istriggered when the value of an analog or floating-point tag is
less than or equal to the value specified by the Limit.

EQ or = Anaarmistriggered when the value of an analog or floating-point tag is
equal to the value specified by the Limit.

NE or <> Analarmistriggered when the value of an analog or floating-point tag is
not equal to the value specified by the Limit.

Digital Tags
The behavior of adigital alarm with specified limits by tag typeisillustrated in Figure 2-2. The

diagram represents an alarm status of active and normal based on avalue, alimit, and
deadband range.

Figure 2-1 Digital Alarm Cycle

Active Active
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|
|
|
|
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TAG TAG

— Time — Time
TGL

Active

Normal | |

A TGL condition is unique because a
TGL alarm immediately returns to
normal status. It is not a true alarm state
1 and is used just as a notification. A TGL
alarm is not visible in the Alarm Viewer if
you do not configure the alarm to require
acknowledgment.

TAG

— Time
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Analog, Long Analog, and Float Tags

The principles of operations are identical when operating on anal og, longana or float tag types.
The smallest unit detected is dependent on the type.

The behavior of an analog, longana, or float tag types with specified limitsisillustrated in
Figure 2-2. The diagrams represent an alarm status of active and normal based on the value,
limit, and deadband range. All examples assume the Limit = 5 and Deadband = 2.

Figure 2-2 Analog and Float Alarm Cycles

LT

Active < Active

LE Normal l

<=

Normal

— Time — Time

NE

Normal Normal

— Time — Time

Message Tags

When there is a change in the value of a Message tag the value is checked to be equal or not
equal to the entire message defined as part of the alarm criteria.
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Alarm Status

Every time the value of an alarm tag is changed, the new value is evaluated against the alarm
criteria

If the tag value does not meet the alarm criteria, the status is considered normal.

If the tag value meetsthe alarm criteria, anew alarm is added to the active alarm list and the
statusis active.

If the dlarm is already active and the value no longer meets the criteria, it returnsto the
normal status.

If thetag returnsto normal and the alarm does not require an acknowledgment, it isremoved
immediately from thelist.

If the tag returns to normal and the alarm required an acknowledgment and has been
acknowledged, it is removed from the list.

If the tag returns to normal and the alarm requires an acknowledgment and has not been
acknowledged, it remains on the list until acknowledged and then is removed.

Theinitialization of an alarm causes the Distributed Alarm Logger task to log the message
to the relational database, providing the configuration is set to log alarms.

The Distributed Alarm Logger task maintains running counts of the number of alarmsin the
active queue at run time.

Alarm Categories

Categorizing alarms facilitates administration and analysis. Three methods are provided to
show related alarms:

Group Name—The group nameis assigned to a class of alarms. Group names can be
identifiers of the severity of the alarm, represent similar types such as pressure gauges, or
indicate a combination of any other characteristics.

Area—Theareais assigned to each alarm individually. More than one alarm can residein an
areaand alarmsfrom different groups can also reside together. An area can reflect aphysical
location such as the boiler room or an area of responsibility such as maintenance.

Priority—The priority isanumerical hierarchy assigned to each individual alarm. Use a
number between 1 (lowest) and 9999 (highest) to set priority. Multiple alarms can be
assigned the same priority number and multiple groups and areas can have common priority
numbers within them.

At least one Group Name must be established to define any individual alarms. All alarms must
belong to a group. The use of areas and priorities is optional. Categories enable filtering and
sorting of alarms on the Alarm Viewer.
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Parent/Child Relationship

The conditions which generate one alarm may also cause another related alarm to be
generated. When these relationships exist, you generally do not want to display the additional
alarms. For example, if the closing of avalve that feeds four different pipelines generates an
alarm, it is areasonable assumption that the lack of flow in each pipe would generate an alarm
based on the value of the flowmeter tag as shown in Figure 2-3. These resulting alarms would
not be important because you already know the flow has been cut off and why. This
relationship between the alarmsis identified as a parent/child relationship. In this example the
main valveis the parent alarm of each of the flow alarms. The resulting child alarms are not
displayed or counted as active alarms because they are aresult of the parent alarm.

Figure 2-3 Parent/Child Alarm Relationship
Child Alarm
Child Alarm

Parent Alarm
Child Alarm

Child Alarm

However, if the main valve is open and one of the individua pipeline flowmeters registers an
alarm, you would want to be advised. In this case the child is not dependent on the parent
because the child alarm was initiated on its own. Thisalarm is displayed and counts as an
active alarm.

Hide Alarms

Alarm hiding (sometimes referred to as masking) is done when you do not need to manage a
particular set of alarms. Alarm hiding is used in the following common situations:

+ Equipment maintenance
¢ Redundant systems
« Station functionality

» Bad sensor
Alarm hiding should not be confused with filters used with the Alarm Viewer. Alarm hiding
can be configured to disregard a particular set of alarms for viewing and/or logging purposes.

Alarm filtering selects specified alarms for viewing and suppresses other alarms from the
Alarm Viewer; however, the alarms are still being logged and tracked.
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Filtering is more common on multiuser or distributed systems. In these architectures, all users
have the ability to monitor all alarms. However, certain operators may be responsible for a
subset of these alarms. Filters enable operators to view only alarms they are responsible for on
the Alarm Viewer.

If analarm is hidden it does not act as a parent in parent/child relationships. To avoid potential
problems when the parent alarm is hidden, child alarms also must be hidden.

Global Hide Tag

The Global Hide tag is used most frequently in redundant systems. In redundant systems, one
nodeisthe master and all alarms are active for this node (Global Hide tag = 0). The slave node
or standby node has the Global Hide tag = 1.

Group Hide Tag

The Group Hidetag is used to hide equipment maintenance alarms. The devel oper must ensure
that alarms are grouped by machine, so when a maintenance cycle begins, those alarms can be
hidden.

There are three mask settings:

» Hide—hides alarm from the Alarm Viewer and the output alarm database

¢ Show—shows alarms on the Alarm Viewer and allows writing to the alarm database
+ Event—hides alarm from the Alarm Viewer, but showsit in the alarm database

The Group Hide tags are a so used to define station functionality. Thisisaspecial case because
anode may have multiple functional requirements. For example, a node may function asa
simple operator station for only one piece of equipment one day. The next day the same node
may be the supervisor's station for all of the equipment. Groups are hidden based on the node
functionality.

Individual Hide Tag

In some systems, individual alarms may need to be hidden to silence an alarm because of a
malfunctioning sensor. When the sensor is repaired, the alarm needs to be monitored again.

Remote Group
Thereis no hiding function for alarms received from remote groups. Alarms should be hidden

at the server node. If you do not want to view the alarms, create afilter in the Alarm Viewer so
the alarms do not show.
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Event Alarms

Event darmsare any alarmsthat arelogged to a database but are not processed for viewing and
acknowledgment. This provides the archival of the alarm condition without operator required
processing. To configure an event alarm, use the Group Hide Tag or the Alarm Hide tag.

Locally Redefined Unique Alarm IDs

For networked systems, if alocal Unique Alarm ID definition can be created and it matches a
remote Unique Alarm ID, the alarm appears asif it isalocal alarm. The Distributed Alarm
Logger task must be running on the remote node. In addition to reporting alarms as if they
were local alarms, this configuration provides the message text from the remote system to be
displayed on the Alarm Viewer.

Alarm Persistence

Alarm persistence is the storing of current information about the status of active alarmsand the
child alarms at user-defined intervals. At startup the information is read preserving important
information, for example, initial time and acknowledgment information.

Alarm persistence is activated by placing a-w on the program arguments field of Distributed
Alarm Logger task line in the Shared domain and by configuring and running the Shared
domain persistence task with atrigger in the Timed Save Trigger field, which causes the
system to save the alarm persistence information each time the persistence trigger is set. The
system then saves the Distributed Alarm Logger task information to thefiles:

o {FLAPP}/{FLNAME}/shared/al_log.prs
» {FLAPP}/{ FLNAME}/shared/al_log.bak

If the *.prs fileisunable to be read at startup, the *.bak file is used instead.

The a_log.prsfileis updated at the time the Distributed Alarm Logger task is shut down and
on aPersistence Timed Trigger change. Theal_log.bak file is updated on a Persistence Backup
Trigger change. For more information about the persistence function, see “ Persistence” on
page 377.

Upon restart of the Distributed Alarm Logger task, thea_log.prsor a_log.bak file isread into
memory, and all alarms are checked for validity.

The active dlarms are stored using their Unique Alarm 1D number. If you have not defined a
Unique Alarm ID in the alarm definition, oneis defined at startup. If the configuration does not
change, each alarm receives the same Unique Alarm ID asit did the previoustime at startup. If
the configuration changes, however, each Unique Alarm ID could be altered, and the
Distributed Alarm Logger task could potentially load persistence information for incorrect
alarms or not load persistence information.
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Alarm Distribution

Alarms can be distributed over the network using the FactoryLink Local Area Network. Each
node can share one or more groups of alarms with other nodes. The alarm is originated on the
nodeit isdefined on and is seen and acknowledged from other nodes that have been configured
to receive information on that particular alarm. When the alarm is acknowledged, either at the
source or at the remote, the source node accepts the acknowledgment and updates the new
alarm status. All nodes receiving information on the alarm are updated.

Alarm Logging

If you want to preserve the time of alarm, alarm data, and the node that acknowledged the
alarm, you can configure Distributed Alarm Logger task to read data from the tagsin the
real-time database and send the data to a disk-based relational database or to atext file. Data
logged to arelational database is then available for browsing through the FactoryLink
Database Browser or other browser program.

The Distributed Alarm Logger task logs data to arelational database using the same
methodology as the FactoryLink Database Logger. The dataislogged in atable format using a
historian task. Alarm instances are logged at a status change: as the alarm occurs, when the
alarm is acknowledged, or an alarm returns to the normal status. The tables for alarm logging
output and their associated schemas are already defined for the Distributed Alarm Logger task.

If aremote group has logging turned on but no database information is defined on the client
node, no information islogged. This condition does not result in the display of an error
message.

When aremote node shuts down and restarts or reconnects after acommunication failure with
the same alarm till active, the logger tries to insert the alarm into the database twice. This
condition results in generating a Duplicate Entry error.

The record length is determined by the size specified in the Message Size field of the Alarm
Archive Control Information table in the Distributed Alarm Logger Setup table.
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Table 2-1 and Table 2-2 describe the schema layout used to build the alarm entry table.

Table 2-1 Alarm Entry Table Schema

Column Type Array Description

SEQ NUMBER 1 Sequence Number of the alarm

AID NUMBER 11 Alarm ID number

NAME CHAR 48 Alarm TAG name

GRP CHAR 16 Group alarm belongsto

AREA CHAR 16 Areaaarm belongsto

PRIO NUMBER 6 Priority of the alarm

ITIME CHAR 30 Initial Time (yearmodyhrmisc.mse)
ATIME CHAR 30 Acknowledge Time (yearmodyhrmisc)
NTIME CHAR 30 Normal Time (yearmodyhrmisc)
DUR NUMBER 11 Alarm Duration in seconds

MSG CHAR 162 Alarm Message

VAR1 CHAR 44 Variable 1 value at Initial Status
VAR2 CHAR 44 Variable 2 value at Initial Status
VAR3 CHAR 44 Variable 3 value at Initial Status
VAR4 CHAR 44 Variable 4 value at Initial Status
OPR CHAR 8 Name of operator who acknowledged

thealarm
Table 2-2 Alarm Entry Column Schema
Index Unique Column list

1 YES SEQ + ITIME.

Logbook
Entries to the logbook are indicated by an asterisk in the Logbook field on the Alarm Control

Viewer. Thelogbook datais viewable using the Database Browser. See Client Builder Help for
more information on the Alarm L ogbook.
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CONFIGURING ALARMS

Alarms are configured in the server application and client project.This section explains how to
locate the alarm tables, the definitions of the table fields, and the general design of the Alarm
Viewer. Instructions for how to configure the Alarm Viewer are in the Client Builder Help.

The examples in this section are from the starter applications that are supplied with the
software. These applications provide tables with preconfigured data to illustrate proper
configuration of the fields. It is recommended that you use a starter application as the basis for
your application. Thiswill make configuration faster and easier.

Set Up Alarm Groups

The Alarm Group Control tableis used to define the properties assigned to each alarm group.
There must be at least one group defined for your application. All alarms must be a member of
agroup.

Color and sound information in the Alarm Group control table do not transfer to the Client
Builder Alarm Viewer. These features are individually configured in the Client Builder
application. If you are viewing alarms using ECS Graphics, colors and sounds can be
configured in the Alarm Group Control table.

Three groups are preconfigured for default purposes: WARNING, CRITICAL, SYSTEM.
These can be used or deleted as required.

Accessing
In your server application, open Alarms > Distributed Alarm Definitions > Alarm Group Control.
Field Descriptions

Note: Thefieldsmarkedwithanasterisk (*) arenot passed to the Client Builder Alarm
Viewer. They are only recognized by the alarm task in ECS Graphics.

Group Name A string to identify the Alarm Group (required field).
Valid Entry: up to 16 uppercase a phanumeric characters
Group Text Group message text that can appear with the output of each individual alarm
message

An optional field but important to assist determining the alarm group when
the message is output to a database or to the Alarm Viewer.

Valid Entry: up to 40 alphanumeric characters
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*Group Composite Tag updated by the Alarm task that stores the code number representing the
Status Tag current status of all alarmsin a particular alarm group

Valid Data Type: analog

Valid Entry: tag name
0: (IDLE) No alarmsin the group are active.
1: (NORMAL)AL least one dlarm in the alarm group is
unacknowledged and has returned to normal.
2: (ACK)At least one alarm in the alarm group is active
and has been acknowledged.
3: (ACTIVE)At least one alarm in the alarm group is
active and unacknowledged.
11: (NORM/ACK)ALt least onealarm inthe alarm group is
unacknowledged and has returned to normal and one
other alarm is active and acknowl edged.

*Group Number Tag updated by the Alarm task that stores the number of active alarmsin
Active Tag thisgroup

Valid Data Type: analog
Valid Entry: tag name
ACK Indicatesif the alarms belonging to this group need to be acknowledged

Note: If thisfield isset to YES or RST, the Unack Alarms Count Tag field in the
General Alarm Setup Control table counts the unacknowledged alarms.

Valid Entry: NO: Noacknowledgment required. Thealarm disappears
from the active list when it returns to normal.
YES: The alarm must be acknowledged.
RST: Theaarm must be acknowledged but not until the
alarm has returned to normal. Thisfield can be used to
reset alarmsinthe PLC or controller in conjunction with
the alarm status.

Default: NO

*AUD Determinesif the alarms belonging to this group produce an audible signal
when the alarm statusis active

Valid Entry: NO: Theaarmsin thisgroupwill not produce an audible
signal.
YES: The alarm produces an audible signal whenitis
active. Thealarmsinthisgroup areincludedinthe count
maintained by the Audible Alarms Count tag in the
General Alarm Setup Control table, which may be used
to send asignal to an external device.

Default: NO
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*Alarm Stat Print
Dev

*LOG

*Log Method Tag

*Initial FG Clr

*|nitial BG Color

Print device number that corresponds to the line number of the printer
device defined in the Print Spooler Information table.

If configured, alarm records are printed when generated or when thereisa
change in the alarm status.

Valid Entry: numeric print device number (Use O to disable)
Default: Blank, no printing is enabled.

Specifiesif group aarms are logged to a database or to aflat file

Valid Entry: NO or N: No logging.
YES or Y: When an alarm is changes status, it is logged
to arelational database
FILE or F: When an alarm changes status, it islogged to
atext or flat file.

Default: NO
Tag that enables arun-time change of the logging method.

When set to the value 1, the alarm records are written to a database unless
the database cannot be accessed. If this occurs, the alarm records are
automatically written to afile as specified in the Device field of the Print
Spooler Information table. To return to database logging, the operator must
manually reset thistag to avalue of 1. A run-time change istypically
initiated using an animated graphic in the Client Builder program for an
operator. A developer might use the Run-Time Monitor (RTMON) utility to
reset the tag for troubleshooting purposes.

Valid Data Type: anaog

Valid Entry: tag name
0: Run-time change of alarm logging is disabled.
1: Alarmlogging is enabled to a database historian.
2: Alarm logging is enabled to afile.

Default: 0
Indicates the foreground color of an adarm in the initial status.

Valid Entry: acolor or NONE
Default: Red

Indicates the background color of an larmin theinitial status.

Valid Entry: acolor or NONE
Default: Blk
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Indicates whether or not thealarm blinksin theinitial status. The speed may
be chosen. YES blinks slowly.
Valid Entry: NULL, NO, YES, N, Y, SLW, FST
Default: No

Indicates the foreground color of an alarm in the acknowledged status.

Valid Entry: acolor or NONE
Default: Grn

Indicates the background color of an aarm in the acknowledged status.

Valid Entry: acolor or NONE
Default: Blk

Indicates whether or not the alarm blinks in the acknowledged status. The
speed may be chosen.
Valid Entry: NULL, NO, YES, N, Y, SLW, FST
Default: NO

Indicates the foreground color of an alarm in the normal status.

Valid Entry: acolor or NONE
Default: Ye

Indicates the background color of an aarm in the normal status.

Valid Entry: acolor or NONE
Default: Blk

Indicates whether or not the alarm blinksin the normal status. The speed
may be chosen.

Valid Entry: NULL, NO, YES, N, Y, SLW, FST
Default: NO

Determinesif the alarm messages are recorded and displayed for this group.
At startup, some alarms can be generated that do not represent true alarm
conditions. To avoid viewing these startup alarms, they are hidden. When
startup is complete, the operator can select to process all alarms again.
Event alarms are any alarms that are logged to a database but are not
processed for viewing and acknowledgment.

Valid Data Type: digital, analog
Valid Entry: tag name
0: Alarms processed

1: Alarms not processed (hidden)
2: Event alarms (no filtering required)
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Notification Group Name for contact group that will receive an e-mail message about the
alarms in this group.

Valid Entry: up to 80 alphanumeric characters (case-sensitive)

E-mail Subject Short text message that appears at the beginning of the Subject line of an
e-mail message transmitted by the corresponding Notification Group. This
message is followed by the Alarm ID and Sequence Number.

Valid Entry: up to 48 alphanumeric characters (case-sensitive)

Define Alarms

Alarms are defined using two tables: The Alarm Definition Information table identifies the
alarms associated with each group and the properties of each individual alarm, and the Alarm
Relations Information table identifies the parent/child relationships between the alarms.

The basic definition of an alarm isto enter atag name for the alarm identity and to establish the
conditions which generate the alarm.

Note: Setup of the alarm group controlsis essential before alarm records can be
defined. All alarms must be defined within a group.

Accessing

In your server application open Alarms > Distributed Alarm Definitions > Alarm Group Control >
“group name” > Alarm Definition Information.

Field Descriptions
Unique Alarm ID A number that identifies the alarm record in the network

Each alarm on the network must be identified with a different number. If a
number is not defined, a unique number is assigned by the al_|log task. The
assigned number is an internal number which does not appear in atag field.
It isimportant to note that the assigned number changes when the system
configuration changes. If you define your own unique numbers, they will
not change as the configuration changes.

Thisfield is required for establishing Parent/Child relationships between
alarms. If Parent/Child relationships are needed for any alarms, all alarm
records in the application must have a Unique Alarm ID.

Valid Entry: 1 to 999999

Alarm Tag Name Name of thetag to be evaluated for an alarm condition (required)
Valid Data Type: digital, analog, longana, float, message

Valid Entry: tag name
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Determines the status of the alarm for digital alarms or TGL conditions. It
also specifies the type of comparison of the alarm Limit value to the
Deadband value in respect to current conditions.

Valid Entry:

Default:

OFF: Off status or O for adigital tag

ON: On status or 1 for adigital tag
TGL:Changed status

LOLO<LOorLT: Lessthan the limit

HIHI > HI or GT: Greater than the limit
<=or LE: Lessthan or Equal to the limit
>= or GE: Greater than or Equal to the limit
= or EQ: Equal to the limit

<> or NE: Not Equal to the limit

ON

If aTGL condition is established, the alarm vanishes as soon asit is
detected because it immediately returnsto normal. If the alarmis
configured to require operator acknowledgment, the alarm is visible until it
is acknowledged and then clears from the display. Alarms are logged to a
relational database regardless of whether the alarm configuration requires

acknowledgment.

Not all conditions arevalid for al tag types. Table 2-3 shows the conditions

supported by each tag type.
Table 2-3 Supported Conditions for Each Tag Type
Condition Digital Analog | Longana Float Message | Mailbox

ON X

OFF X

TGL X X X X X
LOLOLOLT< X X X

HIHI X X X

HI GT >

LE<= X X X

GE>= X X X

EQ= X X X X X
NE<> X X X X
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Limit A value used in conjunction with the Cond. and Deadband fields to
determine an dlarm condition. If atag is defined for thisfield, it must be the
same data type as the Alarm Tag Name and the Deadband field.

Valid Data Type: anaog, longana, float, message, digital
Valid Entry: tag name or constant
Deadband A value above and/or below the Limit value that determines an active alarm
status.

The relationship of the Deadband value to the Limit is specified by the
setting in the Cond. field. Once the alarm istriggered, it remains active until
it moves past the deadband amount. If atag isused, it must be the same data
type as the tag in the Alarm Tag Name and the Limit field.

Valid Data Type: analog, longana, float
Valid Entry: tag name or constant

Message Text Text that can be output to the Alarm Viewer, written to the alarm database,
or output to a graphical animation.
Valid Entry: up to 160 a phanumeric characters
Variable (1-4): Tags used as part of the alarm message when printed to afile, displayed in

the Alarm Viewer, or written to a database. At run time, the values in these
fields are substituted for the corresponding variable.

Valid Data Type: anaog, longana, float, message, digital
Valid Entry: tag name
The Message Text field can include more than one variable, but the run-time display has

constraints as shown in Table 2-4. Message text exceeding the maximum allowable number of
characters per variable is truncated on the display.

Table 2-4 Variable Specifier Lengths in the Message Text Field

If the number of different $VAn$ The maximum number of characters
specifiers is... displayed per specifier is ...

4 11

3 14

2 22

1 44

Embed the individual format variables ($VA1S$, $VA23$, $VA3S$, and/or $VA4S) in the text
included in the Message Text field. For example, the Message Text field can contain the string:
“The current status is $VA1$.” Thetagin the Variable 1 field is Status tag. When the alarm is
generated the current value of the tag in the Variable field, in this case the Variable 1 field,
replaces the specifier when it appears on the Alarm Viewer. This value remains the same while
the alarm instance is displayed on the Alarm Viewer.
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To designate avariable that can be monitored for changing value, use format specifiersin the
Message Text field instead of the $VANS specifiers. Variable specifiers consists of two types:

 Ordinary characters, which are copied literally to the output stream

» Format specifiers, which indicate the format in which variable information will display

For information about format specifiers, see Appendix, “ Format Specifiers.”

Priority

Area Name

Time-stamp Tag

Time-stamp
Format

Use Global Hide

Specifies the priority of the alarm for filtering and sorting purposes.

Valid Entry: 1to 9999
Default: 1

Tag that provides an additional key for filtering and sorting purposes.
Valid Entry: up to 16 alphanumeric characters

(Required if Time-stamp Format is specified) Message tag to specify the
exact time an alarm status changed as aresult of an operator process, such
as acknowledgment.

If no tag is defined, time-stamping is determined when the change is
detected by the Distributed Alarm Logger task.

Valid Data Type: Message
Valid Entry: tag name

Setsthetime-stamp format of the alarm for the Time-stamp Tag field. If this
field is specified, you must configure the Time-stamp Tag.

Valid Entry: NULL: No formatting
USA: USA time format (YYMMDDHHMMSS)
EUROPE: European time format (DDMMYYHHMMSS)
USA_HS US: A time format with 1/21000 sec.
EUR_HS: European time format with 1/1000 sec.
USA L: Long USA time format
EUROPE_L: Long European time format
USA HSL: Long USA time format with 1/1000 sec.
EUR_HSL: Long European time format with 1/1000 sec.

Used only when the Global Hide Tag in the General Alarm Setup Control

tableis set to ON. When an alarm is generated and the Global Hide Tag is
set to 1 (ON), the alarm is not displayed. When an alarm is generated and

the Global Hide Tag is set to O (OFF), the alarm is displayed.

Valid Entry: Y or YES: Do not show alarm. (TheGloba Hide Tagfield
in the General Alarm Setup Control table must not be
blank for this feature to work.)

N or NO: Whenan alarmisgenerated, thealarm displays.
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Alarm Hide Tag

Status

Tag indicates how an individual alarm is processed. Event alarms can be
defined to log for tracking purposes but do not require viewing and
acknowledging. Individual tags defined using this method require operator
change to each record to allow processing.

Valid Data Type: digital, analog

Valid Entry: tag name, whose value at runtimeis:
2: Log to database; do not put dlarmin activealarm list.
1: Thealarmisnot processed (not logged or put in active
darmlist).
0: Thealarmisprocessed (logged and put inactivealarm
list.
Tag updated by the Alarm task that storesthe current value of thisalarm in
the active alarm list. Interpretation of the status code values is dependent
upon the tag type. See Table 2-5 for code definitions and values at run time.
Valid Data Type: digital, analog

Valid Entry: tag name

Table 2-5 Run-Time Status Values

Status

Analog | Digital

Definition Tag Tag

Initial An activealarm; an alarm that hasitsalarm criteriamet. The | 3 0
alarm remains in this status until there is operator action.

Acknowledged | The alarm status which occurs when the operator 2 1
acknowledges an active alarm. The alarm remains listed on
the Alarm Viewer after acknowledgment until the alarm
criteriareturn to normal. (Only alarms in groups configured
to require acknowledgment will remain listed on the Alarm
Viewer after areturn to normal status occurs.

Normal and not | The criteriathat triggered the alarm hasbeenremoved but | 1 0
acknowledged | the operator has not performed the acknowledgment
function.

Idle Thereis presently no criteriato trigger this alarm and the 0 0
alarm does not need acknowledgment from prior alarm
condition.

Notification Group

Name for contact group that will receive an e-mail message about the
specific alarm.

Valid Entry: up to 80 alphanumeric characters (case-sensitive)
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E-mail Subject Short text message that appears at the beginning of the Subject line of an
e-mail message transmitted by the corresponding Notification Group. This
message is followed by the Alarm ID and Sequence Number.

Valid Entry: up to 48 alphanumeric characters (case-sensitive)

Define Parent-Child Relationships

The Alarm Relations Information table establishes a hierarchical relationship between alarms
with related functionality as shown in Figure 2-4.

Figure 2-4 Parent-Child Relationship Tables
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Parent-child alarm relationships are based on the parent alarm status. When achild darmis
initiated within the defined child alarm delay, it is hidden if the parent alarm isin the ACTIVE
status. The child alarm is activated when the parent alarm returns to NORMALL. If the parent
alarm isaready in the NORMAL status, the child alarm is activated immediately.

Each alarm can have multiple parent/child relationships. Alarms defined in aremote group can
never act as achild alarm. A parent alarm must have a defined Unique Alarm ID to create the
child alarms on the local node.

Each alarm is evaluated by the Distributed Alarm Logger task and compared to its parent/child
relationship prior to displaying.
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o If thealarmisaparent, it is displayed.
 If thealarmisachild and the parent statusis not active, the child is displayed.

 If thealarmisachild and the parent statusis active, the child alarm is disregarded or
displayed based on delay criteriayou establish in the relationship.

In the parent/child relationship, two kinds of delays can be specified: child alarm delay and
child recovery delay. These delays specify the time allowed between the generation or clearing
of aparent alarm and the activation of a child alarm unrelated to the parent.

Child Alarm Delay

The length of time a child alarm is suppressed after a parent alarm is triggered is the child
alarm delay.

The conditions that generate both the parent and child alarms must return to normal to allow
the alarm statuses to return to normal. When both have returned to normal, the parent/child
relationship is reestablished. At the next invocation of the parent, the timer is started again to
inhibit the display of the child alarm for the child alarm delay period. These concepts are
shown in Figure 2-5, Figure 2-6, and Figure 2-7.

Figure 2-5 Child Alarm Delay - Child is Suppressed

Parent Alarm Alarms Displayed
Parent 1 10:00 Parent 1
Child Alarm
Delay
Child Alarm 15
Child 1 10:10

Figure 2-6 Child Alarm Delay - Child is Not Suppressed

Parent Alarm Alarms Displayed

Parent 1 10:00 Parent 1
Child 1
Child Alarm
Delay
i 115
Ch!Id Alarm 10117
Child 1
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Figure 2-7 Child Alarm Delay - Child Alarm Only

Parent Alarm N5 Alarms Displayed
Parent 1 Alarm Child 1
Child Alarm
Delay
Child Alarm 15
Child 1 10:15

Child Recovery Delay

The length of time a child alarm is provided to return to normal status after a parent alarm has
been returned to normal statusisthe child recovery delay.

In the previous example, the main valve causing the generation of the parent alarm was shut
off. This generated the four pipeline alarms but they are disregarded because they are
redundant. If the main valve is now turned on, the flow should return to all four pipelines. The
child recovery delay provides sufficient time for a child alarm status to return to normal. If the
child status cannot return to normal in thistime period then the child alarm generates an alarm.

After the child status has returned to normal, and the parent has a normal status, the
parent/child relationship is reestablished. Figure 2-8 and Figure 2-9 illustrates these concepts.

Figure 2-8 Child Recovery Delay - Child Recovers

I Return to Alarms
Parent Alarm 10:00 Normal Displayed: none
Parent 1
Child ]
Recovery 10:01
. :05
Child Alarm
Child 1 Suppressed 10:04
Figure 2-9 Child Recovery Delay - Child Alarms
Alarms
Parent Alarm 10:00 ﬁeturnlto Displayed:
Parent 1 ormal Child 1
Child _ alarmed
10:01 :
Recovery SR
. .05
Child Alarm
Child 1 Suppressed 10:15

FactoryLink Task Configuration Reference Guide / 29



2 | ALARMS
Configuring Alarms

TGL type alarms should not be configured as parent alarms. When aTGL alarm is generated it
becomes ACTIVE and immediately returnsto NORMAL. A TGL aarm never remainsin the
ACTIVE status. Using a TGL alarm as a parent would result in the child alarm never being
hidden. An alarm can be a child to more than one parent alarm.

Parent Alarm ID  Unique Alarm ID of the parent alarm. An entry isrequired for each
additional parent if the child is subordinate to more than one alarm.

Valid Entry: The parent Unique Alarm ID, 1 to 999999

Child Alarm Delay Delay between the activation of the parent alarm and the activation of the
child darm. The parent always hides the child alarm if no delay time is
entered. The child alarmis not displayed if atime is entered and the child
alarm is activated within that period. The child alarm displaysif atimeis
entered and the child is activated after that period.

Valid Entry: 1 to 30000 (seconds)

Child Recovery Delay between the return to normal of the parent and child alarms. A child
Delay aarmisnot displayed if the parent and child return to normal within the
delay period. The child alarm is generated if the parent returns to normal
and the child does not within that period.

Valid Data Type: Numeric
Valid Entry: 1 to 30000 (seconds)

Set Up Database Archive Requirements
Accessing

In your server application, open Alarms > Distributed Alarm Logger Setup > Alarm Archive
Control.

The Alarm Archive Control tableis used to identify the database or file where the dlarm datais
stored. Any relational database supported by FactoryLink can be used to log alarms. If you
start a new application, default field names are provided to write to SQL Server or the internal
dBASE |V file format. You must also configure the historian database tables to select the task
which corresponds to the type of database you want to use to log alarm records.

Alarms are logged as soon as they are generated. The Logger task (AL_LOG) performs and
controlsall alarmlogging. Theinternal database createsthe files using the configured structure
depending on the selection made at FactoryLink Installation.

To configure logging to atext file and archiving the text files, configure the Log File Trigger

and Log File Directory filesin thistable and either the Log field or the Log Method Tag field
in the Alarm Group Control table. Also, the Database Alias Name from the Alarm Archival
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Control table must be entered in the Database Alias Name field on the appropriate Historian
Information table if alarm dataislogged to arelational database.

Field Descriptions

Database Alias Field contains an alias for the path and folder (directory) location of the
Name relational database that stores the alarm data. The path for the dliasis
defined in the Historian Information table.
Valid Entry: up to 16 alphanumeric characters
Default: ALOG
Alarm Table Name Table namein the relational database that stores the alarm data. This name
becomes a table name with the format of eight characters for the name and
three characters for an extension. For example, the name ALARMS
becomes a table name of ALARM S.dbf.
Valid Entry: up to 16 aphanumeric characters
Default: ALARMS
Logbook Table Table namein the relational database that stores the alarm logbook data.
Name
Valid Entry: up to 16 alphanumeric characters
Default: LOGBOOK

Historian Mailbox Tag that stores each alarm message. If multiple messages are received, they
are queued until they are written to the database.

This tag name must also be entered in the Historian Mailbox field in the
Historian Mailbox Information table for the selected database.

Valid Data Type: Mailbox

Valid Entry: Mailbox tag name
Default: ALLOG_HIST_MBX

History Max Maximum number of recordsin adBASE IV historian database. The oldest
Records record is overwritten when the maximum number specified is reached.

Note: If anumber isnot specified, therecordswill continueto bewritten to the storage
mediauntil it isfilled to capacity.
Valid Entry: 1to 1000
Default: 1000

Message Size Size of the message column when it is saved into the alarm in the rel ational
database.

FactoryLink Task Configuration Reference Guide / 31



2 | ALARMS
Configuring Alarms

If the message size is changed after the tables are generated, you need to
alter or drop the existing tables from the database to prevent errors.

Valid Entry:
Default:

Timestamp Fields
Data Type

Valid Entry:

Default:
Log File Trigger

1to 128
80

Specify the datatype to use when logging the alarms table timestamp fields.

CHAR—Fixed length character string formatted as
“yearmodyhrmisc.mse” where

year = Year

mo = Month

dy = Day

hr = Hour

mi = Minute

sc = Second

mse = Millisecond

DATE—Native date/timefield, which may truncate the
millisecond value depending upon the capacity of the
database's native date/time field type.

CHAR

Tag that initiates saving the currently queued alarms to a backup alarms text

file. Thistag istypically initiated using a graphical representation of the
field which receives the trigger input. All the associated fields to save
alarmsto afile must be configured.

Valid Data Type:
Valid Entry:

Log File Directory

Valid Entry:
Default:
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Set Up General Alarm Counters

The General Alarm Setup Control tableis used to configure the tags that maintain counts of the
aarmsin the various states and the counts maintained by the Distributed Alarm Logger task.
Default tag names are preconfigured for the user. The values of these tags can be monitored
from a graphical representation of the system using Client Builder.

Accessing

In your server application, open Alarms > Distributed Alarm Logger Setup > General Alarm

Setup Control.

Field Descriptions

Active Alarms

Global Hide Tag

Unack. Alarms
Count Tag

Maximum number of active alarms allowed. If more alarms are active than
specified, an error message is displayed and the lowest priority alarm with
the oldest time is removed from the list.
Valid Entry: 1to 721
Default: 100

Tag that hides alarms.

This tag works in conjunction with the Use Global Hidefield in the Alarm
Definitions table. Any alarm with the Use Global Hide field set to YES is
hidden when thisfield is set to 1.

Thisfield isused in conditions when reported alarms are not significant, for
example, at startup timewhen alarms are reported because the applicationis
not fully initialized. Alarms can be hidden until operations are stabilized.
Global hide cannot be activated if thisfield is blank.
Valid Data Type: digital
Valid Entry: tag name
0: Show and process alarms

1: Do not show or process alarms
2: Event dlarms

Tag updated by the Alarm task that contains the number of alarmsin the
current unacknowledged status. Thisfield isrequired for alarm
acknowledgment.

If the ACK field of the Alarm Group Control tableis set to YES or RST, a
tag namein this field must be maintained.

Valid Data Type: analog

Valid Entry: tag name
Default: ALLOG_UNACK_COUNT
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Active Alarms
Count Tag

Audible Alarms
Count Tag

Print Active Alarms
Tag

Active List Print
Device

Remote
Notification
Disable

Tag updated by the Alarm task that contains the number of current active
alarms.

Valid Data Type: analog

Valid Entry: tag name
Default: ALLOG_ACTIVE_COUNT

Tag updated by the Alarm task that contains the number of unacknowledged
alarms that have the audible flag set to YES.

If the AUD field of the Alarm Group Control tableis set to YES, atag name
in this field must be maintained.

Valid Data Type: anaog

Valid Entry: tag name
Default: ALLOG_AUDIBLE_COUNT

Tag that triggers the Distributed Alarm Logger task to update the file
{FLAPP}/alarms.txt and print alist of al active alarms. (Alarms.txt isa
default file name. Any name can be used.)

Valid Data Type: digital

Valid Entry: tag name
0: OFF
1: ON, print list
Default: ALLOG_PRINT_TRIGGER

Designates the print device or file where the active alarm output messages
arerouted. The number in thisfield corresponds to the line number of the
print device identified in the Print Spooler Information table (For more
information, see “Printing Alarms’ on page 45.) Select the table line
number that corresponds to the correct print device for the Alarm Stat Print
Dev field in the Alarm Group Control table. An option to print to afile can
also be selected using the same method. When printing to afile, the
pathname of the file is defined in the device field instead of the device
name.

Valid Entry: any positive integer
0: disables printing
Any other number isthe line number of the print device.
Default: 0
(Optional) Name of adigital tag that enables or disables the remote e-mail
notification feature, system-wide. If not specified or if specified and the tag

is set to a0, remote notification is enabled. If specified, and thetagis set to
al, remote notification is disabled.

Valid Entry: tag name
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USING ALARM E-MAIL NOTIFICATIONS

An alarm or event defined in the alarm logger can be configured to use the e-mail notification
agent to acknowledge an alarm by using an e-mail reply from contact recipientsin a
notification group. Whenever the alarm or event’s status changes, an e-mail notification can be
sent to specified contacts. Some contacts may be required to acknowledge an alarm while
others need only beinformed. If a contact fails to be notified within a specified amount of time,
the alarm notification can be escalated to an alternate contact. Other contacts who are not
required to acknowledge the alarm can be designated to receive an alarm notification.

If aclient acknowledgesan alarmin Client Builder, the acknowledge event is sent to the e-mail
agent and the agent will notify all necessary contacts. Any pending outgoing e-mail pertaining
to the original aarm will not get processed.

Figure 2-10 illustrates how an alarm notification is processed. © shows atag configured for
alarmsisin the active state. The alarm logger sends the alarm 1D, sequence ID, and
notification group information. At @, the e-mail agent sends the alarm information to all
contactsin the notification group. At ®, arecipient responds to the e-mail and acknowledges
thealarm. At @, the alarm logger verifies the contact is authorized to acknowledge the alarm
and then formally notifies the alarm logger task that the alarm has been acknowledged. At ®,
the alarm logger sends an acknowledge event to the e-mail agent with the alarm 1D, sequence
ID, and notification group. (The alarm logger task performs the actual acknowledgment.) At
®, the e-mail agent sends an acknowledgment e-mail to all contacts in the notification group.

Figure 2-10 Alarm Notification and Acknowledgment

Alarm Notification @ E-mail Notification

E-mail
Notification
Agent

FactoryLink
Alarm Log Task Acknowledge Alarm

@ Acknowledge
Alarm E-mail Reply

Alarm A
Update
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Client Builder/ I I

Contacts
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E-mail Notification Messages

When the alarm logger notifies the e-mail agent of an alarm or event notification, it supplies
the following information:

¢ Notification Group
e AlarmID

e Alarm Sequence ID
e E-mail Subject Text
e Alarm Message Text

The notification group determines which contact groups will receive the e-mail message. The
Alarm ID & Alarm Sequence ID make up part of the outgoing e-mail subject field. The
outgoing E-mail Subject field contains the Subject Text + Alarm ID + Sequence ID.

The E-mail Subject text is defined in the alarm logger task. The Subject Text can contain any
custom message. It is recommended that the Subject Text either contain the alarm tag name or
descriptive text about the alarm; this information helps the recipient to identify the alarm.

Anindividual contact can be configured to receive the alarm message text as part of the e-mail
body. Because some contacts may have restrictions for the size of e-mail they can receive
(such as mobile phones), it isoptional to include the alarm message text. The reply instructions
are added to the message body of the outgoing e-mail only if the contact is configured to
include the instructions. Figure 2-11 shows an outgoing e-mail message that requires an
acknowledgment by the recipient and one that does not require acknowledgment (intended to
simply inform the recipient).

The reply instructions are contained in a multilingual file named emreply.txt, located in
FLBIN\M SG\[language] directory, where [language] is EN, FR, or DE. If alanguage is not
supported, the desired language can be substituted in the text file for the currently defined
language set using FLLANG. For example, if reply instruction must be sent to only Chinese
recipients and the current FLLANG setting is EN (English), the EN text entry in the
emreply.txt file can be changed to the Chinese text.
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Figure 2-11 Alarm Notification E-mail Messages

Contact in Naotification Group

with Acknowledgment Rights /Alarm ID /Sequence ID
E-mail From\4 fluser@sqa.sfd
Subject To: jane@sgqa.sfd

\\Sent:\r‘Tuesday, August 24, 2004y11:06 AM

Alarm Subject™TanklLevel_Alarm, AID=99201, SEQ=1923467
Message
Text ——» Digital is ON!

This e-mail informs you of a FactoryLink alarm status. You have rights
Reply to acknowledge the alarm. To acknowledge the alarm, reply without
Instructions altering any portion of this e-mail.

Contact in Naotification Group

without Acknowledgment Rights

From\fluser@sqa.sfd

To: jack@sga.sfd

Sent: Tuesday, August 24, 2004 11:06 AM

Subject: TanklLevel_Alarm, AID=99201, SEQ=1923467

Digital is ON!
Reply This e-mail informs you of a FactoryLink alarm status. This e-mail is
Instructions sent for information purpose only. DO NOT REPLY TO THIS E-MAIL!

E-mail Reply Messages

The e-mail agent checksitsinbox every minute for responses sent by any contacts. When a
contact recipient replies to an e-mail message, the e-mail agent verifiesthat the contact is
configured to acknowledge alarms. If the contact is not configured to acknowledge alarms, the
response isignored and the active alarm is not acknowledged.

The e-mail agent uses the From and Subject field to match outgoing e-mail messages with the
response messages. The Alarm 1D and Sequence ID is used to determine what alarm will get
acknowledged in the alarm logger task. Because thisinformation appearsin the Subject field, it
is recommended that the contact not modify the Subject field when replying. Figure 2-12
shows examples of alarm acknowledged e-mail messages.

If a contact does not acknowledge an alarm within a specified time delay, the e-mail is
escalated to another contact. More contacts are notified as time progresses. Escalation only
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appliesto alarms requiring an acknowledgment. If multiple contacts have the same delay time,
the email is sent to these contacts at the sametime.

When e-mail clients are set to automatically reply to messages, the Subject field usually gets
altered to include an automatic reply message. This type of response message is ignored
because the response message fail s to match the outgoing e-mail message Subject requirement.

Figure 2-12 Alarm Acknowledged E-mail Messages

Contact notified when alarm is acknowledged

From: fluser@sqa.sfd

To: jane@sqa.sfd

Sent: Tuesday, August 24, 2004 11:08 AM

Subject: TanklLevel_Alarm has been acknowledged, AID=99201, SEQ=1923467

Digital is ON!

This e-mail informs you of a FactoryLink alarm status. This e-mail is sent for
information purpose only. DO NOT REPLY TO THIS E-MAIL!

Contact notified when alarm has changed but does not require acknowledgment

From: fluser@sqa.sfd

To: jane@sqa.sfd

Sent: Tuesday, August 24, 2004 11:16 AM

Subject: TankllLevel Alarm, AID=99201, SEQ=1923467

Returned to normal!

This e-mail informs you of a FactoryLink alarm status. This e-mail is sent for
information purpose only. DO NOT REPLY TO THIS E-MAIL!

Contact notified when event has changed but does not require acknowledgment

From: fluser@sqa.sfd

To: jane@sqa.sfd

Sent: Tuesday, August 24, 2004 11:45 AM

Subject: Egress Door Open, AID=1000, SEQ=1923500

Door is open!

This e-mail informs you of a FactoryLink alarm status. This e-mail is sent for
information purpose only. DO NOT REPLY TO THIS E-MAIL!
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E-mail Server Definition Table

This table defines the e-mail server parameters required to access the SMTP and POP3 mail
servers. The e-mail agent will use these parameters to connect to the servers so that e-mail can
be sent and retrieved.

Accessing
In your server application, open Alarms > E-mail Notification Agent > E-mail Server Definition.

Field Descriptions

Sender’'s Address Defines the e-mail address of the sender. The sender is usually an account
set up to send e-mail from FactoryLink. Use of auser’s personal account is
not recommended because the sender’s user name and password are visible
in Configuration Explorer.

Valid Entry: up to 128 characters

SMTP Server Defines name or address of your SMTP server for outgoing e-mail.
Address

Valid Entry: an address name (such as“mymailserver”) or an IP
address of up to 80 characters

SMTP Port  The port number that supports the SMTP server. Obtain thisinformation
from your IT department or e-mail provider.

Default: 25

SMTP Logon Indicates whether your SMTP server (outgoing mail) requires
Requires Secure authentication to log in, which means the user name and password are to be
Password encoded before being passed to the mail server. Most secure servers use
Authentication? authentication. Obtain thisinformation from your I T department.

Valid Entry: NO, YES, N, Y
Default: NO

Note: If YESisselected and your system does not require authentication, your login
will get rejected.

SMTP User Name Defines the user name account required by the SMTP server to log in.
Valid Entry: up to 255 characters
SMTP Password Defines the password required by the SMTP server to login.
Valid Entry: up to 255 characters (case-sensitive)
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POP3 Server Defines the name or address of your POP3 server for incoming e-mail.
Address

Valid Entry: an address name (such as “mymailserver”) or an IP
address of up to 80 characters

POP3 Port  The port number that supports the POP3 server. Obtain thisinformation
from your IT department or e-mail provider.

Default: 110

POP3 User Name Defines the user name account to log into the POP3 server. If thisfieldis
not specified, SMTP User Name field is used. (In most mail servers, the
SMTP and POP3 login (user name and password) parameters are the same.)

Valid Entry: up to 255 characters

POP3 Password Defines the password to log into the POP3 server. If thisfield is not
specified, SMTP Password field is used. (In most mail servers, the SMTP
and POP3 login (user name and password) parameters are the same.)

Valid Entry: up to 255 characters (case-sensitive)

Delete Mail From Indicateswhether to delete the e-mail from the POP3 server (inbox) after an
Server After acknowledged alarm is successfully processed. A processed e-mail is
Processing? considered an e-mail that has been validated as an acknowledgment to an

active alarm. Deleting the processed e-mail messages frees up storage space
and reduces the possibility that an old e-mail may get mistaken for a
response to acurrent alarm.

Valid Entry: NO, YES, N, Y
Default: YES
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Notification Groups Table

Thistable links the alarm logger to the e-mail agent. Each alarm group or alarm definition may
reference a notification group, which isreferenced in the Alarm Group Control table. When an
individual alarm belonging to an alarm group changes, member(s) of the referenced
notification group receive an e-mail message.

If anotification group is used on an alarm group level, e-mail is generated for all alarmsin the
group. If anotification group is defined on an individual alarm tag level, e-mail is generated
only for that alarm or event tag.

Accessing

In your server application, open Alarms > E-mail Notification Agent > Notification Groups.
Field Description

Notification Group The name assigned to a group of alarm tags or an individual alarm tag that
determines which contact groups will receive the e-mail message. This
group name must match the notification group name used in the Distributed
Alarms Definitions tables.

Valid Entry: up to 80 alphanumeric characters (case-sensitive)
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Contact Groups Table

Thistable defines the contact group names associated with the notification group. Each contact
group is assigned a schedule (day and time) when the contacts in the group can receive e-mail
notifications.

Accessing

In your server application, open Alarms > E-mail Notification Agent > Notification Groups >
“your notification group name” > Contact Groups.

Field Descriptions

Contact Group Defines the contact group name. that contains the e-mail addresses.
Valid Entry: up to 80 alphanumeric characters

Schedule Start Defines the start time that the contacts in a group can receive e-mail
(24hr Format) notifications. Thistime can coincide with the work hours of the contacts
that belong to the contact group. The start time is expressed in 24-hour
format.

Valid Entry: 0000 (midnight) to 2359 (11:59 p.m.)
Default: 0000

Note: Itispossibleto use astart timethat is greater than the end time. For example,
the group’s availability to receive e-mail spans the time between two days such as an
8-hour shift that starts at 2200 (10:00 p.m.) and ends at 0600 (6:00 a.m.).

Schedule End  Definesthe end time that the contactsin agroup are to stop receiving e-mail

(24hr Format) notifications. Thistime can coincide with the work hours of the contacts
that belong to the contact group. The end time is expressed in 24-hour
format.

Valid Entry: 0000 (midnight) to 2359 (11:59 p.m.)
Default: 2359

Note: Itispossibleto usean endtimethat islessthan the start time. For example, the
group’savailability to receive e-mail spansthetimebetween two dayssuch asan 8-hour
shift that starts at 2200 (10:00 p.m.) and ends at 0600 (6:00 am.).

SUN, MON, TUE, Indicatesthe day of the week that the contactsin agroup can receive e-mail.
WED, THU, FRI, The contacts can receive e-mail only on those days marked with YES or Y.
SAT
Valid Entry: NO, YES, N, Y
Default: NO — Sunday and Saturday
YES - All other days
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Contact Definition Table
This table defines the contacts that belong to a contact group.
Accessing

In your server application, open Alarms > Notification Agent > Notification Groups > “your
notification group name” > Contact Groups > “your contact group name” > Contact Definition
Information.

Field Descriptions

Display Name Defines the display name associated with an e-mail address. The display
name is usually the contact’s first name and last name or a nickname.

Valid Entry: up to 80 aphanumeric characters
Address Defines the e-mail address for the contact
Valid Entry: up to 128 characters

Delay Before Definesthe timein minutesto wait until an e-mail is sent to acontact. This
Notification (mins) delay timeis also known as the escalation time. All entries with the same
time delay are sent an e-mail message at the same time.

Valid Entry: 0to 9999
Default: O

Log Escalation Indicates whether the e-mail notification agent isto log the escalation event.

Valid Entry: NO, YES, N, Y
Default: NO

Role Definesthe role acontact plays when processing an e-mail response. The
contact’s role can be required to perform an acknowledgment or to be
informed (no acknowledgment or response anticipated). If the contact
responds to an e-mail that indicates an active alarm, the role for the contact
ischecked. If theroleis set to acknowledge, the alarm logger is notified that
the alarm was acknowledged.

A contact may have dual roles where the contact isinformed of all darm
notifications and has the capability to acknowledge an alarm. If thiscaseis
desired, the contact’s name must appear twice: one with the ACK role and
the other with the INFORM role.

Valid Entry:  ACK — Acknowledge
INFORM — Information (default)
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Include Alarm  Indicates whether to include the alarm message in the e-mail message body.
Message?

Valid Entry: NO, YES, N, Y
Default: NO
Note: If thecontact’'se-mail provider hasamessage size limitation, the alarm message
may exceed the limit. In this case, NO is recommended.

Include Reply Indicates whether to include the special instructions about how to reply to
Instructions? an alarm in the e-mail message body.

Valid Entry: NO, YES, N, Y
Default: NO

Note: If the contact’s e-mail provider has a message size limitation, the reply
instructions may exceed the limit. In this case, NO is recommended.

Debugging the E-mail Agent

The alarm logger makes use of its“-In" and “-dn” program arguments. Using “-In” signifies
logging to afile, and using “-dn” signifies displaying debug output to the console and
DebugView.
The e-mail agent shares the use of these parameters for debugging. The“n” signifiesalevel:
1 - Informational (general messages)
2 — Configuration (configuration tables)
3 — Transaction messages between the e-mail agent and the mail server
4-All (1-3)

When “—n" is specified, the log file, Agent.txt, is created in:
%FLAPP%\flappl\shared\shareusr\log

DebugView can also capture output to afile. DebugView is afreeware product from
Syslnternals (www.sysinternals.com).
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Printing to files, directing output to files and to the printer can be accomplished using several
different methods. For an explanation of these methods, see Table 2-6. The formats used for
printing can be modified.

Open the file %FLINK%msg\{language}al_fmt.txt with your favorite text editor program. Edit
thistext asindicated in the file to configure the print formats and tokens. The guidelines for
configuration of each option are included in each section of thefile.

Table 2-6 Printing and Directing Output to Files Using the al_fmt.txt File

No. | Description Configuration
1 |Printtoafile | In Alarm Group Control table, set the Alarm Stat Print Dev field equal to a
using the printer line number in the Device field of the Printer Spooler table that
print spooler | contains the address of afile; example, C:\msg\filename.txt
2 |Printtoa In the Alarm Group Control table, set the Alarm Stat Print Dev field equal
printer to aprinter line number in the Device field of the Printer Spooler table that
contains the device port; example, COM1: or LPT2
5 |Printall Print Active Alarms Tag field is set to ON. The Active List Print device
activealarms | tag field is set to a printer line number in the Device field of the Printer
toafile Spooler table that must contain the address of afile; example,
C:\msg\filename.txt
6 |Printall Print Active Alarms Tag field is set to ON. The Active List Print device
activealarms | tag field is set to a printer line number in the Device field of the Printer
toaprinter | Spooler table that must contain the device port; example, COM 1: or LPT2:
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ALARM VIEWER DESIGN

The Alarm Viewer is an alarm management tool that provides a visual display of run-time
alarmsin active states: Initial, Acknowledged, and Normal but not yet acknowledged. The
Alarm Viewer isa customized ActiveX control that interfaces with the FactoryLink alarm
server. The type, sorting, fonts, colors, blinking background or text, fields, field sequence, and
filtering of the displayed alarms are designed according to user preferences. Each client
workstation can maintain a separate design scheme for viewing alarms. Or, once an Alarm
Viewer is configured, the design can be shared among other workstations.

Client Builder provides an integrated design and run-time environment. Accessed in Client
Builder, the Alarm Viewer configuration can be modified in design mode and the changes
observed immediately in the run-time mode, so the designer can make adjustments as needed
to complete the design. Certain features or options can be locked to prevent operator changes
at run time.

In addition to the Alarm Viewer, an Alarm Banner Viewer is configured from the same
ActiveX control. The Alarm Banner Viewer, which displays up to three alarms, provides a
subset of the Alarm Viewer features. Because of its smaller size, it is easily positioned on
various Client Builder mimics. Depending on the design, this viewer shows the operator the
most critical or newest alarms. See the Client Builder Help for instructions to configure the
alarm viewers.
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RUN-TIME ALARMING

Asaarms are generated, the information is displayed on the run time Alarm Viewer or Alarm
Banner Viewer. These alarmsremain on the display until the alarm criteriano longer meetsthe
defined alarm conditions. If an alarm is defined as an alarm that must be acknowledged, the
alarm output remains listed even after the alarm condition is removed and the operator has not
manually acknowledged the alarm.

The size of the viewersis determined at design time, but fields can be resized at run time. The
horizontal scroll bar (when enabled in design mode) allows operators to view the columns
(during run time) when they are no longer visible due to resizing. Other run-time features are
sort, filter, acknowledgment of alarms, and printing. Figure 2-13 showsthe Alarm Viewer with
all of the basic features selected, and Figure 2-14 shows the Alarm Banner Viewer.

Figure 2-13 Parts of the Alarm Viewer at Run Time
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Figure 2-14 Parts of the Alarm Banner Viewer at Run Time
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For detailed instructions on using the alarm viewers at run time, see the Client Builder Help.
When all selections are complete, click Apply and then OK.

FactoryLink Task Configuration Reference Guide / 47



2 | ALARMS
Troubleshooting

TROUBLESHOOTING

If the Alarm task is not working, please check the following steps. If you used one of the
starter applications as a basis for your application, these steps are preconfigured for you.

Verify Alarm Server Task Setup

The Alarm Server task and the associated alarm server executablefile are predetermined in the
FactoryLink software as part of the System Configuration Information.

The Alarm Server manages the alarm output using the Alarm Server task. In response to an
alarm condition, the Distributed Alarm Logger task creates a message. The message can be
output to the Alarm Viewer through the Alarm Server, one or more databases, atext file, or a
printer.

If you used one of the starter applications as a basis for your application, thisinformation is
already completed for you. For most applications, you should not change any of the default
information.

Accessing

In your server application, open System > System Configuration > System Configuration
Information > Alarm Server.

Table 2-7 contains the field definitions and default settings for the Alarm Server task.
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,\'T;?]L% Definition Default
Domain Current FactoryLink versions use the Shared domain. Shared
Task Task Name Predefined name which cannot be changed | ALARM SRV
Information
Task Description Alarm Server
Description
Task Flags |Run at Startup | R: Invokestask at FactoryLink startup Yes
Create Session | S: Provides the process withitsowntab | Optional
Window window and prints messages to the
Configuration Explorer Output window.
SuppressOnline | O: Suppress online updates for this process | Optional
Configuration
Suppress Task | H: Not applicable Not applicable
Hibernation
Flag String | Input box Displays value code of selected Task Flags | Yes
Velue F: Puts task in the foreground at startup
Edit Flags If selected, allows user input of string Not selected
Directly values to input box.
Task Start Order Specifies the run-timerank for invoking |1
Options the task when FactoryLink is started
Start Priority Operating system processing priority 201
Task Executable File | Path and name of file which executes this | bin/alarmsvr
Executable task
Program See “Program Arguments’ on page 52. None
Arguments

Verify the Distributed Alarm Logger Task

The default options for the Distributed Alarm Logger task are preconfigured in the
FactoryLink software. The task name AL_L OG is standard and cannot be changed. Other
options can be modified by the designer. If you used one of the starter applications as a basis
for your application, thisinformation is already completed for you. For most applications, you
do not need to change the default information.
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Accessing

In your server application, open System > System Configuration > System Configuration
Information > Distributed Alarm Logger in form view.

Field Descriptions

Table 2-8 System Settings for Distributed Alarm Logger Task

,\'ii,ﬂqde Definition Default
Domain Current FactoryLink versions use the Shared domain. The | Shared
User domain is still supported.
Task Task Name Predefined name which cannot be changed |AL_LOG
Information [agy Description Distributed Alarm
Description Logger task
Task Flags |Run at Startup | R: Invokestask at FactoryLink startup Yes
Create Session | S: Provides the process with its own tab Optiona
Window window and prints messages to the
Configuration Explorer Output window.
Suppress 0: Suppress online updates for this process | Optional
Online
Configuration
Suppress Task |H: Not applicable for alarm functions Not applicable
Hibernation
Flag String | Input box Displaysvalue code of selected Task Flags. | FR
Velue F: Putstask in the foreground at startup.
A: Suppress printing of return-to-normal
messages for toggle type fields
Edit Flags If selected, allows user input of string Not checked
Directly values to input box.
Task Start Order Specifiestherun-timerank for invoking the | 2
Options task when FactoryLink is started
Start Priority | Operating system processing priority 201
Task Executable The path and name of file which executes | bin/al_log
Executable |File this task
Program See “Program Arguments’ on page 52. None
Arguments
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Verify the Distributed Alarm Server Table

The Distributed Alarm Server table supplies the mailbox and trigger information for the Alarm
Server and the Distributed Alarm Logger tasks to communicate.

If you used one of the starter applications as a basis for your application, thisinformation is
already completed for you. For most applications, you do not need to change the default
information.

Accessing

In your server application, open Alarms > Distributed Alarm Server > Distributed Alarm Server in
form view.

Field Descriptions
These tags are required for communication. The time interval for the poll trigger tag can be
modified using the Interval Timer table. The alarm server table tags are:

Send Mailbox Storage of communications retrieved by the Distributed Alarm Logger task
Default Entry: ALARMSRV_SNDMBX

Valid Data Type: Mailbox
Valid Entry: Up to 16 aphanumeric characters

Receive Mailbox Storage of communications from the Distributed Alarm Logger task
Default Entry: ALARMSRV_RCVMBX

Valid Data Type: Mailbox
Valid Entry: Up to 16 aphanumeric characters

Poll Trigger Polling frequency of the communications between the Alarms Server and
the Distributed Alarm Logger

Default Entry: ALARMSRV_POLL
Valid Data Type: Digital
Valid Entry: tag name

Verify Polling Trigger Timer Setup

The polling frequency for the Distributed Alarms Server is preconfigured in the Interval Timer
Information table. The default is a one second timer named ALARMSRV_POLL. If you used
one of the starter applications as a basis for your application, thisinformation is already
completed for you.

FactoryLink Task Configuration Reference Guide / 51



2| ALARMS
Program Arguments

PROGRAM ARGUMENTS

Argument Description

-A Disables the “ Return-to-Normal” message for digital
alarms.

-D<p> Set debug log level for Run-Time Manager output
window. (#¥=1t09)

-F Freezesinitial text display of alarms configured with
%s (C-style) variables.

-G Ignore remote log settings.

-H<GE Set historian time-out parameter. (# = 5 to 30 seconds)

-1 Leave Node ID embedded in sequence for logging.

-L Enables logging of debug information to alog file.

-M<I> Set maximum number of recordsin Alarm log text file.
(#=1t0 1000)

-0 Set “log once” mode.

-Q<ip> Set warning limit for historian maximum number of
outstanding responses.

-S or -s Sleep before re-entering DTP wait. Thiswould be used
when alot of alarms which change often are configured
but do not result in very many alarms.

- Vit Verbose level increases from 1 through 9.

-W Warm start; use/maintain a Persistence file of alarms.
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ERROR MESSAGES

If the Distributed Alarm Logger task encounters any problems during run time, an error
message iswritten to alog file in addition to displaying on the Run-Time Manager screen. The
log file residesin the following directory:

{FLAPP}/{ FLNAME}/{ FLDOMAIN}/log

Alarm Logging Messages

Error Messages Cause and Action
Cannot connect to SMTP server Cause: The server may be offline.

Action: If the problem persists, check the e-mail agent SMTP
configuration and restart the alarm logger task.

Cannot connect to POP3 server Cause: The server may be offline.

Action: If the problem persists, check the e-mail agent POP3
configuration and restart the alarm logger task.

Configuration could not be loaded Cause: The configuration data could not be loaded for the e-mail
agent. The agent will terminate.

Action: Check the e-mail agent’s configuration. Make sure the
ag.ct file was generated (use CTGEN). Display the CT
fileto verify if any records were generated.

Deadband tag has a different type at | Cause: Alarm tag and limit tag are different types.

Unique Alarm ID number Action: Correct the alarm tag or limit tag type. They must agree.

Duplicate Unique Alarm ID number Cause: The program detected a duplicate Alarm ID number in
used in CT file the software. This check isonly performed when a-d or -I
parameter is specified in the program arguments.

Action: Remove the duplicate from the Alarm Logging
definition.
Error (%d) on set change flag Cause: Aninternal call to set achange flag on atag hasfailed.

Action: Report the error to your support representative.
Empty CT file... Cause: Notablesarefoundinthe CT file.

Action: The configuration is probably invalid. Fill in the
information and define an alarm.
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Error Messages

Cause and Action

Error locating a child with Unique Cause:  The program did not find an Alarm 1D number used to
Alarm ID number define achild. This normally means a corrupted CT file.
Action: Run ctgen -r.

Error locating a parent Unique Alarm ID | Cause:  The program isnot ableto find an Alarm 1D number used
for alarm 'tag name' to define a parent.
Action: Correct the Parent Alarm ID number for the listed child.
Error locating group ‘%s’ Cause: The Alarm Logging task failed while reading CT files.
Action: Ensurethe application is restored properly and converted
(if necessary). Report the error to Customer Support.
Error on change read Cause: Thekernel returned an error when reading a message
from amailbox.
Action: Check the CT filesor runctgen -r.
Error reading type tag Cause: Thekernel returned an error while reading atag.
Action: Check the CT filesor runctgen -r.
Error reading CT index Cause:  Anerror occurred while reading the CT index.
Action: Run ctgen -r andcheck thea log.ctg filefor
corruption.
Error reading from CT table table Cause:  Anerror occurred on reading the CT record.
Action: Run ctgen -r and check theal log.ctg filefor
corruption.
Error retrieving message from type Cause: Thekernel returned an error upon retrieving a message
mailbox from amailbox.
Action: Check the CT filesor runctgen -r.
LAN send Mailbox is not empty. Please | Cause: The FLLAN task did not read messages from the
check FLLAN. mailbox.
Action: Check the Run-Time Manager screen to ensure that
FLLANSND and FLLANRCYV are running.
Limit tag has a different type at Unique | Cause: Alarm tag and limit tag are different types.
Alarm D number Action: Correct the alarm tag or limit tag type. They must agree.
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Error Messages Cause and Action
More object than configured! Cause: MoreAlarms, Children, or Logbook entries exist than the
number specified in the Distributed Alarm Logger Setup
table.

Action: Increase maximum active alarmsin general set up
control for a_log.

No CT file found... Cause: Thea _log.ct file was not present.

Action: Check the tables for the domain selection and the ctlist
filefor typing errors.

No database information for logging... |Cause: Logging is requested for xxx group, but no set up
information is entered.

Action: Fill out the Alarm Archive Control table.

No Setup information specified Cause: Partsof the Distributed Alarm Logger Setup table, which
are necessary for startup to occur, are not configured.

Action: Complete the general set up.

Not enough memory Cause: The software was not able to allocate sufficient memory
to load al datainto memory.

Action: You have insufficient memory in your system and must
add more memory in order for the program to run.

No valid printer device on 'Print Active |Cause: The softwareis not able to print the active alarm list
List' because no valid device was entered in the Distributed
Alarm Logger Setup table.

Action: Verify printer deviceis defined in printer spooler.
Consult the printer troubleshooting manual if trouble
persists.

Programming Error number. Contact | Cause: Internal error message

[ . .
Customer Support! Action: Report the error to your support representative.

Received less bytes than expected Cause: TheFLLAN task is not able to transmit the entire
message.
Action: Increasethe MAXLEN parameter in the local group file.

Sequence error in receiving %s from | Cause: The Alarm Logging task received an inappropriate
node %d message.

Action: Ensure the physical network connections are correct.
Report the error to your support representative.
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Error Messages Cause and Action
Severe error: No memory available for | Cause: The software isnot able to allocate sufficient memory
action during run time.

Action: You have insufficient memory in your system and must
add more in order for the program to run.

SQL Error number, ‘message’ Cause: Historian returned an error and message on an action
from the Distributed Alarm Logger task.

Action: Seethe historian error codes on page 291.

Timer task is not running! Cause: The Timer task was not running before the Logging task
was started. All internal time-stampings are retrieved
from the Timer.

Action: Start the Timer task or, if it isaready running, change the
sequence to ensure the Timer starts before Alarm

Logging.

Unable to insert DTP handler for %s tag | Cause:  Aninternal tag processing call failed.
Action: Report the error to your technical support representative.

Unable to open file for active list Cause: The software cannot open and write to the
{FLAPP}/darms.txt file. Thefile may be open in another
application or you do not have rights to open the file.

Action: May not have sufficient rights or enough disk space. Run
aCHKDSK command to ensure enough disk spaceis
available.

Unable to open Persistence file ‘%s’ Cause: The Alarm Logging task is unable to open the alarm
persistence file to save data.

Action: Check the drive the application is on to ensure enough
spaceis available. Ensure information can be written to
thedrive. If disk spaceislow, make space available.

Unable to write to Persistence file ‘%s’ | Cause: The Alarm Logging task is unable to write record(s) to
the opened alarm persistence file.

Action: Check the drive the application is on to ensure enough
spaceis available. Ensure information can be written to
thedrive. If disk spaceis|ow, make space available.

Warning: More than one line of table Cause: Ontables where only one line isread, more lines are
information detected. The program will continue but could work on
the wrong parameters.

Action: Remove the additional lines.
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Alarm Viewer Messages

Error Message Cause and Action

CT file ctname not found Cause: Theal _view.ct file was not present.

Action: Check the tables for the domain selection and the ctlist
filefor typing errors.

Dimensions of array too short, view Cause: The array dimensions and the number of lines do not
window number match. The array istoo small.

Action: Correct the number of lines or redefine the array.

Duplicate Unique Alarm ID number Cause: The program detected a duplicate Alarm ID number in
used in CT file the software. This check isonly performed whena-d or -|
parameter is specified in the program arguments.

Action: Remove the duplicate Alarm ID.

Error clearing chg flag type error Cause: Thekernel returned an error while clearing a change flag.
Action: Check CT filesorrun ctgen -r.

Empty CT file table ‘ctname' Cause: Notablesarefoundinthe CT file.
Action: Check Alarm Logging set up for table names.

Error error on change read Cause: Thekernel returned an error while reading a changed tag.
Action: Check CT filesorrun ctgen -r.

Error operation on operation mbx Cause:  The kernel returned an error on amailbox operation.
number Action: Check the CT filesorrun ctgen -r.
Error reading CT index... Cause: An error occurred on reading the CT index.
Action: Run ctgen -r and check thea_view.ctg file for
corruption.
Error reading from CT file. Cause:  Anerror occurred on reading the CT record.
Action: Run ctgen -r and check the a_view.ctg file for
corruption.
Error reading type tag error Cause: The kernel returned an error while reading atag.

Action: Check CT filesorrun ctgen -r.

Error writing type tag error Cause: The kernel returned an error while writing a tag.
Action: Check CT filesorrun ctgen -r.
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Error Message

Cause and Action

Method data for filtering does not exist

Cause:

Action:

The user-defined data does not match any of the
available alarms or groups.

You aretrying to filter or sort a group that is not present.
Adjust your sort method.

No Setup information specified

Cause:

Action:

Parts of the Alarm Viewer table necessary to operate are
not configured.

Complete the parts of the Alarm Viewer table.

Not enough memory

Cause:

Action:

The software is not able to allocate sufficient memory to
load al datainto memory.

Your system hasinsufficient memory to run the program.
Add more memory.

Severe error, no memory available for
action

Cause:

Action:

The software is not able to allocate sufficient memory
during run time.

Add more memory.

Unable to load key file

Cause:

Action:

One of the key files used for trandation is missing.
Reinstall FactoryLink.

Unknown alarm group group

Cause:

Action:

The program is not able to find the Alarm ID number
used to define a child.

Check to seeif your CT fileis corrupted.

Unknown CT type...

Cause:

Action:

An unknown type of CT inthe CT fileis displayed.

Run ctgen -r andcheck thea view.ctg and
a_info.ctg filesfor corruption.

Warning: More than one line of table
information

Cause:

Action:

On tables where only one lineisread, more lines are
detected. The program will continue but could work on
the wrong parameters.

Remove the additional lines.

Wrong mailbox message type received
number

Cause:

Action:

This error should not occur.
Report the error to your technical support representative.
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Batch Recipe

The Batch Recipe task transfers sets of predefined values, sometimes called recipes, between
binary disk files and selected tags in the real-time database. In the real-time database, a batch
recipeis a collection of tags grouped together for some purpose. These tags can contain
internally-generated or operator-entered values.

Depending upon the type of recipes that you need, you might find it preferable to use one of
the relational databases to create and store your recipes.

OPERATING PRINCIPLES

You can perform the following functions with Batch Recipe:

Define up to 8,000 different recipe templates, each associated with a virtually unlimited
number of files

Store batch recipesin disk files so the total number of different recipes stored on asystemis
limited only by available disk space

Store each batch recipe file under a standard file name
Specify up to 8,000 tags for one batch recipe template
Use with any of these data types: digital, analog, long anal og, floating-point, and message

You can configure Batch Recipe for use in many diverse applications. For example, a program
can use agraphic display for the entry of application values and write these values to an
external device using an external device interface task. Batch Recipe can save these tag values
in arecipe so the program can then read the values from the batch recipefile.

Sample applications that use a single batch recipe template include:

Producing a particular line of paint. You can use multiple recipe files using the same recipe
template to set various hues or colors of the paint being produced.

Setting up external devices with different recipes for days of the week, end of the month,
and other schedules.

Setting up an environment for atesting procedure with different sets of testing parameters.

You can use batch recipesin conjunction with any FactoryLink task because each FactoryLink
task communicates with other tasks through the real-time database.
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Batch Recipe executes as a background task. The task does not require operator intervention at
run time unless you design the application to require it.

You can configure Batch Recipe to be triggered by events, timers, or operator commands, such
as.

e Anexterna device read operation

e A Math & Logic calculation

e An activity from another station on a network

« Input from the operator using a keyboard or pointing device

Perform the following steps to configure atypical Batch Recipe application:

1. If the recipes are to be edited and/or viewed, create and animate amimic with fields to
enter or display tag valuesin the recipe.

2. Complete a Recipe table containing the tags to be used in the recipe.

3. Complete the protocol module Read/Write table for an external device if you want to
connect the tags in the recipe with addresses in the device.

Monitor the Run-Time Manager screen to determine the status of Batch Recipe at run time.

Note: When performing a platform-dependent FL SAVE, FactoryLink saves
recipefiles; however, when performing aplatform-independent or multiplatform
FLSAVE, FactoryLink does not save recipe files.

RECIPE CONTROL TABLE
Accessing
In your server application, open Recipe > Recipe > Recipe Control.

Field Descriptions

Recipe Name Unique name of the recipe template to be defined or modified.
Valid Entry: up to 16 alphanumeric characters
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Max. Msg. Length
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Recipe Control Table

Tag that initiates aread operation. When Recipe detects thistag is forced to
1 (ON), the task reads the values from the disk file specified in the File
Spec. and File Spec. Variable fields and transfers them to the tags specified
in the Recipe Information table.
Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
Tag that initiates a write operation. When the value of this tag changes,
Recipe collects the current values of the tags specified in the Recipe
Information table and writesthem to the binary disk file specified in the File
Spec. and File Spec. Variable fields.
Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message

Variable specifier that uses the value of the File Spec. Variable tag as the
file path and name.

Sample Path—if you specify the Path File Name
DISK:/RECIPE/PAINT%03d.RCP, and define the File Spec. Variable tag as an
analog data type, value 23, the system generates the following filename:
DISK:/recipe/paint023.rcp

Because the default path is /FLAPP/FLNAME/FLDOMAIN/FLUSER/RCP, the
File Spec. of PAINT/%s.RCP and the File Spec. Variable containing a value of
‘red’ generate the following filename:

[FLAPP/FLNAME/FLDOMAIN/FLUSER/rcp/paint/red.rcp

If the File Spec. Variable is absent, the filename is generated from the File
Spec. and the default path name /FLAPP/FLNAME/FLDOMAIN/FLUSER/RCP.
If the File Spec. isabsent, it defaults to %s,%d,%1d, or %-8.3f as appropriate
for the File Spec. Variable data type.

For more information on format specifiers, see Appendix, “Format
Specifiers.”

Name of atag whose value is used with the entry in the File Spec. field to
form the file/path name for abinary disk file that contains a specific recipe.

Valid Entry: tag name
The maximum number of characters in a message.
Valid Entry: 1to 255
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Forced Write  Indicator of whether al change-status flags on the tagsin the recipe are to
be set to 1 (ON) when aread operation occurs. Batch Recipe can set
change-status flags in aread operation for all tags specified in arecipe
rather than only for those tags whose values have actually changed since the
last read operation. This can be one of the following:

YES Sets change-status flags for all tags when read
regardless of their actual change status

NO Causes change-status flagsto be set only for tagswhose
values have changed since the last read. Thisisthe
default.

Completion Trigger Name of atag whose value isforced to 1 (ON) by the Recipe task when a
read or write operation is completed. The value of the Completion Trigger
tag is 0 (OFF) when the program begins |oading a new Batch Recipe file
from the specified drive to the real-time database, and is forced to 1 (ON)
when the file finishes |oading.

Completion Triggers can be used in multiple operations. For example, the
Completion Trigger can initiate awrite of arecipe to an external device and
it can initiate a message to the operator on amimic. The Math & Logic task
can check the trigger to determine successful reading or writing of the
recipe.

Valid Entry: tag name
Valid Data Type: digital

Completion Status Name of atag set to 0 (OFF) by the Recipe task when the last recipe read or
write is completed without an error or set to 1 (ON) when the last recipe
read or write is completed with an error.

Valid Entry: tag name
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RECIPE INFORMATION TABLE

Accessing

In your server application, open Recipe > Recipe > Recipe Control > “your recipe name” >
Recipe Information.

Field Description

Tag Name Names of tags to be read or written from the recipe file.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, or message

SAMPLE BATCH RECIPE

This section demonstrates how to configure Batch Recipe for the production of cookies and
cereal using the same recipe template. You create arecipe at run time by entering values for
temperature, cook time, flour, water, and sugar on the recipe mimic. Batch Recipe accesses
these values for communication to an external device that controls production. You can also
create other recipes from the same recipe template.

Perform the following steps to configure this sample recipe template:
1 Configure abatch recipe template.
2 Link recipeinput valuesto an external device.

3 Draw and animate a mimic for the operator to use to create and edit recipes at run time.
Configuring Batch Recipe Template
Configure a batch recipe template to create multiple batch recipes without completing a new
recipe table for each recipe. In this sample application, the template creates a new recipe and
opens an existing one.

Perform the following steps to complete the Recipe table:
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1 Inyour server application, open Recipe > Recipe > Recipe Control.

Recipe Control - SHARED (WUS-RI-ws0032... - |03
HE sBRX B w B O 6
[
p Read Save . - — =
Fecipe Mame iaeen iage File Sped %
i CC_RECIPE oo read or_save A -
Recipe Control - SHARED (WUS-RI-wso... (- |[OJES
HE sBRX B i
| B o ol 2
A
i 4 File Spec. Max. Mzg.  |Forced |Completion
Wariable Length ‘wite [ Trigger
1 product 40 MO co_trigr

4| | »

2 Enter the tags as shown in the tables above and save the information when the Recipe Control
table is complete.

3 Open Recipe > Recipe > Recipe Control > CC_RECIPE > Recipe Information and enter the names
of the tags to be used in the recipe template as shown below.

Recipe Information - SHARED - Recip... |- |0/
HEE 2B X B F f
Y Y =K
Tag Mame
1 cc_temp
2 cc_cook_time
3 cc_flaur
4 cc_water
5 e Te

The entriesin this table specify the tags (cc_temp, cc_cook_time, cc_flour, cc_water, and
cc_sugar) whose values you enter on the RECIPE display at run time.

4 Savetheinformation.
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Linking Recipe Input Values to an External Device

Link the valuesto registersin the external deviceif you want the input values of the recipesto
change the settingsin an external device. In this example, you would configure a PLC Write
table with the same tags as those that are used in the recipe. Your PLC ladder logic would need
to written to correspond to the settingsin the recipe. You can also read values from an external
device and save those in arecipe to be used at alater time.

Drawing and Animating a Mimic

Draw and animate amimic called RECIPE using the Client Builder.

Recipe |
remperaure [ ][] sme.
Flour I:l Recipe
Water I:l Main
[i Menu

suger [

Link the tags you created in the recipe table to the animated fields in the mimic.

At run time, you create a recipe the first time you open this mimic by entering a Recipe name
and entering values for Temperature, Cook Time, Flour, Water, and Sugar. To save the recipe,
the operator clicks Save Recipe and then the Batch Recipe:

» Writesthevaluesyou just entered to thetags cc_temp, cc_cook_time, cc_flour, cc_water, and
cc_sugar you defined in the Recipe Information table when you configured the task.

» Creates arecipefile (with a.RCP extension) and writes the values of these tagsin binary
formto thisfile.

When you wish to retrieve the recipe later for display on the screen, open the RECIPE mimic,
type the recipe name, and click Open Recipe. Batch Recipe collects the binary values from the
disk file, writes them to the tags, and the Graphics task displays them on the mimic.

Run-time Example

1 Inthe System Configuration table, be sure the recipe task is configured and has the R flag to
start.
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2 To create arecipe for Cookies, enter the values shown in the following figure and click Save
Recipe to write these values to the tags specified and store the recipe under the file name
Cookies.rcp.

Recipe Cookies

S

Temperature | 375 [i Rg\é?pe
Cook Time | 10

Ii Ope_n

Flour |5 Nl

Water | 2 Main

li Menu
Sugar | 3

3 To create arecipe for making cereal, type Cereal in the Recipe Name field and enter the
following values for each variable.

Recipe Cereal

Temperature | 300 | ,i gg\é?pe
Cook Time | 17 | [ open
Flour E Recipe

Water | 3 | ,i Main
Sugar | 5 Mend

4 Click Save Recipe. Batch Recipe writes the values for the cereal recipe to the specified tag in
the real-time database and stores them on disk in the binary file named CEREAL.RCP.

5 To open therecipefor Cookies, type Cookies in the Recipe Name field and click Open Recipe to
recall the recipe for cookies. Batch Recipe reads the values for each of the variables from the
binary disk file, deposits them in the real-time database, and displays them on the screen.

PROGRAM ARGUMENTS

Argument Description
-L or -1 - Enables logging of debug information to alog file.
-V Does the same as argument —L.
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ERROR MESSAGES

Error Message Cause and Action

Can't create recipe file filename Cause:  Thefile name or pathname may be invalid or the disk
may be full.

Action: Specify the Path File Name correctly. If the Path File
Nameiscorrect, ensure the directory exists. Run CHKDSK
or any disk diagnostic program to determine whether the
disk isfull. Delete unnecessary filesif the disk isfull or
nearly full. Consider making this part of your ongoing
maintenance effort.

Can't find recipe filename Cause: Thetask cannot locate the specified recipefile.

Action: Either the recipefile does not exist or the name of thefile
was entered incorrectly.

Error reading CT header Cause: Either the RECIPE.CT fileiscorrupt or the .CT script file
(/FLINK/CTG/RECIPE.CTG) and the FactoryLink
Run-Time version are not the same version.

Action: Deletethe.CT file and then restart the application to
rebuild the file, or execute CTGEN RECIPE.CT -V3.
Error reading CT index Cause:  Thefile RECIPE.CT file has been damaged.

Action: Rebuild thefile by deleting the RECIPE.CT file and
restarting the application, or execute CTGEN RECIPE.CT
-V3.

Error reading CT record Cause: Either the RECIPE.CT fileis corrupt, or the .CT script
file (/FLINK/CTG/RECIPE.CTG) and the FactoryLink
Run-Time version are not the same version.

Action: Deletethe.CT file and then restart the application to
rebuild the file, or execute CTGEN RECIPE.CT -V3.

Error reading recipe filename Cause: Either thefileis corrupt or the disk is damaged.

Action: Inspect the file and run adisk diagnostic program to
determine if the disk is corrupt. If it is, recreate the file
from scratch or from the backup disk or tape.
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Error Message

Cause and Action

Error writing recipe filename

Cause:
Action:

The specified device is either full or corrupt.

Run CHKDSK or any disk diagnostic program to
determine whether the disk is full. Delete unnecessary
filesif the disk isfull or aimost full.

Invalid CT header size

Cause:

Action:

Either the RECIPE.CT fileiscorrupt or the .CT script file
(/FLINK/CTG/RECIPE.CTG) and the FactoryLink
Run-Time version are not the same version.

Delete the .CT file and then restart the application to
rebuild thefile, or execute CTGEN RECIPE.CT -V3.

Invalid CT record size

Cause:

Action:

Either the RECIPE.CT fileis corrupt, or the .CT script
file (/FLINK/CTG/RECIPE.CTG) and the FactoryLink
Run-Time Manager are not the same version.

Delete the .CT file and then restart the application to
rebuild thefile, or execute CTGEN RECIPE.CT -V3.

Invalid tag

Cause:

Action:

The program detects an invalid tag or the tag does not
existin thereal-time database. Either datain thereal-time
database is corrupt or the Run-Time Manager was started
without having run CTGEN.

Run CTGEN.

No recipes defined

Cause:
Action:

No recipes are defined in the Recipe Information table.

Remove the R flag for the Recipe task from the System
Configuration table or define at |east one recipe.

No tables configured for this task

Cause:

Action:

Either you did not configure the Recipe table or the
following files could be missing or damaged:

- RECIPE.CDB database

- RECIPE.MDX database

- [FLAPP/CT/RECIPE.CT

- .CT script /[FLINK/CTGEN/RECIPE.CTG
FLNEW or CTGEN may not have run correctly.

Deletethe .CT file. Run CTGEN and try again.

Not enough RAM to load CTs

Cause:

Action:

Thetask does not have enough RAM allocated to load the
configuration tables.

Shut down any unnecessary tasks. Increase the system
RAM sizeif this does not help.
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Error Message Cause and Action

No triggers configured for this task Cause: No read or write triggers are defined in the Recipe table.
Action: Define read and write triggers in the Recipe table.

Recipe doesn't match CT filename Cause: The specified recipe file does not match the Recipe
Configuration table. The number of tag names for each
data type and the maximum string space may not match.

Action: Reenter therecipefile. If thefileis correctly specified,
inspect the recipe file in the configuration table.

Recipe is too big Cause: Thetota tagsin arecipewill not fit in a 10000-byte
buffer.

Action: Create asmaller recipe, decrease the size of the message
strings, or switch from longana to analog data type.
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Chapter4 . . ..
Client Buillder

A FactoryLink application consists of aclient project that is configured in the Client Builder
and a server application that is configured in the Configuration Explorer. In the Client Builder
environment, you create and configure the graphical user interfaces for your FactoryLink
application to graphically represent your industrial processes. Client Builder also provides the
run-time environment for interacting with those interfaces.

Although most of the proceduresin this guide are done using the Configuration Explorer, some
procedures reference the Client Builder. You can access the Client Builder by double-clicking
the Client Builder icon on your desktop. For detailed information, procedures, and program
arguments to use the Client Builder, see the Client Builder Help.
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Chapter5 . . ..
Database Browser

The Database Browser task works in conjunction with the historian tasks to allow a server
application to access data in arelational database through a browse window. This method of
browsing is more flexible and powerful than using the Database Browser Control, but requires
more configuration effort.

Database Browser offers the following features:
« Allowsrelational datain arelational database to be manipulated from within FactoryLink

» Allows an application to send and retrieve data to and from all external database tables,
including those created outside of FactoryLink

« Allowsyou to define tags referenced by Database Browser in arrays aswell asindividually

Note: If you are starting a new application, see the Fundamentals Guide for a
discussion on variousbrowsing options. The Database Browser Control may suit
your needsand requirelesstimeto configure. PowerSQL hasall thefunctionality
of the Database Browser task and offers even more power and flexibility with
about the same configuration effort as the Database Browser task. For detailed
information and proceduresto use the Database Browser Control, see the Client
Builder Help. For detailed information and procedures to use PowerSQL, see
page 411.

OPERATING PRINCIPLES

Database Browser is a historian-client task that communi cates with a historian through
mailbox tags to send and receive historical information stored in an external database.

Database Browser accesses datain arelational database by selecting the data specified in a
configuration table and placing it in atemporary table called aresult table. The task views and
modifies the datain the result table through a browse window. A browse window isadiding
window that maps data between the relational database and the real-time database. The browse
window views selected portions of the result table.

For example, if amimic is used to display the browse window, it can display as many rows of
data from the result table as there are tags in the two-dimensional tag array. If there are more
rows in the result table than in the browse window, the operator can scroll through the result
table and see each row of it in the browse window.
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The relationships among the external database, the result table, the browse window, the
real -time database, and the mimic are displayed below.

Fesulttable
External
database 1M 26110000 | 1 | 15 | black
bl .
191M26113000 | 1 |16 Ex — FactareLink
] o real-ime Graphic Display
Extermal 1\ 26120000 | 1 | 17 |whie database
datahase
table "car"
Car # Color

19IM2E123000 | 1|18 |whie 110126123000 [ 1| 18] whie

1991012613000 [ 1 [19] blee |

[15] whie

19| ble

Colt| Cal2| Col3 | Cold

191M 26130000 [ 1 | 19 | ble

191M 26133000 | 1 | 20 | ble

199126140000 | 1 | 21 |bhe

Logical expression:

Coll » 19310126075959
and

Coll «19310126170001
and

Colz=1
and

Col3 > 14
and

Col3 ¢ 22

Database Browser can read from and write to an entire array of tagsin one operation.

Aninternal buffer stores the rows of the result tablein RAM. An external buffer storesthe
overflow of rows from the internal buffer on disk. This allows the operator to scroll back up
through the result table. Figure 5-1 shows the buffers.
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Figure 5-1 Buffers Used in Database Browser

Result Result Internal External
Table Window Cache Buffer
Size {Disk}
(Rows)

15 - - - - — ¢ 20

of
Consists Displays Stores Stores
of 25 rows 5 rows 20 rows remaining

5 rows

In this example, asthe operator scrolls through the result table, the rows of the result table flow
into the internal buffer to be stored in memory. Because, in this case, the result table consists of
25 rows and the internal buffer can store only 20 rows, when the internal buffer isfull, the
excessrows in theinternal buffer flow into the external buffer to be stored on disk.

USE OF LOGICAL EXPRESSIONS

You use logical expressionsto specify the datain arelational database to view or modify. For
the purposes of the Database Browser task, alogical expression is acommand containing a
standard Structured Query Language (SQL) WHERE clause.

To select data from a database table, alogical expression worksin conjunction with thetable’'s
column name and logical operators to form an SQL WHERE clause. The WHERE clause
specifies which rows in a database table to place in the result table.

Note: You must know how to write astandard SQL statement to configure the
Database Browser task. For additional information, see any SQL guide or the
user manual for the relational database.

To make alogical expression flexible at run time, use the name of atag whose valueisa
WHERE clause. If viewing all data from a column in arelational database table, you do not
need to specify alogical expression.
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The following table represents part of a sample database table, CAR.

TRANDATE CONVEYOR CARNUM COLOR
19910126093000 1 12 red
19910126100000 1 13 silver
19910126103000 1 14 black
19910126110000 1 15 black
19910126113000 1 16 black
19910126120000 1 17 white
19910126123000 1 18 white
19910126130000 1 19 blue
19910126133000 1 20 blue
19910126140000 1 21 blue
19910126143000 1 22 brown

A sample WHERE clause referencing the previous table CAR is

TRANDATE > “19910126075959° AND TRANDATE < “19910126170001° AND
CONVEYOR = 1 AND CARNUM > 14 AND  CARNUM <21

In this example, the WHERE clause requests:

Which colors cars 15 through 20 on conveyor 1 were painted between
8:00 A.Mm. and 5:00 p.Mm. on January 26, 1991

From this WHERE clause, the relational database places the following valuesin aresult table.

19910126110000 1 15 black
19910126113000 1 16 black
19910126120000 1 17 white
19910126123000 1 18 white
19910126130000 1 19 blue
19910126133000 1 20 blue
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If the view size of the browse window is 2, the browse window writes the values of the tagsin
two rows to the real-time database, where other FactoryLink tasks can read it and writeto it,
and an operator can view the data on amimic.

The Database Browser task performs four operations:

» Select—Uses an SQL select statement to select and retrieve datafrom arelational database
to be displayed in aresult table.

» Update—Updates the datain the result table and external database. The Database Browser
task can perform two types of update operations:

* Positional—Updates the current row (row at which the cursor is currently pointing) of
data displayed in the browse window.

 Logica—Updates the data described by the logical expression.

 Insert—When an update operation cannot be performed because the row to be updated does
not exist, inserts anew row of datain the result table.

» Delete—Deletes arow from the result table and external database. The Database Browser
task can perform two types of delete operations:

* Positional—Deletes the current row (row at which the cursor is currently pointing) of
data displayed in the browse window.

* Logica—Deéletes the data described by the logical expression.

DATABASE BROWSER CONTROL TABLE

Accessing

In your server application, open Data Logging > Database Browser > Database Browser Control.

Note: If youareusing Client Builder, itisrecommended that you usethe Shared
domain. For ECS Graphics, use the User domain.

Field Descriptions

Browse Name  Specifiesthe devel oper-assigned name of the browse window being defined
or modified.

Valid Entry: up to 15 aphanumeric characters

Select Trigger Tag that triggers a select operation. A select operation selects specific data
from arelational database table based upon information specified in the
Database Browser Information table and placesit in aresult table for you to
view or manipulate.
Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
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Update Trigger Tag that triggers an update operation. The Database Browser task performs
apositional update if you defined a select trigger. When the value of thistag
changes during a positional update, the Database Browser task reads the
valuesin the active row (the value of the current row tag) and updates the
valuesin that row of the result table and external database.

For a positional update to work, the database table must have a unique
constraint configured for it; that is, a unique index must exist for the
database table. This can be configured in Database Schema Creation or
executed externally to FactoryLink whenever the database table is created.
Consult the RDBM S users manual if you need to create a uniqueindex on a
database table that already exists.

Thetask performsalogical update if you have not defined a select trigger to
select specific data. During alogical update, the Database Browser task
reads the values in the first row of the browse window and uses the logical
expression defined in the Database Browser | nformation table to update the
valuesin the external database.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message

Delete Trigger Tag that triggers a delete operation. The Database Browser task performs a
positional deleteif you defined a select trigger. The Database Browser task
del etes the active row in the browse window from the result table and
external database when the value of this tag changes during a positional
delete.

For a positional delete to work, the database table must have a unique
constraint configured for it; that is, a unique index must exist for the
database table. This can be configured in Database Schema Creation or
executed externally to FactoryLink whenever the database table is created.
Refer to Database Logging for more information on configuring the
Database Schema Creation table. Consult the RDBM S user’s manual if you
need to create a unique index on the database table that already exists.

The Database Browser task performs alogical deleteif you have not
defined a select trigger. The rows are deleted in the relational database
indicated by the logical expression during alogical delete.
Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
Move Trigger (Requires use of the Select Trigger.) Tag that moves the active row up or

down the indicated number of rows. The window scrolls the remaining
number of records if the active row reaches the first or last record in the

78 | FactoryLink Task Configuration Reference Guide



Position Trigger

Historian Mailbox

Database Table
Name

Current Row Tag

DATABASE BROWSER | 5
Database Browser Control Table

browse window. For example, if the value of the Move Trigger tagis-3 and
the active row is positioned on the first row displayed in the browse
window, the datain the window scrolls down three rows.

Move operations can be performed only on result tables, so they cannot be
performed unless you have executed a Select Trigger.
Valid Entry: tag name
Valid Data Type: analog

(Requires use of the Select Trigger.) Tag that moves the browse window to
the specified row in the result table. The specified row is centered in the
browse window and becomes the active row. For example, if the value of
thistag is 42, the browse table displays row 42 of the result table.

Position operations are performed only on result tables, so they cannot be
performed unless you execute a Select Trigger.
Valid Entry: tag name
Valid Data Type: analog
Mailbox tag whose value initiates communication with an externa
database. The Database Browser task sends requests for information from
the relational database to this mailbox tag. The historian task reads thistag
and transfers the request to the external database.
Valid Entry: tag name
Valid Data Type: mailbox

Specifies the Database Alias Name (defined in the historian task) and the
name of the table in the relational database the Database Browser task
requests information from. Placea“.” between the Database Alias Name
and the Table Name.

Valid Entry: up to 63 aphanumeric characters

Tag whose value indicates the position of the active row of datain abrowse
window. After the Database Browser task performs a Select, Move, or
Position, the Database Browser task writes the value indicated by the
position of the active row to this tag.

The Database Browser task performs all update and delete operations on the
row indicated by the Current Row Tag tag if you have defined a select
trigger.

Valid Entry: tag name
Valid Data Type: analog
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Auto Create Indicates whether anew row is to be inserted in a database table if arow
Record cannot be found when an update operation is being attempted. Works with
logical updates but not with positional updates.

YES Insert anew row of data
NO Do not insert any new rows. Thisisthe default.

Browse Table Size  Specifies the number of rowsin a browse window that can be viewed or
(Rows) modified. The browse window size must be the same size as the tag array

specified in the Tag Name field of the Database Browser Information table.
All tag arrays specified in the Tag Name field must be the same size. The
browse window size must be the same as the size of the smallest tag array if
al tag arrays are not the same size. The Browse Table Size (Rows) field
also specifies the number of rows of data sent to the Database Browser task
each time it requests data from a historian.

Valid Entry: 1to50

Internal Buffer Size  Specifies the number of rows of datain aresult table that can be stored in
(Rows) memory. Use the following guidelines to choose appropriate internal and
external buffer sizes.

The Database Browser task operates more quickly if all rowsin aresult
table are stored in the internal buffer as opposed to being stored in the
external buffer.

Use avalue large enough to contain as many rows as necessary but small
enough not to use up too much memory.

If the size of the result table is unknown and if memory allows, we
recommend you enter 100; however, if the result table will be shorter, enter
anumber equalling (n)-(tag array size), where n isthe number of rowsin
the result table.

The overflow is stored in the external buffer if you chooseto store only a
given number of rowsin the internal buffer and the result table grows larger
than the internal buffer.

If: the internal buffer can store 25 rows
and the external buffer can store an unlimited number of rows
and the browse window has 5 rows
and the result table contains 50 rows,

then: 5 rows display in the browse window
25 rows are stored in the internal buffer
and 50 rows are stored in the external buffer

Valid Entry: 1 to 9999
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External Buffer See discussion abovein the Internal Buffer Size field description.
Size (Rows)

Valid Entry: 1to 9999
Disable Tag Tag that disables all related browse operations.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, or float

Completion Trigger Tag whose change-status flags are set by the Database Browser task when
any browse operation for this browse window is complete.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message

Completion Status Tag whose value indicates the status of the current operation completed by
the Database Browser task or historian. The status displays as a character
string if thistag is a message tag; otherwise, it displays as a numeric code.
If thetag is digital tag, a0 (zero) indicates success, and a 1 (one) indicates
failure. If thetagis an analog tag, the actual return from the database
software (which could be greater than 32767) is trandated to an equivalent
historian error and returned in the status tag. If the configuration tag is
longanaor float type, it returns the actual status received from the database.
See “ Status Codes and Error Messages’ on page 88 for the codes and
messages that can display in this tag.

You can configure this tag to work in conjunction with output objects in
Client Builder to display codes or messages on any mimic. You can also
configure Math & Logic to monitor this tag and respond to or ignore errors
that occur.
Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
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DATABASE BROWSER INFORMATION TABLE

Accessing

In your server application, open Data Logging > Database Browser > Database Browser Control
> “your browser table” > Database Browser Information.

Field Descriptions

Tag Name Tag that contains the values from a column of arelational database table. If
the Browse Table Size field in the Database Browser Control tableis greater
than 1, the tag must be an array of Browse Table Size or greater. Ensure all
tags entered in the Tag Name field can accommodate Browse Table Size.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
Logical Operator Part of aWHERE clause that specifies the conditions the Database Browser
task usesto select rows from arelational databasetable. Thisfield worksin
conjunction with the Column Name and Logical Expression fields
(described below) to specify WHERE clauses.
AND Specifies a combination of conditionsin alogical
expression.
OR Specifiesalist of aternate conditionsin alogica
expression.
FactoryLink performs a sequentia search through the
database even if the columns are indexed if you use the
OR operator in alogical expression when using the

Historian for dBASE IV. This may result in a slower
response time if the database is large.

NOT Negates aconditionin alogical expression.

AND_NOT Specifies a combination of conditions and negated
conditionsin alogical expression.

OR_NOT Specifiesalist of alternate negated conditionsin alogical
expression. (See examplesin the following table.)
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WHERE clause Description

Col2=3AND Col4 >4 The Database Browser task selects all
rows where Col2 isequal to 3 AND
Col4 is greater than 4.

Col3<60OR Col2>=19 The Database Browser task selects all
rowswhere Col3islessthan 6 OR Col2
is greater than or equal to 19.

Col4>7 AND_NOT Col4 = 20| The Database Browser task selects all
rows where Col4 is greater than 7
AND_NOT equal to 20.

Specifies:

(1) Relational database column name associated with the Tag Name tag.
The Column Name field works in conjunction with the Logical Operator
and Logical Expression fields to specify WHERE clauses with the
following format:

([table.Jcolumn)
where

table Istherelational database table name. Include table, if the
table nameis different from the table name specified in the
Database. Table Name field in the Database Browser
Control table.

column Isthe name of the column within the relational database
table. Use the same column name in two rows of atable.

OR

(2) SQL function, such asMAX (col_name) or COUNT (*). The result of
this function is written to the tag specified in the Tag Name field. SQL
functions are supported only in SELECT statements. SQL functions are not
supported in UPDATE statements or by the Historian for dBASE IV.

Valid Entry: alphanumeric string of 1 to 63 characters

Conditional statement that restricts the rows selected, updated, or deleted
from a database table. This field works in conjunction with the Column
Name and Logical Operator fields to generate the WHERE clause used by
the SQL statement.
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Note: Anembedded variablein Database Browser isaFactoryLink tag that is
preceded by a colon. The embedded variable can only be used in the Logical
Expressionfield. Theembedded variable can beany FactoryLink tag type except
mailbox. If thetag isan array specify the dimension (for example, tag_xyz[2] ).
The tag in the embedded variable is not detected by Configuration Explorer as
atag, therefore user must define the tag somewhere else in the application such
asin Math & Logic.

The conditional statement in a Logical Expression field can consist of
relational operators. The following is alist of relational operators that are
supported by the dBASE 1V historian.

= isequa to

< isless than

> is greater than

<> isnot equal to

<= isless than or equal to
>= is greater than or equal to

isnot null isnot anull value (for dBASE IV historian TRUE
when database column is not all spaces)

between  definesarange of valueswhere X isthe lower limit
XandY andY isthehigher limit. Thisisequal to
COLNAME >= X and COLNAME <=Y

If you are not using the dBASE IV historian, refer to the RDBM S SQL
Language user’s manual for more information.

The WHERE clauseis generated by appending the Local Operator, Column
Name, and Logical Expression fieldsin the order displayed in the Database
Browser Information table. Punctuation is supplied by the Database
Browser to ensure correct SQL syntax. Any embedded variable found in the
Logical Expression field is replaced by a?, which SQL definesas a
substitution marker for a value to be supplied at execute time. The value
supplied isthe tag's value defined by the embedded variable.

The string generated by thisis a WHERE condition. If the first word(s) in
this string is not an SQL reserved word such as ORDER BY, then the
reserved word WHERE is attached to the start of thisstring. Ensure that any
placement of SQL clauses such as ORDER BY and GROUPBY is properly
ordered as defined by the SQL language for the targeted database server.
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The ORDER BY clauseis supported in the dBASE IV historian but only to
the extent that the columnslisted in the ORDER BY clause must match an
index that was created for the database table. The dBASE |V historian does
not build any temporary tables to reorder the rows, so be sure the ORDER
BY matches an index for the dBASE |V database table. If an ORDER BY
clause does not match an index, the dBASE |V historian returns an error.

If you define a Select Trigger in the Database Browser Control table, the
WHERE clause is used for the selected statement. If a Select Trigger is not
defined, the WHERE clause is used for the either the update operation or
delete operation or both.

A Logica Expression can contain one of the following:

(1) Character string of up to 79 characters containing an SQL expression or
an SQL clause.

For example, an SQL expression:
OUTLETVAL =30 and TANKID = ‘BLUEOOY’

For example, an SQL clause:
ORDER BY TANKID

(2) Character string of up to 79 characters representing an SQL expression
that contains embedded variables. If the tag is a message tag, the character
datain the message tag should not be enclosed in single quotes.

For example:

=:tagTANKID

WHERE tagTANKID is a message tag of
value: BLUEQO1

(3) An embedded message variable only. THis variable must be a message
tag. The message tag contains an SQL clause or SQL expression. THe SQL
expression cannot contain an embedded variable and any string constantsin
the SQL expression must be quoted in single quotes.

For example:

:tagSQL Expression

WHERE tagSQL Expression is a message tag
OUTLETVAL = 30 and

TANKID = ‘BLUEOOY’

Note: Theresultisthe samefor Options 1 and 3, but Option 3 alows the user
to changethe SQL Expressiontag to adifferent expression before setting asel ect,
update, or deletetrigger, thereby altering the rows sel ected, updated, or deleted.
Option 1isawaysstatic and cannot be changed at run time. Option 2 allowsthe
user to change the value of TANKID but the SQL expression is still the same;
just the search criteria for the where clause changed.
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The Database Browser substitutes variables with the value of the tag
defined in the embedded variable when executing the select, update, or
delete SQL statement.

For example: =:tagTANKID

generates the following clause:
WHERE TANKID = ?

TANKID isthe value of the Column Name field.

The Database Browser reads the value of the tag tagTANKID from the
real-time database and substitutes its value for the ? whenever it executes a
select, update, or delete SQL statement.

The table resembles the following sample table when complete.

Database Browser Information - SHARED - Database Browser Inf... g@

EE| 3 X wB R F =l ?
Tag MName la?:-?airca?!:r Column Mame Logical E=prezsion

1 TanNkID[Z] TANE. TANKID =BLUEDD'
outlet[3] AND TAME.OUTLET »=OUTLETWAL

< |

»

Because the Select Trigger tag SELTAGL1 (defined in the Control table) is digital in this
example, the historian returns the two following val ues to the Database Browser task when the
change-status flag for SELTAGL is set:

 Values where the column named TANKID equals BLUEOO1
e The column named OUTLET is greater than or equal to the value of the tag OUTLETVAL.

The Database Browser task writes these values to the tags contained in the tag arrays
TANKID[3] and OUTLETI[3]. These values are then displayed in a browse window.
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PROGRAM ARGUMENTS

Argument Description
-L or -1 Enableslogging of debug information to alog file. By
default, the Database Browser does not log errors.
-N or -n Notifies on the completion of a SELECT trigger that

the query resulted in an EOF (End of Fetch) condition
if the rows returned from the query do not equal the
rows defined in the View Size. By default, the Database
Browser task does not report an End of Fetch condition
for a SELECT until a move operation advances the
current row past the last row of the query.

-S# or -si Set maximum number (# = 4 to 160) of open SQL
statements that the Database Browser will have active
at onetime. The default is 160. For very large
applications, this program switch may haveto be
adjusted if the database server is unable to allocate a
resource to open anew SQL cursor.

-V or -vi Set verbose level. (# = 0 to 1) Writes the SQL
statements generated by the Database Browser to the
log file. The Database Browser must have logging
enabled for this program switch to work. The default is
to not write the SQL statements to the log file.

-Wi# or -wit Historian time-out parameter. (# = 5 to 30 seconds).

Sets the maximum timeout in seconds for the Browser
towait for aresponse from the historian. The default is
30 seconds.

For values less than 30 seconds, this switch will only
work correctly when the historian initially achieves a
successful connection with the database server. If the
historian failsto successfully connect with the database
server, Database Browser will time out in 30 seconds
regardless of this switch setting.
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STATUS CODES AND ERROR MESSAGES

Thefollowing table lists status codes written to anumeric Completion Status tag defined in the
Database Browser Control table. The descriptive message is written to a message Completion
Statustag and is also be written to the Task Message tag in the System Configuration table. See

Chapter 13, “Historians” for status codes that are less than 100. The historian generates these
codes, and they are returned to the Database Browser task when an historian operation is

executed.
Code Error Cause Action

100 Asynchronouserror | An SQL COMMIT operation failed | Consult the database administrator
from Historian within the historian. for the external databasein use.
function.

101 Error from A syntax error may have been made | Correct the SQL statement syntax
Historian function. | or information may not have been error by modifying the Information

entered in arequired fieldina table for the task receiving the
configuration table. error. If the information is correct,
ensure the database tabl e exists.

102 Nofieldsfor select. | Thetask istrying to execute aselect | Define sometagsinthe Tag Name
operation, but no tags have been field in the Database Browser
defined to hold the data from the Information table.
select operation.

103 No fieldsfor insert. | The task istrying to execute an insert | Define some tagsin the Tag Name
operation, but no tags have been field in the Database Browser
defined to hold the data from the Information table.
insert operation.

104 Nofieldsfor Task istrying to execute an update Define sometagsinthe Tag Name

update. operation, but no tags have been field in the Database Browser
defined to hold the data from the Information table.
update operation.

105 Update and delete | Update and delete operations cannot | Do not perform update and delete
operations not be performed when using multi-table | operations when using multi-table
supported with view. view.
multi-table view.

106 Cannot update until | A select trigger is defined but aselect | Execute a select operation and then
select is performed. | operation has not executed. Execute a | retry the update operation.

select operation before an update
operation.
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Code

Error

Cause

Action

107

Cannot delete until
select is performed.

A select trigger is defined but a select
operation has not been executed.
Execute a select operation before a
delete operation.

Execute a select operation and then
retry the delete operation.

108 Cannot move until | A select trigger is defined but aselect | Execute a select operation and then
select is performed. | operation has not been executed. retry the move operation.
Execute a select operation before a
move operation.
109 Thisrow of data A delete operation attempted on a No action required.
has been deleted. nonexistant row
110 A FactoryLink FactoryLink PAK function Contact your technical support
function returned | encountered an unknown or representative.
an error. unexpected error.
111 A filefunctionerror | System encountered an unknown If not enough space, decrease the
occurred. error whiletrying to read or writeto | buffer size.
the external buffer.
112 Badtaginlogical |Either atypographical error existsor | Correct typographical errors. If you
expression. an undefined or invalid tag nameis | did not make atypographical error,
entered as an embedded variabletag |then definethetagina
in aLogical Expression field. FactoryLink task other than
Browser.
113 Invaliduseof tagin | Logical expression does not contain a | Correct typographical errors and
logical expression. |valid tag name. ensure the tag name is the name of
avalid tag.
114 HSDA structuretoo | Invalid use of ataginlogical Define the tag used in the logical
small. expression. expression in a FactoryLink task
other than Browser.
115 Can't open log file. | Disk spacetoo low. If disk spaceislow, delete
unneeded files or programs.
116 A request for Internal error. Contact your technical support
memory failed. representative.
117 Can't find unique | A positional update or delete Create aunique index for the table

index for table.

operation occurred on a table without
aunique index.

and retry the operation.
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One of the following messagesis displayed to the right of BROWSER on the Run-Time
Manager mimic if an error occurs with the Database Browser task or historian at run time. The
first three letters (nnn) in the message bel ow indicates whether the message came from the
Database Browser task (DBB) or the Historian (HIS). Seethe .LOG file to display the
complete message if it is truncated on the Run-Time Manager mimic.

Error Message

Cause and Action

nnn-[BAD_SMBX] Bad send mailbox. | Cause: You entered the wrong mailbox tag name.
Browse rec: browse window name Action: Use the same tag name for the Historian Mailbox fields
of the Historian Mailbox Information table and the
Database Browser Control table.
nnn-[BAD_WHERE_TAG] Bad tagtag | Cause: Either you made atypographical error or entered an
name for logical expression. Browse undefined or invalid tag name as the embedded message
rec: browse window name tag in alogical expression.
Action: Correct al typographical errors. Definethetag in another
task if needed.
nnn-[CT_HDR] No sel, upd, or delete Cause: Th select, delete, or update trigger is not defined.
trigger defined. Browse rec: browse Action: Define at least one of the triggers listed above.
window name
nnn-[DBTBL_SYNTAX] The Database | Cause: You left the“.” out of the entry in the Database. Table
Table value is missing a “.”. Browse Name field in the Database Browser Control table.
rec: browse window name Action: Puta“.” between the database name and the table name
in the entry in the Database. Table Name field.
nnn-[FILE_ERR] File function Cause:  The system encountered an unknown error while trying
“function” returned error error code. to read from or write to the external buffer.
Browse rec: browse window name Action: Verify you have enough disk space. If not, decrease the
buffer size.
nnn-[FL_FUNC] Function “function” Cause: TheFactoryLink PAK function encountered an unknown
returned error error code. Browse rec: or unexpected error.
browse window name Action: Report the error to your support representative.
nnn-[FL_FUNC] Function “FL_WRITE” | Cause: The column typein the database FactoryLink istrying to
returned error 9. Browse rec: browse read from does not match the column type defined in the
window name Database Logging task Schema Creation table.
Action: Make the column type in the Column Type field of the

Schema Creation table the same as in the database.
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Error Message Cause and Action

nnn-[FLERROR] FactoryLink error error | Cause: An unknown PAK function error occurred within the
number historian.

Action: Report the error to your support representative.

nnn-[HSCONNECT] Failed to connect | Cause: You may have specified the wrong mailbox tag name.

to historian Action: Specify the Historian Predefined mailbox tag namein the
Historian Mailbox field in the Database Browser Control
table.

nnn-[HSDA_TOO_SMALL] HSDA Cause: You specified an invalid tag in alogical expression.

structure too small. Browse rec:

; Action: Make surethat all tags used in the logical expression are
browse window name

defined.
nnn-[HSDBERROR] Historian database | Cause: This message is accompanied by various other messages
error: error message that describe the cause of the error.

Action: Read the accompanying message displayed on the
Run-Time Manager screen or in the .LOG fileand
attempt to correct the problem based on the instructions
in the message.

nnn-[HSDUPLICATE] Tried to inserta | Cause: You tried to insert aduplicate row into aresult table.

duplicate row Action: No action required

nnn-[HSENDOFETCH] Last row fetched | Cause: The task could not find arow during an update operation
or row not found because that row does not exist. Or, during a move or
position operation, you specified a nonexistent row (for
example, row 100 when the table has only 50 rows). You
attempted to go past the end or above the beginning of
the result table.

Action: No action required

nnn-[HSFLDEXISTS] Tried to add an Cause: You tried to add an existing field.

existing field Action: No action required

nnn-[HSMAXOPENS] Too many open | Cause: You tried to open more than 10 unique databases.

sessions Action: Use fewer than 10 databasesin a configuration table.

nnn-[HSMEMORY] Memory error Cause: Not enough memory is alocated for the historian.

malloc failed Action: Allocate more memory for the historian.
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Error Message

Cause and Action

window name

nnn-[HSNOFIELD] Tried to access a Cause: You tried to open a nonexistent field.

nonexistent field Action: No action required

nnn-[HSNOTABLE] Tried to accessa | Cause:  You tried to open anonexistent table.

nonexistent table Action: No action required

nnn-[HSPREPARE] Failed to prepare | Cause: A nonexistent table name or field name is specified or a
stmtid syntax error ismade in an SQL statement.

Action: Ensure al entriesin the Database Browser table are
correct, especially those for the SQL statement.

nnn-[HSSTMTID] Invalid stmtid Cause: The historian shut down before the Database Browser
returned from historian task or another historian-client task.

Action: Shut down the Database Browser, then all other
historian-client tasks, and then the historian. Restart the
historian, followed by the Database Browser and other
historian-client tasks.

nnn-[HSTBLEXISTS] Tried to create an | Cause: You tried to create an existing table.

existing table Action: No action required

nnn-[HSTIMEDOUT] Historian task not | Cause: A browser request did not get a response from the

responding. Maximum timeout historian within the timeout period.

exceeded Action: If thetimeout period is less than the time taken to serve
the request, you may increase the timeout, e.g., from
-w300 to -w400.

nnn-[HSUNKNOWN] Unknown function | Cause:  An error occurred within Browser.

request sent to historian Action: Report the error to your support representative.

nnn-[INVUSE_WHERE_TAG] Invalid Cause: A logical expression contains an invalid tag name.

use of tag in logical expression. Action: Correct all typographical errors and ensure the tag name

Browse rec: browse window name . .
isthe name of avalid tag.

nnn-[MULTI-VIEW] Update and delete | Cause: You tried to perform an update or delete operation while

oper_ations not supported with using multi-table view.

multi-table view. Browse rec: browse Action: Do not try to perform update or delete operations
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Error Message

Cause and Action

nnn-[NO_FLDS_INS] No fields for Cause: Thetask istrying to perform an insert operation but no
insert. Browse rec: browse window tags are defined to hold the data from the insert
name operation.
Action: Define some tags in the Tag Name field of the Database
Browser Information table.
nnn-[NO_FLDS_SEL] No fields for Cause: Thetask istrying to execute a select operation but no
select. Browse rec: browse table name tags are defined to hold the data from the select
operation.
Action: Define some tags in the Tag Name field of the Database
Browser Information table.
nnn-[NO_FLDS_UPD] No fields for Cause: Thetask istrying to execute an update operation, but no
update. Browse rec: browse table name tags have been defined to hold the data from the update
operation.
Action: Define some tags in the Tag Name field of the Database
Browser Information table.
nnn-[NO_LOGICAL_EXPR] No logical |Cause: A logical operation was defined but the logical
expr. Browse rec: browse table name. expression was not specified.
Column name: column name Action: Either delete the operation or create alogical expression.
nnn-[NO_MEMORY] Out of RAM Cause: Not enough RAM isavailable to run this task.

Action: Allocate more RAM for the Database Browser task.
nnn-[NOTASSOC] Col name column Cause: A non-existent or an invalid tag is specified. A column
name not associated with browse or name is also specified but not alogical expression.
where tag. Browse rec: browse window Action: Define atag in the Tag Name field of the Database
name ; . X

Browser Information table and/or specify alogica
expression.
nnn-[NO_UNIQ_INDX] Can't find unique | Cause: You attempted a positional update or delete operation on
index for table. Browse rec: browse atable without a unique index.
window name Action: Create a unique index for the table and retry the
operation.
nnn-[NULL_ROW] This row of data was | Cause: You attempted a delete operation on a deleted row.
deleted. Browse rec: browse window Action: No action required

name
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Error Message

Cause and Action

nnn-[NULL_TABLE] No data for this Cause: You tried to perform an update, move, or del ete operation

table. Browse rec: browse table name on aresult table that contains no rows of data because the
select operation resulted in no rows of data or you
deleted al rows of data from the table.

Action: No action required
nnn-[OPEN_LOG] Can't open .LOG file. | Cause: The computer may have run out of disk space.

Action: Delete any unnecessary files or programs.
nnn-[SEL_B4 DEL] Can't delete until | Cause: You defined aselect trigger but a sel ect operation was not
select is performed. Browse rec: executed. A select operation must be executed before a
browse window name delete operation can be performed.

Action: Execute a select operation before the delete operation.
nnn-[SEL_B4_MOVE] Can't move until | Cause: A select trigger is defined but a select operation was not
select is performed. Browse rec: executed. A select operation must be executed before a
browse window name move operation can be performed.

Action: Execute a select operation before the move operation.
nnn-[SEL_B4 UPD] Can't update until |Cause: A select trigger is defined but a select operation was not
select is performed. Browse rec: executed. A select operation must be executed before an
browse window name update operation can be performed.

Action: Execute a select operation before the update operation.
nnn-[SQL_ASYNC] Asynchronous Cause: An SQL COMMIT operation failed in the historian. For
failure to name. Error: error message. Oracle, it can fail if you do not have enough disk space.

Action: Consult the administrator for the database in use.
nnn-[SQL_SYNC] Historian function Cause: A syntax error was made or information for arequired
function failed. Error: error message field was not specified in a configuration table.

Browse rec: browse window name Action: Modify the information in the Database Browser
Information table to create a correct SQL statement if the
error isa syntax error. Ensure the database table exists.

nnn-[UNSOL_MSG_RCVD] Unsolicited |Cause: A task wroteto Browser’s mailbox tag unexpectedly.

message received from tag number Action: Check the X-reference list to see which task isusing the

same tag and change the mailbox tag name of the task.
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Error Message Cause and Action
F BAD_CT_SIZE Bad size for CT #(CT |Cause: Thereisadiscrepancy between the Database Browser
number) script file and the size. You may have modified the

Browser .CTGfile.

Action: Copy the .CTG file from the Installation disk over the
modified one.

F_BAD_RMBX Invalid global mailbox: |Cause: Browser’s predefined mailbox tag is nonexistent in the
mailbox name GLOBAL.CT file.

Action: Report the error to your support representative.

F_INIT Task initialization failed Cause: Thismessageis preceded by another error message that
explains the cause of the error.

Action: Examine the preceding message to determine the cause
of theinitialization failure.

F_NO_CTS No valid tables in CT Cause: The Database Browser tables have not been configured.

archive file name Action: Configure the Database Browser tables.

F_NO-DOMAIN_NAME No domain Cause: No domain nameis specified for the application
name for appl. directory directory directory.

Action: Specify adomain name for the application directory.

F_OPEN_CT Can't open CT archive file |Cause: A .CT file may have been deleted.
name Cause: Use CTGEN to rebuild the .CT file,

F_READ_CT Can'tread CT #CT number | Cause: A .CT fileiscorrupt.
in CT archive file name Action: Rebild the corrupt .CT file.
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The Database Logger task (Logger) writes blocks of datato a historical database to preserve
datafor historical purposes. Each time a new value for atag is collected or computed, the
current value of the tag in the real-time database is overwritten by the new data. To preserve
this data, the Database L ogger task reads the data from the real-time database and sends it to a
disk-based relational database through a historian.

The historian used for this transfer depends on the relational database receiving the data. The
database can be either the SQL Server database that can be purchased with FactoryLink or a
third-party relational database, such as Oracle.

With the Logger, you can create a table and specify which tags to capture in that table. When
the value of any tag changes, the values of al tagsin the table are logged. Database L ogging
provides the ability to group tagsin a database table, and event-based data can be logged using
a segquence key rather than atime key.

Database Logging is best for situations when you want to:
 Log al tags when any tag changes or is triggered

« Simultaneously log a group of like (logically associated) tags
 Group data logged based on some criteria

+ Configure atable column to be a dynamic pen on atrend chart

Dataislogged using logging operations. Each logging operation defines which datato log
when the operation executes. The operations and the data for logging with each operation are
defined in tables:

- Database Logging Control table—Defines the operations that log data
 Database Logging Information table—Defines which data to log with each operation

DATABASE LOGGING METHODOLOGY

This section describes and illustrates how real-time tags are logged to arelational database.

1. The real-time database receives and stores data in tags from various sources, such asa
remote device, user input, or computation results from a FactoryLink task. When datais
collected and stored in this database, other tasks can access and manipulateit.
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2. The Logger reads the values of tagsin the real-time database and maps the tags to columns
in a disk-based relational database table.

3. The Logger sends the data from the real-time database to an historian mailbox in the form
of an SQL INSERT statement. The request remains in the historian mailbox until historian
processes the request.

4. After historian processes the request, it connects to the relational database and inserts the
datain the relational database file, where other applications can use the data.

You must consider the following when selecting alogging method:

Grouping Data: FactoryLink permits you to log datawith or without a group association. If
you elect to log data without a group association (nongrouped), the table
delineates the data in the table from data in other tables.

Ordering Data  FactoryLink permits you to log grouped and nongrouped data with or
without a sequence or order number. If you elect to associate a sequence
number with rows of data, your table structure must include a column that
contains the sequence number associated with the row of data (record). The
sequence number can be an integer or atime-stamp.

Indexing Records are displayed in arelational database tablein the order they are
added. Thisis known as the natural or physical order. The field or fields
selected for indexing are called the index key.When atableisindexed, an
index fileis created that contains the indexed order. The actua record order
in the database file remains unchanged. Accessing indexed records is faster
than accessing non indexed records.

Deletion Methods The logging method you choose dependsin part on how data gets del eted
from the relational database. Your options include:

Record rollover
Subgroup rollover
Group data deletion

Note: If you'reusing thedBase |V historian, record rollover controlstable
size. If you're using another database, you should use a stored procedure and
PowerSQL to control table size.
Database Logging Available database logging methods include:
Methods Nongrouped/Nonsequenced Method
Nongrouped/Sequenced M ethod

Grouped Method
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This chapter describes how to configure logging and provides sample applications for the
following grouping methods:

Nongrouped/Nonsequenced Data

Use thislogging method if you want to log data without a group association and logging order
is unimportant.

The sample application for nongrouped/nonsequenced data is for a gasoline station that logs
the following data for an unleaded fuel storage tank:

¢ Tank level
e Tank pressure
» Tank temperature

Nongrouped/Sequenced Data

Use thislogging method if you want to log data without a group association and want to know
the logging sequence.

The sample logging operation for nongrouped/sequenced datais for a gasoline station that logs
the total gallons of unleaded and diesel gas pumped each hour of the day for 24 hours. The
hourly total is an accumulated value stored in areal-time database tag. Each time gasis
pumped, the number of gallons sold is added to the accumulated value.

The total for each type of gas (unleaded and diesel) islogged to different columnsin the same
table.

Grouped and/or Subgroup Data

Use thislogging method if you want to log data with a group hame, group name and subgroup
number, or subgroup number.

The sample logging operation is for a gasoline station that logs the total gallons of unleaded
and diesdl gas sold each hour of the day for each day of the week for aweek. The hourly total
is an accumulated value stored in a real-time database tag. Each time gas is pumped, the
number of gallons sold is added to the accumulated value.

Thetotal for each type of gas (unleaded and diesel) islogged to the same column in the same
table but distinguished by a groupname_subgroupnum in the group column.

Each day of the week is represented by the subgroupnum that increments at the end of each
day. Thetable sizeis controlled by subgroup rollover that occurs after seven days.
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DATABASE LOGGING CONTROL TABLE

The Database Logging Control table sets up the mailbox the Logger uses to communicate to
the historian as well as the database alias and table information that L ogger needs to pass to
historian.

The following examples are used with the discussion of the field definitions.

Database Logging Control - SHARED {WUS-RI... |- (O3

HE s2RX 2B » o8
ol 7
Nongrouped/
LogM Log Historian D atabaze Nonsequenced Data
g Mame Trigger b ailbox Alias Mame
1 HOMGROUP  hour_trig higtmbr uzco_log
4| | ’
Database Logging Control - SHARED (WUs-RI... |- (O3
(== B X «oF » % 5
ol 7
Nongrouped/
LogN Log Histarian Databaze Sequenced Data
g Mame Trigger b ailbox Alias Mame
1 SEQUENCE | hour_trig histrb uzco_log
4| | ’

Database Logging Control - SHARED (WUS-RI-... [- [0/

HE % BX wF B % 4
%
Grouped and/or
Subgrouped Data
Log M Log Histarian Databaze
SULLS Trigger t ailbiox Alias Mame
1 UMLEAD_GRP | hour_trig higtrnbe uzco_log
2 DIESEL_GRFP  howr_trig higtrnb ugco_log
| »
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In your server application, open Data Logging > Database Logging > Database Logging Control.

Field Descriptions

Log Name

Log Trigger

Historian Mailbox

Name to reference the logging operation.

The nongrouped/nonsequenced data example defines one logging
operation named NONGROUP that logs nongrouped tank data for the
unleaded fuel storage tank.

The nongrouped/sequenced data example defines one logging operation
named SEQUENCE that logs the total gallons of unleaded and diesel gas
sold each hour.

Thegrouped and/or subgrouped data example defines two logging
operations: one named UNLEAD_GRP that logs total gas pumped each
hour for unleaded gas and DIESEL_GRP that logs total gas pumped each
hour for diesel gas.

Valid Entry: alphanumeric name of up to 16 characters

Tag name that triggers the logging operation. If you leave this field blank,
the logging operation activates with the Log-On Change field in the
Database L ogging Information table.

In the nongrouped/nonsequenced data example, the NONGROUP
operation executes when the hour_trig tag is set.

In the nongrouped/sequenced data example, the SEQUENCE operation
executes when the hour_trig tag is set.

In the grouped and/or subgroup data example, both operations execute
when the hour_trig tag is set.

Specify both afield trigger and alog-on change in the Log On Change field
of the Database Logging Information table to enable the same operation.
The operation executes each time the trigger is set and each time the tag
value changes.
Valid Entry: tag name

Valid Data Type: digital, analog, longana, float, message
Mailbox tag name the historian uses to transfer data. You must define the
connection for this mailbox in the historian table.
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Nongrouped/ ol | 7
Nonsequenced Data

Database Logging Control - SHARED ( WUS-RI... |- |03
HE 2R X 2@ £ g
LogN Log Hiztarian Databaze
g Mame Trigger hd ailbo Alias Mame
1 HOMGROUP  hour_trig histmb uzco_log
® / l

Historian flailbox Information forS0BC - SHARED - Hist... |- | 0/E3)

HE bR B

R

ol 7

Higtorian
bzl
1 ALLOG_HIST_ME=
2 DELCHISTHER
3 DPLCHISTHER
4 SECURITYME=
3 hiztrbs
f| 1l Database Logging Control - SHARED (WUs-RI... - (O3
HEIEE fBaax «oF » % 5
Nongrouped/ I"’I %
Sequenced Data
Lag N Log Hiztorian Databaze
00 Hame Trigger M ailbos Aliaz Mame
1 1 SEQUEMCE  hour_trig hiztrnbe usco_log

H Historian )‘ailhux Infurmatim

|
DBC - SHARED - Hist... - )0/

SIEEREY BRI

F ®» 06

ol 7

Hiztarian
F ailbro

ALLOG_HIST_MBEX
DELCHISTMB
DPLCHISTHB
SECURITYMEX
histrnbs

L] B LN] AN E
= oo ra)—

102 / FactoryLink Task Configuration Reference Guide



DATABASE LOGGER | 6
Database Logging Control Table

Database Logging Control - SHARED {WUS-RI-... (- [O)E3
HE R X @ » oK
ol | ?
Grouped and/or ——
Log Hiztorian Databaze
Subgrouped Data Log Name Trigger Mailbox bliaz Mame
1 UMLEAD_GRP | hour_trig hiztrnbe usco_log
2 ]| GRF  hour_trig hiztrnbe usco_log
Historian Mailbox Information for ODBC - SHARED - Hist... |- | 0/E3)
FEINEY B : F/ @@l W e
Histo?ian
t ailbo
1 ALLOG_HIST_MEX
2 DELCHISTMER
3 DPLCHISTMER
4 SECURITrMER
3 higtmbs

For more information on the strategy for defining historian mailboxes, see
“Historians’ on page 253.

Valid Entry: mailbox tag name

Database Alias Database alias name that references the database where historian sends the
Name data You must define the same alias name in the historian table when
defining the mailbox connection. In the examples, the datais logged to the
USCO_LOG database, which is an alias for referencing the USCO
database.

Valid Entry: database alias name

FactoryLink Task Configuration Reference Guide / 103



. 6 | DATABASE LOGGER
Database Logging Control Table

Database Logging Control - SHARED (WUs-RI... - |00
(== B X «vBE B B 5
2
Nongrouped/
Nonsequenced Data Log N Log Histarian Databaze
00 Mame Trigger b il Aliaz Name
1 MOMGROUP | hour_trig hiztrnbs uzco_log

_ ]
Historian Iformation for ODBE SHARED - Historian In].. [~ ] (01 23

HS sfaX of ENXF 288/ M ¢

Databdze Dizable/Ena o o S
Aliaz Mame  |Connection ANNECtan Jining
1 ALOG 'DSMH=MyFlink; UID=za; FWD=
2 MY THEMND 'DSMH=MyFlink; UID=za; FWD=
3 MYDRgOG 'DSMH=MyFlink; UID=za; FWD=
4 SECIRITY 'DSMH=MyFlink; UID=za; FWD=
] USCO_LOG 'DSMH=MyFlink; UID=za; FWD=
< | 3
Database Logging Control - SHARED (WUs-RI... |- (O3
HEE % BX vE » % 5
%
Nongrouped/ H
Sequenced Data —
Log Mame ng H|3F0r|an D.;tabase
d Trigger M ailbos Aliaz Mame
1 SEQUEMCE  hour_trig hiztrnbe usco_log

z
Historian Information for ODBC - SHARED - Historian Inf... |} (01 &3
HE s 2B X ©F Foepe /2

Databaze Dizable/Ena |,
Alias Mame | Connech
1 ALOG 'DSM=MyFlirk: UID=sa; PWD=
2 MY TREMD 'DSM=MyFlirk: UID=sa; PWD=
3 WY DPLD 'DSM=MyFlirk: UID=sa; PWD=
4 SECURITI 'DSM=MyFlirk: UID=sa; PWD=
3 USCO_LOG 'DSM=MyFlirk: UID=sa; PWD=
4| | 3
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Database Logging Control - SHARED (WUS-RI-... - [0/g3
HE 2R X 2@ £ o 3
ol %
LogN Log Hiztarian Databaze
g Mame Trigger hd ailbo Alias Mame
1 UMLEAD_GRP  hour_trig histmb uzco_log
2 DIESEL_GRP  hour_trig histmb uzco_log

. |
Histurial}/lnfnrmatinn for ODNARED - Historian Inf... E]@
FEINEYT IR VGEY Y WIS

Databaze Dizable/Ena o tiom St
Aliag Mame | Connection ONMECHan 2Hing
1 ALDG 'DSMN=MyFlink; UID=za; FWD=
2 MY{TREMD 'DSMN=MyFlink; UID=za; FWD=
3 MPFPLOG 'DSMN=MyFlink; UID=za; FWD=
4 SECURITY 'DSMN=MyFlink; UID=za; FWD=
3 USCO_LOG 'DSMN=MyFlink; UID=za; FWD=
< | 3

Unique name to reference the table in the relational database that receives
the data. If this table does not already exist in the relational database when
dataisloggedtoit, it is created using the schema defined in the Schema
Name field.

Valid Entry: unique name of up to 31 characters

Name that defines the relational database table structure that receives the
data. If the table specified in the Database Table Name field does not already
exist in the relational database when dataislogged toiit, it iscreated using
the schema defined in thisfield.

If you enter aname in thisfield, it must match the name defined in the
Schema Name field on the Schema Control table. If it does not match a
defined schema name, it isasif you left thisfield blank.

A tableisnot created and datais not logged if you leave thisfield blank.
Valid Entry: schemaname
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Schema Control - SHARED { WUS-RI-WS0032\Starterapp ) |- /|04
[=R=N B X B B B H ol %
Schema Mame b amimum Recordsz
Nongrouped/ 1 MYTREMD_SCHEMZ,
Nonsequenced Data 2 MOMGRP_DATA 100
3 GROUP_DATA
4 SEQUEMNCE| DATA 100
Database Loggihg Control - SHARED ( WUS-RI-wsoo32wt... (- 03I
In this example, .
the nongrp_data HE & 3 X 0P » o -l %
schema is used. [ atabaze hema N Frioiit Completion Curent Sequence
Table Hame EMa ame Moy e tatus Tag Tag
Data is logged to the 1 hongrp_table | mongrp_data i hongrp_done
database table named *
nongrp_table.
4 >

Schema Control - SHARED ( WUS-RI-WS0032\Starterapp ) |- /(023
HE tBRX 2P ® LR ol 7
Nongrouped/ Schemna Narme Maxirmum Records
Sequenced Data 1 [MYTREND_SCHEMA
2 |NONGRP_DATA 100
3 |GROUP_DATA
4 |SEQUENCE_DATA 100
In this example, :

the sequence_data
schema is used.

Databade Logging Control - SHARED ( WUS-RI-WS0032\St... g@]"
& s elx oF 2R M T

Data is logged to the Databaze Coherds Mame | Pricgite | SOmPlEtion Current Sequence
database table named Table Mame ¥ |Status Tag Tag
seg_table. 1 zeq_table sequence_data |0 zeq_done

4| | ’
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In this example,
the group_data
schema is used.

Data is logged to the

database table named
grpsub_table.

Priority

Disable Tag

Completion Status
Tag
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Schema Control - SHARED ( WUS-RI-WS0032Starterapp ) |- |05
HEE % B X | » 5B - 7
Schema Mame I aimum Fecords
1 MY TREND_SCHERA,
2 NONGRP_DATA 100
3 GROUF_DATA
4 SEQL‘ENCE_DATA 100
| F Datdpase Logging Control - sHaRED (wus-R1-w... [ O3
H&E\% BX vE » % 5
2
D atahaze .. Completion Current 5
Tabg\{ne Schema Mame | Pricrity Status Tag Tae
1 gipzub_table | group_data 1] ugrsub_done ugrzub_o
2 arpzub_table | group_data 1] darpzub_done darzub_o
< | | 3

Number that controls the order in which Logger handles the queueing of
logging operations. Thisisarelative priority to other logging operations.
For example, if Logger receives two requests at the same time from two
different operations, it processes the request with the highest priority
(lowest number) first.
Valid Entry: 0to9
Default: 0

Tag that disables logging operations. This must be in the Shared domain.

Valid Entry: tag name
Valid Data Type: digital, analog, float, or longana
Default Entry: digita

Tag updated by Logger to indicate the compl etion of thislogging operation.
A liswritten to thistag after dataislogged to the historian mailbox. Do not
specify atag name if you do not want to track the completion of this
logging operation.
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Thisfield istypically used for coordinating activities between tasks. That is,
you can use the completion of thislogging operation to trigger another task
or operation.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float

In the nongrouped/nonsequenced data example, the remaining fields are
not needed and are left blank.

In the nongrouped/sequenced data or group and/or sequence data, the
following two fields are only used if you are using an integer sequence
number to order the logged data.

Current Sequence Tag name that stores the current sequence number for thislogging
Tag operation. The next time alogging operation occurs, the value stored in this
tag isincremented by one and the new value is assigned to the row of data.

The Current Sequence Tag valueis saved in afile when FactoryLink is not
running and updated to this field when FactoryLink is restarted, so
interrupts do not cause problems with duplicate records in the relational
database table.

Valid Entry: tag name
Valid Data Type: analog, longana, float

Sequence Change Tag name used to adjust the numbering sequence during run time when
Tag ordering data by integer. Thisfield provides the ability to manually create
gaps in the numbering sequence of ordered data.

If you leave this field blank, you can never manually adjust the numbering
sequence of ordered data.

When avalueis force written to the tag specified in thisfield, the value
written is used to adjust the Current Sequence Tag value. For example, if the
Current Sequence Tag valueis 5 and you force write avalue of 5 to thistag,
the Current Sequence Tag changesto 10.

If the tag typeis digital, increment the Current Sequence Tag by 1 by force
writing a 1 to the Sequence Change Tag.

If the tag type is analog, long analog, or float, force write any whole
positive or negative number to the Sequence Change Tag. If you write a
positive number, the value of the Current Sequence Tag increments by the
specified number. If you write a negative number, the value of the Current
Sequence Tag decrements by the specified number.
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Be careful when adjusting the Current Sequence Tag by a negative number
asthis can cause two rows of datato have the same sequence number. If the
sequence number is part of a unique index, duplicate record values are not
permitted in the column. If an attempt is made to log a duplicate value,
FactoryLink displays an error message and the data is not logged.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float

In the nongrouped/sequenced data example, the remaining fields are
blank. They are not needed for nongrouped/sequenced data.

Inthegrouped and/or subgrouped data example, thefollowing fieldsare
only needed if you are using an integer sequence number to order the
logged data.

Tag name that contains the group name to delete when the Group Delete
Trigger tag executes. When group deletion istriggered, al group datais
deleted. If the group contains subgroups, all subgroups and their data are
deleted.

If you do not specify atag in thisfield, you can never delete data by
specifying a groupname. If you do not specify atag in thisfield but do
specify a Group Delete Trigger, al nongrouped data sequenced by integer
and all subgroups without a groupname association are deleted from the
table when the trigger executes.

Enter the name of the group to delete in the Value field of the Tag Editor.
Valid Entry: tag name
Valid Data Type: message, digital, analog, longana, float

Tag name that triggers the deletion if you want to delete data by group
based on an event. When this trigger is set, the data for the group specified
in the Group Delete Tag field on thistable is deleted.

If you leave thisfield blank, deletion of group datais never triggered.

L eave the Group Delete Tag and Group Delete Trigger fields blank if you are
subgrouping data without a group association. If you wish to delete
subgroup data without a group association, use the subgroup rollover
feature to delete nongrouped data sequenced by integer.
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The following table shows the fields in the Database L ogging Control table
displayed after the Group Delete Trigger field. Leave the fields blank if you
are not using subgrouping.

Database Logging Control - SHARED ( WUS-RI-WS0032st... |- ||0/E3
HE 4 X vo@ i e ol | 7

Group Delete Current Subgroup Subgroup Change b amimum
Trigger Tag Tag Subgroups
1 uday_zubgroup dayend_trig 7
2 dday_zubgroup dayend_trig 7
< »

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float

Note: Misleading Error When Doing GROUP DELETE:

A SERIAL tableisnot created if Logger is configured to log GROUP data
without using a sequence column. However, when the trigger for GROUP
DELETE isactivated, an attempt ismadeto del ete the appropriate entry from
the SERIAL table for this group. This attempt produces an error, because it
tried to access a nonexistent table. The datais correctly deleted from the
database table, and the error has no effect on the historian and/or L ogger
operations that follow.

Current Subgroup Tag that stores the current subgroup number for this group.

T80 The next time anew subgroup is created for this group, the value stored in
thistag is adjusted by the amount defined in the Subgroup Change Tag field
on this table and assigned to the new subgroup.

If thisfield is left blank, subgroups are not supported for this group and no
subgroups are created for this group.

The value of thistag is set to O at group delete and 1 at subgroup rollover.

The Current Subgroup Tag value is saved in afile when FactoryLink is not
running and updated to thisfield when FactoryLink is restarted so interrupts
do not cause problems with duplicate records in the relational database.

Valid Entry: tag name
Valid Data Type: analog, longana, float
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Tag that triggers a subgroup change. When the tag value changes, a new
subgroup is created. The value to assign to the new subgroup is calculated
by adjusting the value in the Current Subgroup Tag by the value in the
Subgroup Change Tag. Thisfield provides the ability to manually set or
change the subgroup numbering sequence.

If you enter atag namein thisfield, atag must also be defined in the Current
Subgroup Tag field. Leave thisfield blank if you are not using subgrouping.

If the tag typeis digital, the Current Subgroup Tag increments by 1 when 1
isforce written to this tag.

If the tag type is analog, long analog, or float, force write any whole
positive or negative number to thistag. If it contains a positive number, the
value in the Current Subgroup Tag increments by the specified number. If it
contains a negative number, the value of the Current Subgroup Tag
decrements by the specified number.

Be careful when adjusting the Current Subgroup Tag by anegative number.
This can cause two subgroups to have the same number. If the group ID is
part of a unique index, duplicate record values are not permitted in the
column. If an attempt is made to log aduplicate value, FactoryLink displays
an error message and the data is not logged.

Leave thisfield blank to use the same subgroup number each time this
trigger executes.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float

Maximum number of subgroups allowed before subgroup rollover occurs.
If you leave thisfield blank but have specified a subgroup tag, the Logger
continues to increment the subgroup number indefinitely until the disk is
full.

You must define atag in the Current Subgroup Tag field for subgroup
rollover to occur.

Valid Entry: numeric value
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DATABASE LOGGING INFORMATION TABLE

The datato log with each operation is defined in the Database L ogging Information table. This
table also maps the data to specific columnsin the relational database table receiving the data.
This section describes how to compl ete the Database L ogging Information table to log datafor
the sample application to one of the following tables.

Nongrouped/Nonsequenced Data

gallons pressure temp
Nongrouped/Sequenced Data
Order_col Time_col Ugal_sold Dgal_sold
Grouped and/or Subgrouped Data
group_ID order_col gals_sold

Accessing

In your server application, open Data Logging > Database Logging > Database Logging Control
> “your trend” > Database Logging Information.

Database Logging Control - SHARED {WUS-RI... - (O3

Nongrouped/
Nonsequenced Data

This example shows

three columns:
gallons, pressure, and temp.

HE sB2RX 2Fp ® o
ol %
Lag N Log Histarian Databaze
0g Hame Trigger b ailbox Alias Mame
1 MOMGROUFP | hour_trig higtmbr uzco_log

Database Logging Information - SHARED - Database Logg... E]@

—{|

"

4 .
g smex cPE IR PR W7
Tag Mame Column Name tdea:g.lthg. Iﬁﬂgr?gr; Ezgg;n
1 utank_gals gallons 1] MO DATA,
2 pressure 1] MO DATA,
3 temp I MO DATA

112 / FactoryLink Task Configuration Reference Guide



DATABASE LOGGER | 6
Database Logging Information Table

Database Logging Control - SHARED ({ WUSRL... x Nongrouped/
_ i { E]@. Sequenced Data
HE 2R X 2@ £ g
H 7 This example shows
four columns:
Loa N Log Hiztarian D atabaze order_col, time_col,
REHAME ) Tringer M ailbo Alias Mame ugal_sold, and dgal_sold.
1 SEQUEMNCE | hour_trig hiztrnbs uzco_log
*/
l .
\ « | Database Logging Information - SHARED - Database Logg... g@
HE % X vop FiF &0 s IS
Max. Mzg. |Log On |Column
Tag Mame Colurin Mame Length Dheree |[Useas
1 unlead_gals ugals_zold 0 MO DATA,
2 diegel_galz dgals_zold 0 MO DATA,
3 order_cal I MO SEQUEMCE
4 time_col 0 MO TIME
Database Logging Control - SHARED { WUS-RI-... [~ |[O)E3 Grouped/
- Subgrouped Data
HE sB2RX 2Fp » o8
ol 7
This example shows
Lag N Log Histarian Databaze three columns:
0g Hame Trigger Mailbox Aliaz Mame gals_sold, group_ID,
1 _|UNLEAD_GRF  hou_tig histmb usco_log and order_col.
2/ DIESEL_GRF  hour_trig higtmbr uzco_log
\ i N
1
\» Database Logging Information - SHARED - Database Loggi... g@
HE & X v | R | 7
tax. Mzg. (LogOn  |Column
Tag Hame Colurmn Mame Length Change |Usage
1 unlead gals galz_sold 0 MO DATA,
2 unlead_group group_ 1D 0 MO GROUP
3 arder_cal 0 MO SEQUEMNCE
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Field Descriptions

Specify the following information for this table:

In the nongrouped/nonsequenced data:

Tag Name Tag name that references the tag to log in the column this entry represents.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message

In the nongrouped/sequenced data:

Tag Name What you enter in this field depends on the usage of the column that
receives the logged data. The options are described in the following table.

Column
Use

Tag Name Field Value

data

Tag to log in the column represented by this entry

sequence

If you want to manually set the sequence number to use for
the next logging operation, specify the tag that contains the
absolute number you want to use. If you never want to
manually set the sequence number, leave thisfield blank.

If thistag value is any number except 0, that number is
assigned as the sequence number for the next row of data
logged. Then thistag valueisreset to 0. If arecord with that
seguence number already exists and the sequence number is
part of a unique index, datais not logged.

If thistag valueis O, the next sequence number assigned to a
row of datalogged isthe valuein the Current Sequence Tag
field after it isincremented by one.

This operation does not update the Current Sequence Tag
field. The next sequence number assigned continues from the
number in the Current Sequence Tag field.

time

Do not specify atag name. SECTIME is always used.

The data type of the tag defined depends on the column usage. The options
are described in the following table;

Column Usage Valid Tag Types

data digital, analog, longana, float, message

sequence analog, longana, float

time The global tag SECTIME isaready defined. You do not

need to specify atype.
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In the grouped and/or subgrouped data:

Tag Name What you enter in this field depends on the usage of the column that

receives the logged data. The options are described in the following table.

Codg?n Tag Name Field Value
data Tag to log in the column represented by this entry
group Tag name that contains the name of the group associated
with this operation.
time Do not specify atag name. SECTIME is used.
sequence | If you want to manually set the sequence number to use for

the next logging operation, specify the tag name that
contains the absolute number you want to use. If you never
want to manually set the sequence number, leave thisfield
blank.

If thistag value is any number except 0, that number is
assigned as the sequence number for the next row of data
logged. Then thistag valueisreset to 0. If arecord with that
sequence number already exists and the sequence number is
part of aunique index, datais not logged.

If thistag value is O, the next sequence number assigned to a
row of datalogged is the value in the Current Sequence Tag
field after it isincremented by one.

This operation does not update the Current Sequence Tag
field. The next sequence number assigned continues from
the number in the Current Sequence Tag field.

The data type of the tag defined depends on the column usage. The options
are described in the following table:

Codgrenn Valid Tag Types
data digital, analog, longana, float, message
sequence | analog, longana, or float
time The global tag SECTIME is already defined. You do not
need to specify atype.
group If groupname is numeric, use digital, analog, longana, or
float. If groupname is made up of characters, use message.
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Column Name Name of the column to receive the data specified in the Tag Name field.

Nongrouped/
Nonsequenced Data

Nongrouped/
Sequenced Data

If the table structure is defined through the relational database software, the

name must match one of the columns defined for the table.

If the table structure is defined through FactoryLink, the name must match
one of the column names defined in the Column Name field on the Schema

Information table. Thisrelationship is shown in the following graphics.

Valid Entry: column name

Schema Information - SHARED - Schema Information (... [Z]@

EHE 3 X v | (R ol 2
Caol Length
Colurnn Mame Uz:g;;n Colurnn Type F'?Qc%sioﬂ
1 gallans DaTa IMTEGER
2 pressure DATA FLOAT
3 temp DaTa IMTEGER

Datahasé\Lngging Information - SHARED - Database Logg... [Z]@

HE s2eX oF F I F &8 ol | ?
tax. Mzg. |Log On | Calumn
TaagMame | Calurni M arme Lty Dhenge | Uszee
1 utank_aals gallons I} MO DATA
2 pressure 0 MO DATA
3 temp a MO AT

Schema Information - SHARED - Schema Information (\... g@

HE sB2@aX vF g -E ol ?
Colurmn Length or
Column T:Jame Uszee Column Type Eesdm
1 order_c SEQUEMCE
2 time_col TIME
3 ugals_zol DATA INTEGER
4 dgals_sol DATA, integer

= Datahasé\Lngging Information - SHARED - Database Logg... g@

S s 2eX oF | FlIF 20 W9
tax. Mzg. |Log On | Calumn
Tag Mame >Cu:lun'm M ame Lty Dhenge | Uszee
1 unlead_gals ugals_sold I} MO DATA
2 diezel_gals dgals_sold 0 MO DATA
3 arder_col a MO SEQUENCE
4 time_col I} MO TIME
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Schema Information - SHARED - Schema Information (‘... E]@
Grouped/ HE s B X wp R F ol %

Subgrouped Data

Cal Length
Calurnn I:Jame Uz:;?: Colurnn Type P?:cﬂsioir
1 gals_zal DATA INTEGER
2 group_| GROUP
3 order_cal SEQUEMCE

Database \ugging Information - SHARED - Database Loggi... [Z]@
HE sBaX oF Y X LI

Max. Meg. |Log On | Column

Tag Mame >EIUIumn Hame Length e |Uszes
1 unlead_gals galz_sold 0 MO DATA
2 unlead_group aroup_ID i} [ 1] GROUP
3 order_col 0 NO SEQUENCE

Max. Msg. Length  Maximum number of characters allowed in the column. If you leave this
field blank when the tag type is message, a default of 80 is assumed. The
value specified in this field should aways be equal to or less than the value
specified in the Length or Precision field on the Schema Information table.

Leave thisfield blank to assume a default of O for tags defined with atag
type other than message, which indicates thisfield is not used.

Valid Entry: 1to 999 (if message)
Default: 80

Log On Change Specify whether or not the logging operation is triggered if the specified
Tag Name field value changes. This can be one of the following:

YES When the tag value changes, the log operation occurs. If
you leave the Log Trigger field blank on the Database
Logging Control table, you must indicate YESin thisfield
for at least one tag on this table to activate the logging
operation.

NO When the tag value changes, the log operation does not
occur.

Specify both atrigger in the Log Trigger field of the Database Logging
Control table and alogin change in thisfield for the same operation. The
operation executes each time the trigger is set and each time the value
specified changes.
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Column Usage Kind of information sent to the column.

In the nongrouped/nonsequenced data example, column usage isdata
for each column in a table logging nongrouped/nonsequenced data.

d/ Schema Information - SHARED - Schema Information (... g@
Nongroupe =
Nonsequenced Data EE % X v @ R ¥ | %
Columni Mame Szg‘;‘: Column Type :E,?Qg:;oﬂ

1 gallons D& INTEGER

2 pressure DAT, FLOAT

3 temp DATA INTEGER

| Database Logging Infl:hwt\ion - SHARED - Database Logg... g@

HE r 22X o FRUF 2080 b/ 7

Max. Msg |Cogn Polumn

Tag Mame Column Mame Lenath Dhemae |[Useee

1 utank_gals gallons 0 WO DATA,
2 pressune 0 MO DATA
3 temp 0 MO DATA

In the nongrouped/sequenced data example, column usage isone of
the following:

data Usefor columnsthat do not receive a sequence number
in the form of an integer or time-stamping.

sequence Use for columns receiving a sequence number in the
form of an integer.

time Usefor columns receiving a sequence number in the
form of atime-stamping. The time-stamping used is
SECTIME.
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Schema Information - SHARED - Schema Information (\... g@
Nongrouped/ B )
Sequenced Data HS & & X ﬁ ﬁc £l @ @ H ?
Cal Length
Column Mame UZ:;: Column Type P?;gsinﬂ
1 order_col SEQUEMCE
2 time_col TIM
3 ugals_zold DATA INTEGER
4 dgals_sold DATA, integer
Database Logging Infl\ﬂm\atiun - SHARED - Database Logg... E]@
HE & X9 i (R E ol 2
[LET - og On J Calumin
TaagMame Calurnn Mame Lty JE#;E"Usage
1 unlead_gals ugals_sold I} MO DATA
2 diezel_gals dgals_sold 0 MO DATA
] arder_col i MO SEQUENCE
4 time_col I} MO TIME

Inthegrouped and/or subgrouped data example, column usage isone
of the following:

DATA Usefor columnsthat do not receive a sequence number
or group ID.

SEQUENCE Use for columns receiving a sequence number in the
form of an integer.

TIME Usefor columns receiving a sequence number in the
form of atime-stamping. The time-stamping used is
SECTIME.

GROUP Usefor columns receiving the group identification
assigned to the row of data.

If you leave this field blank, data is assumed even though the word data
does not display in the field.

If the table structure is defined through FactoryLink, the value entered in
thisfield must match the value entered for this column in the Column Usage
field on the Schema Information table.
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Grouped/

E L
Subgrouped Data HE & x o ﬁ ﬁc Ea @ @ H ?
Caol Length
Colurmn Mame Uz:glj-?en Column Tepe F'?Qc%sioﬂr
1 gals_sold DATA INTEGER
2 group_ 1D GROUFP
3 arder_cal SECNJEMCE
n Database Logging Inforimation - SHARED - Database Loggi... g@
HE 4 X o F »HB 7
Tag Mame Calurin Mame tdea: ch lEI?‘ugar? g 52!:;:1
1 unlead_galz galz_gold i HO DATA
2 unlead_group group_|D i HO GROUP
3 order_cal ] [ 1u} SEQUENCE

Schema Information - SHARED - Schema Information (‘... E]@

TESTING DATABASE LOGGER OPERATIONS

Once you have configured data logging, test the configuration using RTMON or DBX/DBT to
ensureit is functioning properly. Perform the following steps to troubleshoot the logging
configuration:

1.

Using the Run-Time Monitor (RTMON) or DBX/DBT, add the following itemsto awatch
list for the tags you are logging and triggers you are using for a single logging operation.

Using the Tag Input feature, enter sample data into each real-time database tag you are
logging and trigger the tag that executes the logging operation you are testing.

Check the relational database tables to seeif the sample data gets logged.

Trigger subgroup rollover and add more sample datato check that subgroup rollover occurs
properly.

Trigger subgroup rollover using a number that exceeds the maximum number of subgroups
allowed to check that subgroup rollover returns to one at the proper time.

Trigger group delete to check that group datais deleted at the proper time.
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In the
Run-Time Manager
window, does the Logger task
indicate "Running” with
no errors?

Is the activation trigger
being set to 1 by the task setting
he event? (Use RTMON

Is the Historian running
with no errors in the Run-Time
Manager window?

Does the Mailbox name in
Logger match the one in the
Historian table?

Check the Error Messages
section. Take the suggested
action.

Trace the source of the trigger.
Use RTMON to force write the
trigger for testing.

Check the Error Messages
section. Take the suggested
action. If this does not work,

troubleshoot Historian.

Make a change in either table so
they match. Then, rerun.

The system may be logging OK,
but the Historian requests are
being cached. Either place debug
in Logger and Historian (using
program arguments) and retest
looking at results, or continue
with flowchart.
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Did the
table specified in the Logger
Control get created?

Did values get put in
the database? (Use the SQL
utility to determine this.)

SOA

Do the indices and the No
schema match?

In the Program Arguments field in
the System Configuration
Information table, place a V4 and
a -L in the rows for Logger and
Historian. Restart, then manually
trigger. Look at log files for errors.

Do the tags in the Logger
Information table have
real values?

Are these in the same tags
as in Logger tables?

In the Program Arguments field in
the System Configuration
Information table, place a V4 and
a -L in the rows for Logger and
Historian. Restart, then manually
trigger. Look at log files for errors.

Make appropriate changes in the
Schema tables, delete the
existing table, and restart.

Use the RTMON tag watch list to
see tag values. For testing, you
can place values in the tags
using RTMON or DBX/DBT.

Make necessary edits to
the tables.

Logger is working

properly.
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Argument

Description

-D or -d

Enables debug information to be sent to the shared
window.

-E or -e

Causes Database Logging to set the completion trigger
when the historian task processes the logging
operation. By default the completion is set when
Database Logging sends the request to the historian
mailbox. With this switch, the completion trigger for all
log operations means the historian task has processed
the logging transaction.

Setting the completion trigger does not guarantee the
log transaction is successful; it only meansthe log
transaction has compl eted.

-L or -1

Enables error logging to the log file. By default
Database Logging does not log errors.

-QF or -qif

Sets the maximum number of outstanding
asynchronous logging transactions (SQL statements)
for the historian task to complete. Once thislimit is
reached, Logger operates synchronously until the
number of uncompleted transactions is reduced. By
default Logger alows for up to 100 outstanding
logging transactions before operating in a synchronous
mode.

(# = 100 to 2,000,000,000)

-S# or -si

Sets the maximum number of concurrently prepared
SQL statements active at one time. The default is 30.

(#= 110 30)

-V1 or -vl

Causes Logger to write the SQL statements generated
by the Database Browser to the log file. The Database
Browser must have logging enabled for this program
switch to work. The default isto not write the SQL
statements to the log file.
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Argument

Description

Wi or -wi

Sets the maximum time-out in seconds for Database
Logging to wait for aresponse from the historian task.
The default is 30 seconds.

(#= 510 30)

For values less than 30 seconds, this switch will only
work correctly when the historian initially achieved a
successful connection with the database server. If the
historian has never successfully connected with the
database server, Logger will time out in 30 seconds
regardless of this switch setting. The -w switch always
works for time-outs set at more than 30 seconds,
whether the historian initially achieved a successful
connection with the database server or not.

Note: Do not set arbitrarily high values for this
argument becauseit could delay the detection of an
actual network or server malfunction.
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ERROR MESSAGES

Error Message Cause and Action

Bad activation trigger in Log name: Cause: Aninvalid activation trigger existsin the DBLOG.CT
logname file

Action: Verify the datatype of the tag that triggers the logging
operation specified by logname is avalid type where
logname is the name designated for the control entry.
Logging operation triggers are specified in the Log
Trigger field of the Database Logging Control table.
Only digital, analog, long anal og and floating-point types
arevalid. If incorrect, delete the tag, recreate it with a
valid datatype, and then restart the application.

Bad Completion trigger in Log name: | Cause: Aninvalid completion trigger existsin the DBLOGCT
logname file

Action: Verify the datatype of the tag that identifies the
completion of the logging operation specified by
logname is avalid type where logname is the name
designated for the control entry. Logging completion
triggers are specified in the Completion Status Tag field
of the Database L ogging Control table. Only digital,
analog, long analog and floating-point types are valid. If
incorrect, delete the tag, recreateit with avalid datatype,
and then restart the application.

Bad current sequence tag in Log hame: | Cause: The Current Sequence tag hasaninvalid datatype for the

logname logging operation specified by logname.

Action: Verify the datatype for the Current Sequence Tag on the
Database Logging Control tableis digital, analog, long
analog, or floating-point. If incorrect, delete the tag,
recreate it with avalid data type, and then restart the
application.
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Error Message

Cause and Action

Bad current subgroup tag in log name:
logname

Cause:

Action:

The Current Subgroup Tag has an invalid data type for
the logging operation specified by logname.

Verify the data type for the Current Subgroup Tag on the
Database Logging Control tableis digital, analog, long
analog, or floating-point. If incorrect, delete the tag,
recreate it with avalid data type, and then restart the
application.

Bad field type in schema name:
schemaname, field name fieldname

Cause:

Action:

The Column Type field on the Schema Information table
isblank and data is defined in the Column Usage field.

Ensure the Column Type field and Column Usage fields
of the Schema Information table are compatible.

Bad group delete tag in log name:
logname

Cause:

Action:

The Group Delete Tag has an invalid data type for the
logging operation specified by logname.

Verify the data type for the Group Delete Tag on the
Database Logging Control tableis digital, analog, long
analog, floating-point, or message. If incorrect, deletethe
tag, recreate it with avalid data type, and then restart the
application.

Bad group delete trigger in log name:
logname

Cause:

Action:

The Group Delete Trigger has aninvalid datatype for the
logging operation specified by logname.

Verify the data type for the Group Delete Trigger on the
Database Logging Control tableis digital, analog, long
anal og, floating-point, or message. If incorrect, deletethe
tag, recreate it with avalid data type, and then restart the
application.
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Error Message Cause and Action

Bad log records in log name: logname | Cause: A field name that requires an entry is blank for the
logging operation specified by logname.

Action: Verify al field entries in the Database Logging Control
and Database L ogging Information tables have valid
entries.

Cause: The Tag Name field has an invalid data type for the
logging operation specified by logname.

Action: Verify the datatype for the Tag Name field on the
Database Logging Control tableis digital, analog,
floating-point, or message. If incorrect, delete the tag,
recreate it with avalid data type, and then restart the
application.

Bad read tag in log name: logname, Cause: Thetag typeisinvalid for fieldname.

field name: fieldname Action: Verify the datatype isvalid for fieldname. If incorrect,

delete the tag, recreate it with avalid data type, and then
restart the application.

Bad sequence change tag in log name: | Cause: The Sequence Change Tag has an invalid data type for

logname the logging operation specified by logname.

Action: Verify the datatype for the Sequence Change Tag field
on the Database Logging Control tableis digital, analog,
long analog or floating-point. If incorrect, delete the tag,
recreate it with avalid data type, and then restart the
application.

Bad schema records in schema name: | Cause: Unableto read the .CT file for schemaname.

schemaname Action: Verify SchemaNameisvalid in the Schema Control

table and valid information is in the Schema Information
table. If it isvalid, shut down the Logger task and rebuild
the .CT filesby forcing actgen of dblogger (ctgen -v?2
dbTogger).

Bad send mailbox in log name: Cause: The mailbox tag typeisinvalid for logname.

logname Action: Verify the tag type for the Historian Mailbox field in the

Database Logging Control table is mailbox. If incorrect,
delete the tag, recreate it with avalid data type, and then
restart the application.
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Error Message

Cause and Action

Bad size for CT # recordnum

Cause:

Action:

A discrepancy exists between the indicated .CT file and
the Logger task.

Rebuild the .CT file by forcing a ctgen of dblogger
(ctgen -v2 dblogger).

logname

Bad subgroup change tag in log name:

Cause:

Action:

The Subgroup Change Tag isdefined with aninvalid data
type for logname.

Verify the data type for the Subgroup Change Tag field
on the Database Logging Control table is digital, analog,
long analog, or floating-point. If incorrect, delete the tag,
recreate it with avalid data type, and then restart the
application.

Can't close database

Cause:

Action:

The Logging task issued a close database command to
the historian task and the historian task could not close
the database. The historian may have lost the connection.

Verify the historian is connected to the database. Check
error messages within the historian. Perform
troubleshooting for the historian task. Also for applicable
databases, make certain the user is still logged into the
database server.

Can't create index: indexname for log
name: logname using schema name:
schemaname

Cause:

Action:

An SQL error occurred while creating an index for
logname.

Verify aschemawith Schema Name exists in the Schema
Control table with a proper index defined in the Index
Information table. Create oneif one does not exist. If this
does not correct the problem, generate alog file by
placinga -v4 -14 inthe System Configuration table
for Logging, restart FactoryLink, and reproduce the error
condition. Refer to thefile
FLAPP/FLNAME/FLDOMAIN/FLUSER/LOG/DLMMD
DYY.LOG to find all previous errorslogged for logname
and take corrective action as described for each error in
this chapter.
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Error Message Cause and Action

Can't create table: tablename for log Cause: An SQL error occurred while creating tablename.
name logname using schema name:

Action: Verify a schemawith schemaname exists in the Schema
schemaname

Control table with a proper index defined in the Index
Information table. Create oneif one does not exist. If this
does not correct the problem, generate alog file by
placinga-v4 -14 inthe System Configuration tablefor
Logging, restart FactoryLink, and reproduce the error
condition. Refer to thefile
FLAPP/FLNAME/FLDOMAIN/FLUSER/LOG/DLMMD
DYY.LOG to find al previous errorslogged for logname
and take corrective action as described for each error in
this chapter. Also ensure you are connected to avalid
database defined in the historian.

Can't log record for log name: logname | Cause: A table does not exist for logname and no schemais
defined.

Action: Create a schema using the schema name defined in the
Schema Name field of the Database L ogging Control
table or define a schema name in the existing Schema
Name field.

Cause: Logging could not prepare an SQL statement to send to
the historian.

Action: Review the prepared SQL statements in the historian
.LOG files. Take corrective action as described for each
error.

Can't open CT archive filename Cause: The .CT archive file does not exist or is corrupt.

Action: Rebuild the .CT files by forcing actgen of dblogger
(ctgen -v2 dblogger).
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Error Message

Cause and Action

Can't open database
database_aliasname

Cause:

Action:

Logger issued an open database command to the
historian and the historian could not open the database.
The historian may have lost the connection.

Verify the correct database alias name is defined in both
the Database L ogging Control and the Historian
Information tables. For applicable historian tasks verify
FactoryLink is connected to the database with avalid
logon ID and a password. Generate .LOG files for
Logging and the associated historian.

Can't open log file

Cause:

Action:

Cause:

Action:

Logger cannot open or write to the .LOG file used to
debug the task.

Verify the FLAPP/FLNAME/FLDOMAIN/FLUSER/LOG
directory exists. If not, createit. If the problem persists,
remove the -| argument from the Logging task in the
System Configuration table.

Logger may have run out of memory or disk space.

Verify free memory and sufficient disk space exist on the
system.

Can'tread CT # recordnum in CT
archive filename

Cause:

Action:

The archivefileis corrupt.

Rebuild the .CT files by forcing a ctgen of dblogger
(ctgen -v2 dblogger).

FactoryLink error filename

Cause:

Action:

An unknown PAK function error occurred within
historian.

Contact your technical support representative.

Failed to connect to historian

Cause:

Action:

An invalid mailbox tag is specified.

Verify the tag name in the Historian Mailbox field in the
Database Logging Control tableis avalid name and the
tag type is mailbox. If incorrect, delete the tag and
recreate it as defined in the Historian Mailbox
Information table. Generate .L OG files for the Logging
task and historian by placing a -v4 -14 inthe program
arguments in the System Configuration table.
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Error Message Cause and Action

Failed to prepare stmtid Cause: A nonexistent table name or field name is specified or a
syntax error is madein an SQL statement.

Action: Verify al entriesin the Database Logging configuration
table are correct. Rerun the application with a-v4 -14 as
program arguments for the Logging and historian tasksin
the System Configuration table.

Historian database error: filename Cause: Thismessage is accompanied by various other messages
that describe the cause of the error.

Action: Respond to the message displayed on the Run-Time
Manager screen or use the .LOG file by rerunning the
application with a -v4 -14 asprogram arguments for
the logging and historian tasks in the System
Configuration table. Refer to the appropriate error
message in this chapter for corrective action.

Invalid command line (usage) Cause: A program argument specified for the Logging task in
the System Configuration table is not valid.

Action: Verify the specified argument isvalid.

Invalid dimension specification in Cause: A sizeisdefined for a column that does not match the
schema name: schemaname size of the data being inserted into the column.

Action: Increase the value in the Length or Precision field on the
Schema Control table.

Invalid global mailbox: Cause: The global mailbox name may beinvalid or nonexistent.

DBLOGHISTMEX Action: Verify thetag in the Historian Mailbox field of the
Database Logging Control table isavalid mailbox tag. If
incorrect or nonexistent, create a new mailbox tag. Only
mailbox is an acceptabl e tag type. Restart the application.
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Error Message Cause and Action
Invalid group configuration. Group tag | Cause: One of the following tags is missing in the Database
and current subgroup tag does not Logging Information table for logname: Tag Name,
exist in log name logname Column Usage, or Current Subgroup Tag.

Action: Verify each field is defined in the Database L ogging
Information table.

Cause: A column isincorrectly defined with a data type of
GROUP.

Action: Delete GROUP from the Column Usage field in the
Database L ogging Information table.

Invalid group configuration. Maximum | Cause: A maximum number of subgroupsis defined, but a

subgroups defined and current Current Subgroup Tag does not exist in the Database

subgroup tag does not exist in log Logging Control table for logname.

name logname Action: Create a Current Subgroup Tag for logname or delete the
value in the Maximum Subgroups field.

Invalid group configuration. Subgroup | Cause: A Current Subgroup Tag is not defined in the Database

change tag exists and current Logging Control table, but a Subgroup Change Tag exists

subgroup tag does not exist in log for logname.

name logname Action: Create a Current Subgroup Tag for logname or delete the
Subgroup Change Tag.

Invalid schema name: schemaname in | Cause: An incorrect or nonexistent schemanameis entered in

log name: logname the Schema Namefield on the Database L ogging Control
table.

Action: Verify the spelling of the schema name in the Schema
Control table or create a schemawith the name specified.
Restart the application.

Invalid stmtid returned from historian | Cause: The historian shut down.

Action: Shut down the logger task and all other historian tasks
running. Restart the historian and logger. If this does not
resolve the problem, rerun the application with a - v4
- 14 as program arguments for the logging and historian
tasksin the System Configuration table.

Memory error malloc failed Cause: Insufficient memory is allocated for the Logging task.

Action: Check system for free memory.
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Error Message

Cause and Action

No activation trigger for log name:
logname

Cause:

Action:

A trigger to start the logging operation specified by
logname is not defined in the Database Logging Control
table.

Define atrigger in the Log Trigger field for logname.
Restart the application.

No CTs in CT archive dblog.ct

Cause:

Action:

Database L ogging configuration tables are not set up.

Define the Database L ogging Control and Database
Logging Information tables. Verify the entries are in the
correct domain.

No database name in log name:
logname

Cause:

Action:

A database alias name is not specified for logname.

Verify the existence and accuracy of the database alias
name in the Database L ogging Control table. Change or
add as necessary.

No domain name for application
directory directory

Cause:

Action:

The domain name ismissing or invalid in the application
directory.

Verify the existence and accuracy of the domain in the
operating system. Change or add as necessary.

No field name in log name: logname,
CT # recordnum

Cause:

Action:

The Column Name field in the Database L ogging
Information tableis blank or misspelled.

Open the Database L ogging Information table and verify
the existence and accuracy of the column name. Change
or add a column name as necessary.

No field name in schema name:
schemaname, CT # recordnum

Cause:

Action:

A column name is not specified in the Schema
Information table for schemaname.

Open the Schema Information table and verify the
existence and accuracy of the column name. Change or
add as necessary.

No jobs configured in CT archive
dblog.ct

Cause:

Action:

Database L ogging configuration tables are not set up.

Define the Database L ogging Control and Database
Logging Information tables. Verify the logging tables are
configured in the correct domain.
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Error Message

Cause and Action

No mailboxes in CT archive ctfile

Cause:

Action:

A mailbox tag does not exist in the specified archive.

Verify avalid mailbox tag is specified in the Logging
Control table and the historian tables.

No records in log name: logname

Cause:

Action:

Cause:

Action:

Datais not defined for logname in the Database L ogging
Information table.

Open the Database L ogging Control table and delete
logname, or configure a Database Logging Information
table for logname.

The Tag Namefield isleft blank in the Database L ogging
Information table.

Open the Database Logging Information table. If the
Column Usage field is data, add avalid tag namein the
Tag Name field.

No records in schema name:
schemaname

Cause:

Action:

Historian is attempting to create a new table and cannot
locate a schema. Data from the Schema Information table
is not configured or not entered.

Open the Schema Control table and configure a Schema
Information table for schemaname.

No schema defined in CT # recordnum

Cause:

Action:

Data from the Schema Information table is not
configured or not entered.

Define the Schema Control, Schema Information, and
Index Information tables.

No schema name defined in log name:
logname

Cause:

Action:

Action:

The SchemaNamefield in the Database L ogging Control
table is blank or incorrect.

Verify the existence of the schemain the Database
Schema Creation table. Create it if one does not exist.

Verify the accuracy of the schemaname. Change or add a
valid schema as necessary.

No table name in log name: logname

Cause:

Action:

The Table Name field in the Database L ogging Control
tableisblank or invalid.

Verify the existence and accuracy of the table name.
Change or add atable name in the Table Name field in
the Database L ogging Control table as necessary.
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Error Message

Cause and Action

Out of RAM

Cause:

Action:

Database L ogging can not acquire memory to run.
Restart the task. Install more RAM if the task fails again.

SQL: failed to historian_function: error
code SQL_errornum, SQL_errormsg

Cause:

Action:

An SQL error occurred during alogging operation.
Historian returned a database-dependent error code.

Refer to the user manual for the appropriate relational
database software. Consult the error code descriptions
and take appropriate action to correct the problem.

SQL.: failed to historian_function:
SQL_errormsg

Cause:

Action:

An SQL error occurred during alogging operation.
Historian returned a database-dependent error code.

Refer to the user manual for the appropriate relational
database software. Consult the error code descriptions
and take appropriate action to correct the problem.

SQL: Log name failed to
historian_function: SQL_errormsg

Cause:

Action:

An SQL error occurred during alogging operation.
Historian returned a database-dependent error code.

Refer to the user manual for the appropriate relational
database software. Consult the error code descriptions
and take appropriate action to correct the problem.

Task initialization failed

Cause:

Action:

The Logging task failed to register with the kernel.

Verify FactoryLink isup and running by running flshm
-lum. Also verify it is a purchased option.

Tried to access a nonexistent field

Cause:

Action:

Cause:

Action:

A field in the database table is missing.

Verify the existence of the field in the Database L ogging
Control table. If it does exist, verify the names match up
between the Schema Control and the Database L ogging
Control tables. Createit if it does not exist.

Permission to access the field is denied.

Log inthrough the appropriate user or have the user grant
permission to access the field.
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Error Message

Cause and Action

Tried to access a nonexistent table

Cause:

Action:

Cause:

Action:

The database table does not exist.

Verify the table name in the Database L ogging Control
table. If it does exist, verify the names match up between
the Schema Control and the Database Logging Control
tables. Createit if it does not exist.

Permission to open the table is denied.

Log inthrough the appropriate user or have the user grant
permission to access the table.

Tried to insert a duplicate row

Cause:

Action:

The user tried to add an existing key value to a unique
index. The row can not be inserted causing the data to be
lost.

Decrease the logging time interval or determine why the
associated tag with the index column is not changing.

Unknown function request sent to
historian

Cause:

Action:

An SQL error occurred during alogging operation.
Historian returned a database-dependent error code.

Refer to the user manual for the appropriate relational
database software. Consult the error code descriptions
and take appropriate action to correct the problem.

Unsolicited message received from
tagnum

Cause:

Action:

A task other than historian wrote to the Logging mailbox.

View the X-reference list to determine which task is
writing to the Logging mailbox. Change the mailbox tag
name of the task writing to the Logging mailbox.
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In FactoryLink, the relational databases are configured in atable format consisting of rowsand
columns. The schema of the table defines the number, size, and content of the rows and
columns.

Schema definitions are created in the Database Schema Creation folder for the Database
Logging tables. Thisfolder contains four tables:

 Schema Control table—Assigns unique names to table structures to log data.
« Schema Information table—Defines the columns and table structure attributes.

« Index Information table—Defines which columns the table structure uses as the index. Do
not use thistable if you are not indexing the table.

 Security Event Logging Schema table—Defines the table columns included in the Security
Event Logging table.

SCHEMA CONTROL TABLE

The Schema Control table sets up the names for each unique data table structure, or schema,
you create.

Accessing

In your server application, open Data Logging > Database Schema Creation > Schema Control.

Field Descriptions

Schema Name Name that references a unique table structure. Depending upon the
application, it might have three unique table structures, as shown in the
following examples:

nongrp_data For logging nongrouped, nonsequential data. Table
content is not grouped or ordered.

sequence_data For logging nongrouped, sequenced data. Table content
reflects event order or time of occurrence.
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group_data For logging grouped data. Table content is grouped or
sorted by a specified criterion.

Valid Entry: up to 19 alphanumeric characters
up to 10 characters for dBASE IV historian

Maximum Records Number that defines the maximum number of records allowed if you are
logging nongrouped datato a dBASE IV historian and want to control the
number of records in the tables using this schema. Other database client
products such as Oracle or SQL Server require that you perform your own
maintenance of the database tables according to your specific needs.

Record rollover occurs when the maximum is reached and starts updating at
the location of the first record. This processisrepeated in acircular fashion
from that point on. DB4_HIST keepstrack of only the records added to the
database table and not the records deleted from the table.

Leavethisfield blank to use as many records as your disk space allows or if
you are logging grouped data.

Valid Entry: 1 to 9999999999

When designing your application, note the following Maximum Records
feature restrictions:

1) Do not delete records from atable for which Maximum Records have
been specified.

2) Do not use DBBROWSE positional or logical delete, PowerSQL
positional or logical delete or array delete, or DBLOG group del ete feature,
or BH_SQL delete, or any other delete function. Doing so may result in
corrupted data when rollover occurs.

3) Do not browse ALL the records in the table where record rollover is
taking place. This can end in DBBROWSE fetching garbage data. This can
be avoided if the Maximum Records valueis set well in excess of what you
need to browse. For example, if you reguire that your browse operation
criteria select the latest 1,000 records |ogged, set the Maximum Records
value at 10,000. This way, the oldest record being overwritten is well
removed from the records being browsed.

4) To ensure integrity of the database table, DB4_HIST starts areindex of
the table upon insert of arecord with duplicate value in the unique index
column. Theinserted record is rejected with a“ unique key error”; however,
the CPU load for reindexing the table might be substantial for large tables.
Unfortunately, the unique key error generally occurs at times of heavy CPU
usage like application startup, heavy EDI read/write activity, heavy graph
swapping activity by operators along with other heavy usage, etc. At such
times, there might not be CPU cycles left to update the SECTIME tag for a
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few seconds, but DBLOG might go ahead and log this same value to a
unique index table column more than once. If you have a very large table
and cannot control frequent occurrence of “unique key” errors during your
application run, it is strongly recommended that you not use the Maximum
Records feature, asit will seriously degrade performance.

5) Dueto a problem in the routines used to build this functionality, the
integer value “0” for aunique index integer type column is not handled
correctly. If you use“0” inyour uniqueindex column, you should designate
this column of type “char” instead of “integer” or “smallint.” It is not
necessary to change the type of the tag that |ogs to this column or reads
from this column, as FactoryLink does data conversion automatically. You
should only use unique index column of typeinteger also if you can
guarantee that avalue of “0” will never belogged toit. If avalueof “0” is
logged, at record rollover time the index file will become corrupt and the
database useless.

Caution: Thisapplieseven if you do not use the Maximum Records
feature. Having a“0” in a unique index integer columnin
your table, your index filewill become uselessif you ever do
areindex using BH_SQL or DBCHK or any other meansin
the future.

6) If the records for your different groups are logged non sequentially over
time, and you want to del ete records based on the age of the groups, do not
use the Maximum Records feature. After record rollover, DB4 _HIST will

overwrite the records starting from the oldest without considering its group
ID. You should use the Group Delete feature provided for this purpose. The
Group Delete of records and Maximum Records features are incompatible.

SCHEMA INFORMATION TABLE
The schemafor each table structure you want to log data to is defined in the Schema

Information table. Whether or not the data is grouped or sequenced defines how this table
should be compl eted.

Accessing

In your server application, open Data Logging > Database Schema Creation > Schema Control >
“my schema” > Schema Information.
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Field Descriptions

Column Name

Column name. Each name must be unique within atable structure and must

conform to the standards for the relational database being used.
FactoryLink does not support column names that begin with a number. The
size of the column name for dBASE 1V islimited to 10 characters. For
specific naming conventions allowed, refer to the documentation for the
database you are using.

Valid Entry:

column name

In the following example for a gasoline station, there are three column

names:
group_ID
order_col

gals sold

Contains identification assigned to the row of data

Receives the sequence number indicating the order the
row of datawaslogged in.

Receives the number of gallons sold.

group_ID order_col gals_sold
r87 1 10.5
s93 1 12.2
r87 2 5

Column Usage How information in this column is used, which can be one of the following:

data (Default) Usefor columns not used for sequence, time,

sequence

time

group

or group. In this example, gals_sold column qualifies
for data usage.

Use for columns receiving a sequence humber in
integer form.

Use for columns receiving a number in time-stamp
form. The time-stamp used is the value from the global
tag SECTIME.

Use for columns receiving the group identification
assigned to the data row.

Column Type Keyword that represents the data type contained in the Column Usage field.
This must be a data type that the relational database receiving the data

supports.

Refer to the relational database user guide for the correct syntax.

140 / FactoryLink Task Configuration Reference Guide



Length or
Precision

DATABASE SCHEMAS | 7
Schema Information Table

The following table lists the dependencies.

Column Usage Column Type
data All supported types.
sequence Do not specify a column type.
time Do not specify a column type.
group All supported types.

If you do not know the data type when completing this table, specify
unknown as a placeholder and a reminder to define this data type before
completing the configuration. If you do not change unknown to a supported
type before starting the application, an error occurs.

Valid Entry: keyword name

Valid Data Type: small integer, integer, float, character, date, or number
(for the dBASE 1V historian)

Default: character

Maximum number of characters the column can storeif you defined a
character data type in the Column Type field.

If you defined a data type other than character or number, leave thisfield
blank to assume the default O.

If the Column Type field isanumber or contains a data type the relationa
database supports, specify a precision qualifier, such as xxx or Xxx,yyy,
where x and y can be any number. The precision qualifier definesthe
number of digits (including the decima) the column alows, and the
accuracy of the number before rounding.

Valid Entry: up to 80 alphanumeric characters (cannot exceed 64 if
the Column Usage field is group.)

With the dBASE historian, for afloat datatype, the maximum precision you
can saveisafive-digit integer with a precision of five (11,5). A float data
type with avalue greater than 99,999 is not logged correctly, and is
displayed as eleven asterisks. To circumvent this constraint, dBASE users
can specify number as the Column Type. This alows larger numbers; for
example, by using a precision of (13,3), you can log the number
123456789.123.
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If Column Typeiis. ..

integer
small integer
float

date
character (length)

number (precision)

INDEX INFORMATION TABLE

Length/Precision is. . .
0 (not applicable)
0 (not applicable)

0 (Maximum float precision in FactoryLink is (11,5),
which isthe default precision for datavaluesin a
float-type column.

dBASE |V users: To log values with precision greater
than (11,5), use the number data type.

0 (not applicable)

xxx where x can be any number. If Column Usage is
group, the maximum length is 64. Maximum length for
dBASE IV is 19 characters.

precision qualifier xxx,yyy

where x and y can be any number.

xxx = total characters, including decimal point, in the
value character string and

yyy = number of characters at the right of the decimal.

Tableindices are defined in the Index Information table. Only complete thistable if you are
indexing atable. You create an index by specifying the column name or names you want to use
astheindex in this table. The columns specified are called the index key. You can index on
more than one column. Records are retrieved from the database on the first column specified,

then the next column, and so on.

In the Schema Index Information table, specify the following information for each index key
you want associated with the table structure. You can specify up to 99 different index keys for
each schema, although a practical limit is between 6 and 9. Each index key is a separate line

item on this table.

Accessing

In your server application, open Data Logging > Database Schema Creation > Schema Control >

“my schema” > Index Information.
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Number to uniquely identify the schemaindex key you are defining. Start
with 1 and increment by one for each lineitem. The more indices, the more
disk usage and time it takes to log data.

Valid Entry: index key number between 1 and 99

Specify whether or not this index key represents a unique index. The value
you enter in this field must be uppercase. This can be one of the following:

YES Duplicaterecord values are not permitted in the column(s)
comprising thisindex key. If an attempt is made to log a
duplicate value, FactoryLink displays an error message
and the column of datais not logged.

NO Duplicate record values are permitted in the column(s)
comprising thisindex key.

Column name(s) in the table structure that comprises the index key. The
name must match the name in the Column Name field of the Schema
Information table.

Valid Entry: column name

If you are creating atable using the dBASE 1V historian, observe the
following constraints:

1. Thetotal number of characters keyed in should not exceed 254, as
characters over that limit will not be recognized as valid columns.

2. The width of the columnsin bytes (which depends on column type; for
example, a column of type char(4) has awidth of 4 bytes) should bea
number less than the maximum size (100 bytes).

If you are using more than one column as part of the index key, use aplus
sign(+) to separate each column name you specify. The multiple columns
specified are indexed in the column order they are displayed. For example,
given adatabase table of three columns: Employee Name, City, and
Employee Number, you can specify City+Employee Name. The datais
retrieved alphabetically by City first, and within each city, alphabetically by
Employee Name.
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OPERATOR EVENT LOG

The Operator Event Log is used to log al changes (events) made by an operator of a
FactoryLink application. Whenever the operator performs some action that changes atag's
value from the client project, the OPC Server creates and logs events. Client Builder events,
such as connections and disconnections, are also logged. If you are using a third-party OPC
client, the log may not reflect the node name of the remote system in the client node database
record.

If anew FactoryLink application is created using the Application Setup Wizard or the Create
New Application (FLNEW) utility, the client projects have examples for viewing the Operator
Event Log found on the RUNM GRS mimic. The simple browser control example shows the
database table OPERL OG displayed in reverse TMSTAMP order (latest first).

Configuring Operator Event Log Column Names

The Operator Event Log column names come predefined but can be changed by editing the
Security Event Logging Schematable.

Accessing

In your server application, open Data Logging > Database Schema Creation > Security Event
Logging.

Field Descriptions

Column Alias Interna “aias’ name for the type of datalogged.
Valid Entry: Seetable below

Entry Description

CLIENT For Client Builder, CLIENT isthe node name of the computer
where the client is running. For third-party clients, it isthe
name passed as the client’s name.

EVENTMSG | A message associated with the event which is built
automatically by the OPC Server. Contains messagesin the
following fixed formats:

+ Operator Name Logged In

» Operator Name Logged Out
 Tagname changed to newvalue
+ Client NodeName Connected

+ Client NodeName Disconnected
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Entry Description
EVENTYPE | Type of event, such login, logout, connect, disconnect, update
OLDVALUE |Tag'svaueimmediately before the change
OPERNAME | Name of the operator
OPER2NAME | Second authorization signature
REASON Operator selected/entered reason
TAGNAME | Name of the tag whose value changed
TMSTAMP Time that the event occurred
VALUE Tag's new value after the change

You can change the column names and length in the Security Event Logging Schematable, but
the column alias must remain the same. The column order can also be altered from the standard
found in the Examples Application and the FLNEW templates.

Configuring an Operator Event Log in an Existing Application

If you have an existing application that needs the Operator Event Log functionality, you need
to do the following stepsin Configuration Explorer:

1 Add the program arguments to the OPC Server task.

The configuration of the OPC Server task isfound in the System Configuration Information

table.

Argument Description
/0perkEvent=mailbox name, |Setsthe mailbox name, database alias name, and
database alias name, database table name for the Operator Event Log.
database table name
/OperEvent=0FF Turns the Operator Event Log off.

2 Add the mailbox for your historian of choice to the mailbox list. For more information, see the
“Historian Mailbox Information Table” on page 267.

3 Set up the database alias in the historian. For more information, see the “Historian Information
Table” on page 262. (You can use an alias for a database connection that you have already set

up.)

Note: Thisdatabase table will grow quickly if you have many clients attached
to the server. It isrecommended that you monitor the size of the table and then
archive and purge the table regularly.
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Viewing the Operator Event Log
After the Operator Event Log feature is configured in Configuration Explorer, you can view

the Operator Event Log using the Database Browser ActiveX control in Client Builder. For
more information, see the Client Builder Help.
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Data Point Logger

The Data Point Logger task logs one data point at atime to a historical database to preserve
datafor historical purposes through a historian. The historian used for this transfer depends on
the relational database receiving the data, such as SQL Server, Oracle, or Sybase.

The Data Point Logger simplifies the task of logging individual data points by providing
preconfigured tables. It also alowsyou to add or remove tags from the list of tags being logged
during run time. You can also define your own Data Point L ogging tablesif you need one other
than the pre-defined tables.

Data Point Logging is best for situations when you want to:

Log atag only when its value changes

Use preconfigured tables and eliminate the time spent setting up tables
Be able to index on log time or tag name or both

Sort al logs of atag in order of occurrence

Configure atag to be a dynamic pen on atrend chart

Dynamically change the list of tags being logged during run time

Data Point Logging uses four configuration tables:

Data Point Logger Control—Relates the Data Point Logging tables to a schema that
describes the table parameters.

Data Point Logging Information—Specifies which tagsto log, when to log the tags, and in

which table to log the information.

Data Point Schema Control—Controls the structure or schema of the Data Point Logging

tables.

Dynamic Logging Control—Changes the list of tags being logged during run time without
stopping system processing.
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DATA POINT LOGGING FUNCTION

Data Point L ogging reduces the task of configuring datato belogged. Data Point Logging uses
astructured database with the number of columns and the names of the columns predefined by
the Data Point Logging Schematable.

Because the table structures are preconfigured, the Data Point Logging task can only be used to

log shared, numeric value tags. The tags to be logged can be specified in the Configuration
Explorer by means of the Data Point Logging Information table or the Tag Editor.

Preconfigured Data Point Logging Tables
Data Point Logging provides five default Data Point Logging tables, each mapped to a specific
default schema name, to provide for efficient storage and retrieval of certain tag types. These
log tables are shown in the table below.

Table 8-1 Preconfigured Data Point Logging Tables

Table Used to Store
FLOATVAL floating value data
LONGANA long analog (large integer) data
ANALOG analog (small integer) data
LOGDATA genera log data
TRENDATA datathat will be used for trend analysis

Each preconfigured Data Point L ogging table usesthe Database AliasName MYDPLOG which
references the relational database where historian sends the data from Data Point Logging. In
addition, each default table refers to the Historian Mailbox mailbox tag entry.

Preconfigured Data Point Logging Table Schemas

Data Point Logging provides four default Data Point L ogging table schemas, each accepting a
different logged data type.

Table 8-2 Default Data Point Logging Table Schemas

Schema Name Data Type
TAGDATA float
SMALLINT smallint (analog, data)
LARGEINT integer (longana, analog, data)
FLOATVAL float (float, longana, analog, data)
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The maximum number of records allowed in a database table is governed by the relational
database being used. For example, the maximum number allowed in a dBASE IV database
table governed by any of the four default Data Point L ogging table schemasis 1,000,000. Each
default schema also specifies a maximum tagname column width of 48.

You must specify a schemafor the table in the Data Point Schema Control table if you define
your own Data Point Logging table.

Data Logged

Dataislogged to a predefined table structure. For each event logged, the database row reflects
the following entries.

LOGTIME TAGNAME TAGVALUE

LOGTIME Storesthe time the tag was logged
TAGNAME Tag that was logged at LOGTIME
TAGVALUE Vaue of thetag logged at LOGTIME

Only thelog time, tag name, and the tag value are recorded in each row. This meansless datais
stored and captured at each logging trigger, optimizing database storage space.

If atag islogged more than once during a given second, any values requested to be logged
after the first occurrence within that second are ignored.

LOGGING METHODS

With Data Point Logging, you can specify when atag (data point) is to be logged based on one
or more of the following:

A changein the tag (exception logging)

+ A fixed-timeinterva

« A changein atrigger tag

At task startup, all exception and fixed-time interval tags are logged to create a default

beginning reference point. Triggered logging tags are not logged at startup because the trigger
tagis not initiated yet.

FactoryLink Task Configuration Reference Guide / 149



8 | DATA POINT LOGGER
Logging Data

Logging Based on a Change in the Tag Value (Exception Logging)

You can configure Data Point Logging to log an event whenever the value of the selected tag
changes. FactoryLink pollsfor values of all tags specified for Data Point Logging. If the value
has changed from the previoustime it was logged, another event is recorded to the log.

If a given tag changes frequently but not all changes are significant, you can configure
deadbanding on the tag so only significant changes are logged. This reduces the amount of data
logged and decreases system processing time. Deadbanding allows you to specify a band
around atag to determine when the change is significant enough to record the changed value to
the system. This band can be an integer or a percentage of the value.

Logging Based on a Fixed-Time Interval

You can configure Data Point Logging to log an event at a specific time interval with the
minimum interval being one second. Fixed-time-interval logging rates are based on either
seconds, minutes, hours or days, as calculated from a starting point of midnight. It may be
appropriate to log atag value every hour or once a day, depending on the tag.

Fixed-time interval-based logging is tied to time maintained by an internal clock based on the
SECTIME global tag. Thistag trackstime from the starting point of midnight, January 1, 2004,
inintervals of one second.

Logging Based on a Change in a Trigger Tag

You can configure Data Point Logging to log the value of atag whenever a specified trigger
tag istriggered. Whenever the trigger tag is triggered, Data Point Logger logs the event.

LOGGING DATA

Data Point Logger allows you to specify tags to be logged when you are configuring the
system and dynamically during run time. When Data Point Logger starts, it looks at several
files to determine which one to use to build the log. Data Point Logger determines which of
these filesis newer:

e The Data Point Logger configuration table file, {FLAPP}shared\ct\dplogger.ct
» The DataPoint Savefile, {FLAPPRlog\dplogger.dyn

» The Data Point Save file specified in the Command File Tag field of the Dynamic Logging
Control table.

The newer file becomes the list of all tags considered to be configured for logging. If the

Command File Tag is not configured or if the tag contains an empty string, the default Data
Point Save fileis used.
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Defining Data to Be Logged During Configuration

When FactoryLink is being configured, the Data Point L ogging function can be configured for
aspecific tag in one of two methods:

 Through the Tag Editor when a new tag is defined
» Through the Data Point Logging Information table

Logging Data Dynamically

You can dynamically add tags to and remove tags from the list of tags to be logged during
run-time operation in one or both of the following ways:

» Generate and load a Data Point Save File that contains one or more logging requests
» Enter asingle logging request in atag

Data Point Save File

The Data Point Save File {FLAPPRlog\dplogger.dyn contains alist of all tags currently
configured for logging. You can create a Data Point Save File that is loaded whenever its
associated Read trigger is set. The load process causesthe list of tags currently being logged to
be overwritten by the list of tags specified in the designated Data Point Save File.

Single Logging Request

Data Point Logging allows you to enter a single logging request by means of the Command
Tag defined in the Dynamic Logging Control table. Thistype of dynamic logging request
either adds tags to or removes tags from the list of tags currently configured for logging.
Optionally, the logging request can have a tag associated with it that describes the logging
request status.

This type of dynamic addition and removal of tags is temporary so, every time Data Point

Logging is restarted, the new tag list generated from the Data Point Save File or the
Configuration Table file supersedes the existing list.

DATA POINT LOGGER CONTROL TABLE

The Data Point Logger Control table is preconfigured to contain the five default tables and
their associated schemas, database alias names, and historian mailboxes.

Accessing

In your server application, open Data Logging > Data Point Logging > Data Point Logger.
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Field Descriptions

Table Name

Schema Name

Database
Alias Name

Historian
Mailbox

Disable Tag

Unique name for the Data Point L ogger table that receives the data. Each
table name must be unique across all relational databases.

If this table does not exist in the relational database, the historian creates it
using the schema defined in the Schema Name field when you make a
corresponding entry on the Data Point Schema Control table.

Valid Entry: up to 16 alphanumeric characters

Unique name for the table schema that defines the structure of the relational
database tables receiving the data. This entry must correspond with an entry
in the Data Point Schema Control table.

To revise any Schema Name after you have already logged datato atable
using that schema, you must use SQL to drop the table from the list of
objects being logged, ater the associated schema, then restart FactoryLink.
This recreates the table using the new table structure.

If you are using a database server, such as Oracle or Sybase, alter the table
directly using the SQL command ALTER.TABLE. For moreinformation on
ALTER.TABLE, see“PowerSQL” on page 411.

Valid Entry: up to 19 alphanumeric characters

Name of therelational database where historian sends the data from Data
Point Logger. This entry must match a database alias name entry on a
database-specific historian table. See “Historians’ on page 253 for more
information.

Valid Entry: up to 31 characters

Name of the mailbox tag used to transfer datato the historian. Thistag must
match a mailbox tag entry on a database-specific historian table. See
“Historians” on page 253 for more information.
Valid Entry: tag name
Valid Data Type: mailbox

Tag that disables logging operations.

Valid Entry: tag name
Valid Data Type: digital, analog, float, or longana
Default Entry: digital
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DATA POINT LOGGER INFORMATION TABLE

Use the Data Point Logger Information table to relate the tags you are logging to a Data Point
Logger table and to configure one or more tags to be logged to a specific relational database
table configured in the Data Point Logger Control table. Specify one or more of the following
logging methods for each tag:

* On exception—using the Log On Change field.
» Fixed-time interva—using the Log Rate and Log Rate Based On fields.

» Upon an event trigger—using the Log Trigger field.

Ensure the name of the table you want to log datato is displayed in the Table Name field at the
bottom of thetable.

Accessing

In your server application, open Data Logging > Data Point Logging > Data Point Logger Control
> “your log tag name” > Data Point Logger Information.

Field Descriptions

Log Tag

Log On
Change

Log Rate

Log Rate
Based On

Name of the tag to be logged.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float
Default: digital

Whether Data Point Logger is triggered when the value of the tag specified
inthe Log Tag field changes.

Valid Entry: yes,y, no, n

Indicate the interval of time between logging occurrences of the tag being
logged. This entry works in conjunction with the time unit the entry in the
Log Rate Based On field defines.

Valid Entry: Integer from 1 to 86400
Unit of time the Log Rate field entry is based on.

Valid Entry: seconds, minutes, hours, days
Default: seconds
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Log Trigger Name of the tag that triggers the Log Tag to be logged.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
Default: digital

DATA POINT SCHEMA CONTROL TABLE

The Data Point Schema Control table is used to control the structure or schema of the Data
Point Logger tables. On the Data Point Schema Control table, you can either:

« Change the storage space occupied by the tag name and tag value fields for the
pre-configured Data Point Logger tables.

« Define additional Data Point Logger table schemas. Before using a new schema, however,
you must also add arecord (row) for it to the Data Point Logger Control table.

Data Point Logger provides four default Data Point logger table schemas, each accepting a
different logged data type.

Schema Name Data Type
TAGDATA Float
SMALLINT Smallint (analog, data)
LARGEINT Integer (longana, analog, data)
FLOATVAL Float (float, longana, analog, data)

Accessing

In your server application, open Data Logging > Data Point Logging > Data Point Schema
Control.

Field Descriptions

Schema Name Unique name for the schemathat defines a unique Data Point Logging table
structure. Thisschemaisalso referenced on the Data Point Logging Control
table.

Valid Entry: up to 19 alphanumeric characters
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Maximum number of records allowed in a Data Point Logging table
governed by this schemain the dBASE |V database. Only dBASE IV
databases use thisfield. You can use this parameter to automate table
maintenance. When the maximum is reached, the oldest record is deleted. If
you leave this field blank, as many records as disk space allows are logged.

Valid Entry: 1to 1,000,000

Maximum width of the Data Point Logging table column receiving the tag
name may occupy. If the tag name contains dimension specifications, you

must include them when cal culating the tag name width. You can use this

parameter for efficient data space utilization. If you expect the logged tag

name never to exceed 32 characters, then reduce the width to 32.

Valid Entry: 8to 48
Default: 48

Datatypes allowed for the tag being logged to the Data Point Logging table.

Valid Entry: float, integer, smallint or a user-specified,
database-dependent numeric data type, such as
NUMBER for Oracle

Specify aprecision qualifier, such as xxx or xxx,yyy, where x and y can be
any number if the Logged Value Data Type field contains a specific data
type supported by the relational database. The precision qualifier defines
the number of digits and identifies the number of digits allowed in the
column and the accuracy of the number before rounding occurs.
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PROGRAM ARGUMENTS

Argument Description

-1 Disable logging tag values at initialization.

-L Enable logging of SQL statementsto afile.

-R<P> Set maximum number of rows.

-S Generate Data Point save file after successful dynamic
log request.

-T Generate Data Point savefile at task termination.

-V Enable logging of SQL statements. Statements logged
(sent) to Run-Time Manager output window, but not
saved.

W< Set historian time-out parameter. (# = 5 to 30 seconds)

-1 Disable logging tag values at initialization.
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ERROR MESSAGES

This section references the directory as FL APP when discussing errors associated with filesin
your FactoryLink application directory.

Errors at Task Startup

The following messages report error conditions that occur at Data Point Logging task startup.

Error Message Cause and Action
Bad size for CT # record_number Cause: (Task terminated.) A discrepancy exists between the
indicated .CT file size and the file size specified in the
Data Point Logging task.

Action: Rebuild the .CT file by forcing a ctgen of the Data Point
Logging task using ctgen -v2 dplogger.

Can’t open CT archive file_name Cause: (Task terminated.) This.CT archivefileis missing.

Action: Rebuild the .CT file by forcing a ctgen of the Data Point
Logging task using ctgen -v2 dplogger. Call Customer
Support if Data Point Logging does not run.

Can’t read CT #record_number in CT | Cause: (Task terminated.) This.CT archivefileis corrupt.

archive file_name Action: Rebuild the .CT file by forcing a ctgen of the Data Point
Logging task using ctgen -v2 dplogger. Call Customer
Support if Data Point Logging does not run.

Database alias name not supplied for | Cause: This Data Point Logging table does not have a Database
table name: table_name Alias Name entry.

Action: Enter avalid Database Alias Name.

Historian mailbox not supplied for table | Cause: This DataPoint Logging table does not have an Historian
name table_name Mailbox entry.

Cause: Enter avalid Historian Mailbox name.

No CTs in CT archive file_name Cause: (Task terminated.) No configuration data existsin this
.CT archivefile.

Action: Rebuild the .CT file by forcing a ctgen of Data Point
Logging using ctgen -v2 dplogger. Call Customer
Support if the task does not run.
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Error Message

Cause and Action

No domain name for application
directory directory_name

Cause:

Action:

(Task terminated.) The domain is not defined.
Define the environment variable FLDOMAIN.

No jobs configured in CT archive
file_name

Cause:

Action:

(Task terminated.) The Data Point Logging Control table
must have at |east one row of data.

Add arow to the Data Point Logging Control table.

Out of RAM

Cause:

Action:

(Task terminated.) Not enough memory remainsto |oad
FactoryLink.

Either add more memory or reduce memory
consumption.

Task cannot run in domain USER

Cause:

Action:

(Task terminated.) The User domain is specified.
Start the task in the Shared domain.

Task initialization failed

Cause:

Action:

(Task terminated.) The Data Point Logging task failed to
register with the kernel.

Verify FactoryLink isup and running by using flshm
-lum. Also verify the task is a purchased option.

The table table_name is not valid

Cause:

Action:

A Table Name/Schema Name entry in the Data Point
Logging Control table does not have a corresponding
entry in the Data Point Schema Control table.

Enter the missing entry in the Data Point Schema Control
table.
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Errors at Run Time

Error Message Cause and Action

Can’t open log file Cause: Theerror log file could not be opened.

Action: Check to seeif thedisk isfull. If so, free up adequate
disk space.

Creation of save point file file_name Cause: The Data Point savefileis not created, possibly because
failed aninvalid path is specified in the Command File Tag.

Action: Check the syntax of the Command File Tag entry.

Error attaching to database Cause: Depends on content of <db_specific_error_message>.
database_name

- ion: < ifi >,
<db_specific_error_message> Action: Depends on content of <db_specific_error_message

Error creating table table_name Cause: Depends on content of <db_specific_error_message>.

<db_specific_error_message> Action: Depends on content of <db_specific_error_message>.

Error executing cursor for sql Cause: Depends on content of <db_specific_error_message>.
statement

- ion: < ifi >,
<db_specific_error_message> Action: Depends on content of <db_specific_error_message

Error initializing cursor for sql Cause: Dependson content of <db_specific_error_message>.
statement

i Action: Depends on content of <db_specific_error_message>.
<db_specific_error_message>

Error occurred during reloading of save | Cause: An error occurred while rel oading the Data Point save
point file. Please view log file file.

Action: Check the error log file.

Error preparing cursor for sql Cause: Depends on content of <db_specific_error_message>.
statement | Action: Depends on content of <db_specific_error_message>.
<db_specific_error_message>

Global tag tag_name not found Cause: (Task terminated.) Possibly the global tag SECTIME or
the global tag DPLOGHISTMBX ismissing.

Action: Run FLCONV.

Invalid configuration for tag tag_name |Cause: No logging method is specified for thistag.
in table table_name

Action: Specify one or more logging methods for the tag.
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Error Message Cause and Action
Invalid syntax in command Cause: Incorrect syntax isusedinaLOG or REMOVE
{LOG|REMOQVE} statement.

Action: Check the command syntax.

Multiple dynamic control records are | Cause: Data Point Logging only reads the first dynamic logging
not supported control record. All other rowsin thistable are ignored.

Action: Remove al dynamic logging control records except the
first.

Table table_name is defined more than | Cause: (Task terminated.) A table name can only be referenced
once once in the Data Point Logging Control table.

Action: Remove one of the references.

The table table_name is not valid Cause: The table specified in a dynamic logging command does
not exist in the Data Point Logging Control table.

Action: Enter the name of thistablein the Table Namefield in
the Data Point Logging Control table.

The tag tag_name is not valid. Error Cause: Aninvalid tag nameis specified.

<err_msg> Action: Specify avalid FactoryLink tag name. <err_msg>
further describes why the tag isinvalid.

Unable to remove tag tag_name Cause: Tag(s) specified inaREMOVE statement cannot be
removed.

Action: Check the tag name specified in the REMOVE

command.

Was not able to read save point file Cause: This Data Point save file was not read, possibly because

file_name it does not exist or it existsin adirectory other than the

default directory.

Action: Create oneif the Data Point save file does not exist.
Specify the full path in the Command File Tag entry if
thefile existsin adirectory other than the default
directory.
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Event and I nterval Timer

Event and Interval Timer allows you to define timed events and time intervals that initiate and
control any system function in run-time mode. Thistask links timed events and intervals to
tags used as triggers whenever the event or interval occurs. Timer tags can be referenced by
other FactoryLink tasks to trigger some action, such as:

» Read vauesfromaPLC

e Update areport

e Log datato arelational database
 Perform amathematical procedure

Use this task to signal the occurrence of specified events or intervals by writing to digital tags
in the FactoryLink real-time database.

» Timed events occur at a specific time not more than once every 24 hours (for example,
Monday at 8:00 A.M.). They are configured in the Event Timer Table.

e Timeintervalsoccur at least once every twenty-four hours at regular intervals of the system
clock (for example, every 60 seconds). They are configured in the Interval Timer Table.

OPERATING PRINCIPLES

The Event and Interval Timer task operatesin synchronization with the system clock. For each
defined interval or event, you must create a digital tag in the real-time database. When the
system clock matches the specified event or interval, the task forcesthe value of thisdigital tag
to 1 (ON).

Thereis no limit, except the amount of available memory, to the number of event and interval
timers that can be defined.

The Event and Interval Timer task also updates global information used by FactoryLink such
asthe current time, the day of the week, and the month. Such global information is stored in
predefined FactoryLink tags, known as reserved tags, each of which is one of the following
data types: analog, long analog, or message.

While the Timer task is running, these reserved tags are constantly updated. In order for the
Timer task to run, you must have entered an R flag for the Timer task in the System
Configuration Table.
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The following table lists reserved tags that are updated by the Event and Interval Timer task.

Reserved Tag Data Type

A_SEC Analog
A_MIN Analog
A_HOUR Analog
A_DAY (Day of month) Analog
A_MONTH Analog
A_YEAR Analog
A_DOW (Day of week) Analog
A_DOY (Day of year) Analog
DATE (DOW MM/DD/YYYY) Message
TIME (HH:MM:SS) Message
DATETIME (DOW MM/DD/YYYY HH:MM:SS) Message
YYMMDD (YY-MM-DD) Message
SECDAY (Seconds since start of current day) Long Analog
SECY EAR (Seconds since start of current year) Long Anaog
SECTIME (Seconds since January 1, 1980) Long Analog

CHANGING THE OPERATING SYSTEM DATE AND TIME
To change the operating system date and time while FactoryLink is running, shut down the

Timer task, change the date and time, and restart the task. Otherwise, the Timer task tries to
catch up by processing missed intervals.
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EVENT TIMER INFORMATION TABLE

Use Event Timer to define events that occur at least once every year. For example, use Event
Timersto start or stop reports and as triggers to read and write recipe files at a particular time

of day.

Accessing

In your server application, open Timers > Event Timer > Event Timer Information

Field Descriptions

Tag Name

Year

Month

Day

DOW

Hours
Mins.

Secs.

Tag name (example: time8am) to be assigned to the event. When the event
occurs, thetag isforced to 1 so its change-status bit is set to 1. The Timer
task resets all event timers back to zero at midnight. You can assign more
than one tag to the same event.

Valid Entry: tag name
Valid Data Type: digital

The 4-digit year the event isto occur (example: 2004). Leave thisfield
blank if the event occurs every year.

The month the event isto occur. Can be written numerically (1 to 12) or
abbreviated MMM (example: MAR for March). Leave thisfield blank if the
event occurs every month for the selected year.

The day the event isto occur. Written numerically (1to 31). Leavethisfield
blank if the event occurs on every day of the selected period.

Day of the week the event isto occur. Written asthefirst three letters of the
selected weekday (example: MON for Monday). Leave thisfield blank if
the event occurs on every day of the week or only on one specific day.

Hour the event is to occur (0 to 23, with 0 being midnight). The event timer
assumes a default value of O for blank fields.

Number of minutes (0 to 59) after the hour the event is to occur. The event
timer assumes a default value of O for blank fields.

Number of seconds (0 to 59) after the minute the event isto occur. The
event timer assumes a default value of O for blank fields.

Note: Between midnight (00:00:00) and thetimeindicated inthe Hours, Mins.,

and Secs. fields, the value of thetag an event islinked tois O (OFF). Thetag
value changesto 1 (ON) after the timed event occurs and stays this way until
midnight when it changes back to 0 (OFF). Because of this fact, always set a
time other than 00:00:00 to avoid the changing back to 0 (OFF) at midnight.
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First Vauethat determinesthe action taken upon system startup, if startup occurs
after atimed event. Because thisfield only affects events scheduled for the
current date, the system checks the date before changing any values.

YES Thetag'svalueisimmediately forced to 1 (ON).

NO Default—thetag'svaueisleft asisand does not change
to 1 (ON) until the next occurrence of the timed event.

The Event Timer Information table resembles this example when all information is specified.

Event Timer Information - SHARED { WUS-RI-wso0... - [OJE3
(= =24 BX B B O 5
Il | %
TagMame Wear ko, Day Do JHowrs [Mins
1 startday a ]
2 endday 17 ]
3 nEwEar JaM 1
4 lazhday 12 K1l
5 friGpm FRI 17 0
| 3

In this example, the startday tag has a value of 0 between midnight and 8:00 A.M. and 1
between 8:00 A.M. and 11:59 PM. and 59 seconds (23.59.59) each day of the year.

Similarly, the endday tag has a value of 0 between midnight and 5:00 PM and 1 between 5:00
PM. and 11:59 PM. and 59 seconds.

The newyear tag value has avalue of 1 on January 1 of each year and 0 on all other days.

Similarly, the lastday tag value has avalue of 1 on December 31 of each year and 0 on al other
days.

The fri5pm tag has a value of 1 each Friday between 5:00 PM. and 11:59:59 PM.
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INTERVAL TIMER INFORMATION TABLE

Use Interval Timer to trigger eventsthat occur at least once every 24 hours at regular intervals
of the system clock, such as every second or every two hours. For example, use interval timers
astriggersin Polled Read or Write PLC tables and in Send or Receive tables for FL/LAN
Network configurations.

Accessing

In your server application, open Timers > Interval Timer > Interval Timer Information.

Field Descriptions

Tag Name

Hours
Mins.
Secs.
10ths

Name of the tag (for example, sec5) to be assigned to the interval. You can
assign the same interval to more than one tag.

If the tag specified in thisfield is undefined, the Tag Editor appears when
you click Enter with atag type of digital in the Type field. Accept this
default.

Valid Entry: tag name
Valid Data Type: digital

Indicates the length, in hours, of the interval (0 to 23)

Indicates the length, in minutes, of theinterval (0 to 59)
Indicates the length, in seconds, of the interval (0 to 59)
Indicates the length, in tenths of a second, of the interval (0to 9)

Note: Theinterval timer assumes a default value of O if these fields are | ft
blank. At least one of these fields must befilled in with avalid entry. (Not zero,
asit isnot considered avalid entry.) If theinterval can be divided evenly into
24 hours (86400 seconds or 1440 minutes), the timer runs asif it started at
midnight. If theinterval cannot be evenly divided into 24 hours, thetimer starts
at system startup.
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The Interval Timer Information table resembles the following sample when al information has
been specified.

Interval Timer Information - SHARED ... E]@
HES tBB X R
» 0P ol @

Tag Hame Hourz | Mins. Secy.  |10ths

zech ]
zec3l an
min ¥ 7

minZ20 20

report] 1 17

hourd a

[ap] [y} oy PR o) By
=

In this example, the sec5 tag's change-status flags are set to 1 every 5 seconds; that is, when
thereserved analogtag A_SEC =0, 5, 10, 15, ... 55. Thistimer runs asif it started at midnight;
therefore, if system startup timeis 9:39:18, the sec5 tag's change-status flags are first set 2
seconds later, at 9:39:20, and every 5 seconds thereafter.

The sec30 tag's change-status flags are set to 1 every 30 seconds, when A_SEC = 0 and 30.
Thistimer runs asif it started at midnight.

The min7 tag's change-status flags are set to 1 every 7 minutes after system startup, because
1440 is not evenly divisible by 7.

The min20 tag's change-status flags are set to 1 every hour, again at 20 minutes after the hour,
and again at 40 minutes after the hour.

The reportl tag's change-status flags are set to 1 every hour and 17 minutes, after system
startup.

The hour8 tag's change-status flags are set to 1 three timesaday: at 8:00 A.M., 4:00 PM., and
midnight, regardless of system startup time.

When interval timers are used as triggers for other tasks, such as PLC read triggers or Report

Generator triggers, these tasks automatically use the change-status flags associated with these
timers.
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ERROR MESSAGES

Error Message Cause and Action
Bad data in ETIMER record Cause: The Event Timer Table contains one or more invalid
record_number, file filename values.
or Action: Open the Event Timer Information table. Ensure the
Bad data in ITIMER record correct tag name is entered.

record_number, file filename
Check the datatype. Only digital datatypesarevalid on
the Event Timer Information table. Choose View > Object
List to check the data type specified for atag. Then, use

the Search function from the View menu.

Choose View > X-ref List to display the Cross Reference
List to locate al tables that reference a particular tag
name. Choose View > Search, enter the desired tag name,
and click Enter.

Bad filename index record in file Cause: The TIMER.CT file may not have the correct number of
filename configuration tables archived in it. One or more files may
be damaged or missing.

Action: Ensure the following files exist:
FLAPP/ETIMER.MDX
FLAPP/ETIMER.CDB
FLAPP/ITIMER.MDX
FLAPP/ITIMER.CDB

If the files are present and the problem till exists, delete
FLAPP/TIMER.CT and restart the application to rebuild
the TIMER.CT file.

FactoryLink Task Configuration Reference Guide / 167



9 | EVENT AND INTERVAL TIMER
Error Messages

Error Message

Cause and Action

Can't close file filename Cause:

Action:

Either the operating system, third-party software, or
hardware setup on your system isincorrect or
incompatible or aninternal error occurred. The
FactoryLink real-time database may have been
corrupted.

Verify the following:
The operating system is set up to run FactoryLink (tuning
parameters, resources).

All third-party software needed by FactoryLink is
installed and set up correctly and you have the correct
version of FactoryLink.

All hardwareis correctly set up and al of the hardwareis
compatible.

Can't find filename in file filename Cause:

Action:

The TIMER.CT file may not contain the correct number
of configuration tables. One of the following files maybe
damaged or missing:

FLAPP/ETIMER.MDX

FLAPP/ETIMER.CDB

FLAPP/ITIMER.MDX

FLAPP/ITIMER.CDB

Ensure the following files exist:
FLAPP/ETIMER.MDX
FLAPP/ETIMER.CDB
FLAPP/ITIMER.MDX
FLAPP/IITIMER.CDB

If the files are present and the problem still exists, delete
FLAPP/TIMER.CT and restart the application to rebuild
the TIMER.CT file.
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Error Message Cause and Action
Can't get FactoryLink ID errno Cause: The Timer task is unable to register with the FactoryLink
error_number kernel; the Timer task may already be running or more

than 31 FactoryLink tasks not including Run-Time
Manager may have been started.

Action: Check the Run-Time Manager screen to seeif the Timer
task isrunning. Also, check the number of tasksthat have
been started. The maximum number of tasks including
Run-Time Manager is 32.

Can’t open file filename Cause: The specified fileis either nonexistent or opened by
another task. Incorrect editing may have caused the
problem if thefile is exported, edited with atext editor,
and then imported.

Action: Ensurethe specified file name exists. If it exists, check to
seewhether it was exported, edited with atext editor, and
then imported. The file should be unformatted ASCI|

text.
Invalid tag type for Reserved Timer tag | Cause: The specified reserved Timer tag is the wrong data type.
tag_name The RTDB may be damaged.
Action: Use the Configuration Explorer to correct the reserved
timer tag(s).
Read failed for ETIMER record Cause: An1/O error occurred during the reading of an Event
record_number in file filename Timer.CT record. The TIMER.CT file may not contain

the correct number of configuration tables. A file may be
damaged or missing.
Action: Ensurethefollowing files exist:
FLAPP/ETIMER.MDX
FLAPP/ETIMER.CDB

If the files are present and the problem still exists, delete
FLAPP/TIMER.CT and restart the application to rebuild
the TIMER.CT file.
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Error Message

Cause and Action

Read failed for ITIMER record Cause: An /O error occurred during the reading of an Interval
record_number in file filename Timer.CT record. The TIMER.CT file may not have the
correct number of configuration tables archived init. A
file may be damaged or missing.
Action: Ensurethe following files exist:
FLAPP/ITIMER.MDX
FLAPP/ITIMER.CDB
If the files are present and the problem still exists, delete
FLAPP/TIMER.CT and restart the application to rebuild
the TIMER.CT file.
Reserved Timer tags not defined Cause: Some or al of the reserved timer tags are not defined.
Action: The GLOBAL.CDB and/or GLOBAL.MDX filesare
damaged.
FLNEW did not run. FLNEW creates ablank application
structure, including these two files.
Part of FLINK/BLANK may be missing.
Wrong Kernel version Cause: Incompatible versions of FactoryLink software exist on
the system.
Action: Reinstall the system.
Wrong number of CTs archived in file | Cause: The TIMER.CT file may not contain the correct number
filename of configuration tables. A may be damaged or missing.
Action: Ensure the following files exist:

FLAPP/ETIMER.MDX
FLAPP/ETIMER.CDB
FLAPP/ITIMER.MDX
FLAPP/ITIMER.CDB

If the files are present and the problem still exists, delete
FLAPP/TIMER.CT and restart the application to rebuild
the TIMER.CT file.
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Event Time Manager

The Event Time Manager (ETM) task allows a user to configure objects, functions, and
parameters, and to control them based on an Event List that is related to the configuration. An
optional user interface can be used to build the Event List independent of the FactoryLink
system.

The Event Time Manager was originally available as athird-party option. It ismainly provided
now to allow customers who used it in the past to upgrade their systemsto the latest version of
FactoryLink.

ETM contains the following features:

 Virtually unlimited number of tagsin list of time-controlled objects, functions, and events.
 Enabling/disabling control per object, Min/Max control, and standard value.
 Configurable functions with actions SET, TGL, ON, OFF, ADD, SUB.

 Automatic adjustment of time including daylight savings.

 Configurable special events or periods for Easter, Christmas, and so on.

 Events configurable as repetitive and with period limitation, such as aways on Monday
12:00 from May to September.

 Configuration check by running in test mode.

 Support of severa file formats for the Event List several file formats. The ASCII file
formats (Csv, Cat, Txt, WoA) are read directly from the file system and the database format
(dBasel V) isread using the FactoryLink Browser.

» Anoptional ETM Input Mask program allows for on-line configuration of events by using
predefined tables (input masks).
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OPERATING PRINCIPLES

This section describes various operating principles and concepts associated with the ETM task
and the ETM Input Mask program.

Event Definition/Special Events

Every event object is associated with afunction (representing a class) and its commands.
When defining objects you tell ETM which tags it must control and the associated function
defines how ETM can control those object. By defining events, you tell ETM when it has to
process an action.

The location for ASCII Event Listsis %flapp%\ETM; for historian filesit is freely selectable.

An event is defined by fields Fix Date, Event Time, Weekday, Special Event, Valid
from..through.

e The date/time format is 1SO 8601 and starts with the FactoryLink time calculation
(1980-01-01 00:00:00).

e Thedate (YYYY-MM-DD) is defined by year (4 digits), month (2 digits) and day (2 digits)
separated by a hyphen or minussign {-}.

e Thetime (hh:mm:ss) is defined by hours, minutes and seconds (each of 2 digits) separated
by acolon {:}; the time resolution is one second.

e The day begins at 00:00:00 and ends at 23:59:59.

» Thefields Valid from...through require the date format and are used to limit the span of a
repetition.

Weekday and Special Event are further possibilities to describe an event. You can specify the
available entries in the ETM Runtime Parameter table. Every entry can be negated by a
preceding hyphen {-}.

Anevent isdefined exactly for one time (explicit) or asarepetition, being processed more than
once. On arepeated event at |east one field in the date and time string is empty. Preceding
delimiters must be declared. An empty field generally means always whereas Weekday and
Special Event are considered one field. An empty time field means at 00:00:00. As alogical
rule consider an event to occur at the time: [Weekday OR Special Event] AND [Fix Date]
AND [Valid from..through] AND [Event Time].

The examplesin the following tables illustrate explicit events and repetitions.
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Table 10-1 Explicit Events

Week | Specid Fix Valid | Vvalid Event Remark
Day(s) | Event(s) | Date from | through | Time (Date/Time format is1SO
8601)
2000-03-23 14:05:00
2004-01-01 00:00:00
2004-01-01 Same as line above, since an
empty Event Time means
00:00:00
2005-01-01 Sameasline above, but 1 year
later

Table 10-2 Repetitions

Week | Speciad Fix valid | valid Event Remark
Day(s) | Event(s) | Date from | through | Time (Date/Time format is 1ISO
8601)

Mon -03 -10 08 Always every Monday at 8
o'clock from March through
October

Mon -Easter 8 Every Monday at 8 o'clock but
-Xmas not at Easter and Christmas

Sun Easter 8 Every Sunday or every day at
Xmas Easter or Christmas at 8
o'clock

-01-01 2003 | 2007 From 2003 through 2007 on
every January 1% at midnight
(00:00:00)

2001- -01 :30 On thefirst of every monthin
2001 always at half past

Every day at midnight

-- Every day at midnight

Mon 12 Alwaysat 12 o'clock on
Wed M onday, Wednesday and
Fri Friday

-Sat 20:00:00 | Every day at 20 o'clock but
-Sun not on Saturday and Sunday
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Time Mechanism

The internal clock (ETMClock) follows the system clock in one second intervals. The
ETMClock isonly incremented if the system clock precedesit. If the ETMClock is more than
one second behind, ETM runswith a shorter interval to make up leeway. The short interval can
be adjusted by a program argument. In this way events will always be processed even if the
system clock is changed (daylight saving) or the CPU isblocked by other tasks. Furthermore a
burst of events may be processed in batches without overloading the system.

Actual adjustment
Time example: Daylight Savings Time

On Off
| stop ETM clock

— System clock with adjustments

N

max processing speed —3» ETM clock following system clock

P Real-Time

Event List and Buffer Handling

The Event List isread periodically (asynchronously) by an adjustableinterval. Every repetition
and every explicit event from the actual time until the end of the day is read from the Event
List. A buffer time can be specified to increase the span of explicit events read. Reading the
file and preparing the data for processing can consume time depending on the file size. But
until datais completely prepared, ETM still runs with the list read one cycle before. In case of
unsuccessful Event List, reading or preparing the buffer read one cycle before guarantees that
no event islost. Modifications on the Event List only take effect on successful reading. If your
modifications will be available immediately, you can force reading the event list database by
triggering atag configured in the ETM Runtime Parameter table.

Run-time and Test Operation Mechanism

When the ETM run-time task is starting, it runs automatically in the normal run-time mode. It
can also run in atest mode to check the commands and the event list. In thistest mode, ETM
can beinitialized on a certain date and time and process the event list speeded up for that day,
such asto test the events released later at Christmas.

Caution: Thismay cause unpredictable reactions. For example, telling ETM to stop
the heating system, it is best to cut off the communication to the PLC first.
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Mode Description

The operation mode is available as an input/output tag configured by Parameter tag OpMode
in the ETM Runtime Parameter table. Thetag is subdivided like a bit field in command and
information modes. The user can set ETM to a certain mode by forcing the tag with a
command mode. ETM always shows its actual state with information modes. The following
modes are available:

Mode Dec Hex Value Description
Auto 00x0000 Command and information mode, theinternal clock follows
the system clock
Test 10x0001 Command and information mode, theinternal clock follows

the value of the Parameter tag External Time configured in
the ETM Runtime Parameter table

Off 20x0002 Command and information mode stop the internal clock

Init 256 0x0100 Information mode, ETM is processing an initialization
routineasat ETM startup

ReadDB 512 0x0200 Information mode, ETM isreading the Event List database

Mode Transition Description
Auto

After each SleepTime (Program Argument), ETM checksiif the system clock has changed and
if theinternal clock islate. If so, ETM processes the events according to the faster internal
clock. Then ETM suspends again for the duration of SleepTime.

If the ReadPeriod (Program Argument) has expired, ETM goes to ReadDB to update the Event
List and returnsto its previous state.

If Parameter <OpMode> is set to 2, ETM goes to Off and stops processing. The
Parameter <External Time> isinitialized with the actual value of the system clock.

If the <OpMode> isset to 1, ETM goes Test/Init. The <Externa Time> isinitialized with the

actual value of the system clock; the Event List is read and an initialization on that
<Externa Time> is started.
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Auto/Init

ETM readsthe Event List database. If theinitialization is completely processed, ETM goes to
Auto.

If the <OpMode> is set to 2, ETM goes to Off mode and stops processing. The
<External Time> isinitialized with the actual value of the system clock.

Test/Init

ETM reads the Event List database. If theinitiaization is completely processed, ETM goes to
Test mode.

If the <OpMode> is set to 2, ETM goes to Off mode and stops processing.
Off

If the <OpMode> is set to 0, ETM goesto Auto/Init mode. The Event List isread and an
initialization on the system clock is started.

If the <OpMode> is set to 1, ETM goesto Test/Init mode. The Event List isread and an
initialization on the actual value of <External Time> is started.

Test

After each SleepTime, ETM checks if the Parameter <External Time> tags value has changed
and theinternal clock islate. If so, ETM processes the events for the increased internal clock.
Then ETM suspends again for the duration of SleepTime.

If the ReadPeriod has expired, ETM reads the Event List database again.
If the <OpMode> is set to 2, ETM goes to Off and stops processing.

If the <OpMode> is set to 0, ETM goes to Auto/Init. The Event List isread and an
initialization on the system clock is started.
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ETM Input Mask Program

ETM supports an optional ETM Input Mask program that allows on-line configuration of
events using predefined tables (input masks). The ETM Input Masks are automatically linked
to the Objects, Functions, Weekdays, and Specia Events previously configured in the
FactoryLink application. When the ETM Input Mask program is closed, a modified Event List
isstored in the FactoryLink application so the ETM Task can read the list for online processing
of the new events. For valid Event List Formats, seethe ETM Parameter table.

ETM OBJECT INFORMATION TABLE

The ETM Object Information Table identifies objects that ETM controls. Every object can be
disabled at run time and can have its own value range, default value, unit, and description.

Accessing

In your server application, open Other Tasks > ETM Event Timer Manager > ETM Object
Information.

Field Descriptions

Field Name Description Valid Entries VaI|dT532aSbase
Object Tag representing the object to be controlled. A (optional, case DIGITAL,
Control Tag | function having one or several commands must | sensitive, 48 ANALOG
be associated with the object. Depending on the | characters): any LONGANA,
command and the specified event, ETM will valid tag name FLOAT or
writeto thistag. MESSAGE

Enable Tag | Tag in combination with the contents of the (optional, case DIGITAL,
*Enable Vaue Tag to interlock events on this sensitive, 48 ANALOG,
object. If the condition given by thesetwo fields | characters): any LONGANA,
is false the events are ignored, otherwise they are | valid tag name FLOAT or
enabled. If either field is empty no event will be MESSAGE
ignored.
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Valid Database

Field Name Description Valid Entries Types
*Enable Tag or character constant in combination with the | (optional, case DIGITAL,
Value Tag contents of the Enable Tag to interlock eventson | sensitive, 48 ANALOG,

this object. If the condition given by these two characters): any LONGANA,
they erc cnabiel I Gther il 1o ampty no vent |l g nameor | FLOAT or
will be ignored. I the two fields have different | 2 acter constant | MESSAGE
tag typesthe * Enable Value Tag is transformed to
the type of the Enable Tag before the test will be
made. At the beginning of the contents, alogical
operator can be assigned to determine the
condition. The following operators are alowed:
= Equal (default if no operator given)
1= NOT equal
< Lessthan
<=Lessor equa
> Greater than
>= Greater or equal
The following two examples of character
constants represent the same condition and will
disable every event on an object if the contents of
the enabletag is not 3:
‘3
=3
Function A function must be associated with every object. | Valid entries
It describes the class or type of the object. (required, case
Functions can have a number of commands as sensitive, 23
described for the ETM Function Information characters): any
Table. function name
referencing
commandsin the
appropriate Function
Information table.
*Min Value | Tag or number constant representing the lower | (optional, case ANALOG,
limit of the object value. If acommand of an sensitive, 48 LONGANA or
event forces the objects value below this limit, characters): any FLOAT

the value will be corrected to the contents of this
field.

valid tag name or
number constant
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Field Name Description Valid Entries VaI|dT53t6aSbase
*Max Vaue | Tag or number constant representing the upper | (optional, case ANALOG,
limit of the object value. If acommand of an sensitive, 48 LONGANA or
event forcesthe objects value above thislimit, the | characters): any FLOAT
value will be corrected to the contents of this valid tag name or
field. number constant
*Standard Tag or character constant representing the default | (optional, case DIGITAL,
Value value of the object if no other valueis specified | sensitive, 48 ANALOG,
for an event. characters): any LONGANA,
valid tag name or FLOAT or
character constant. | MESSAGE
Unit Individual description of the unit of the objects | (optional, case
value displayed in the ETM Input Masks sensitive, 23
characters): any
Object FactoryLink Tag Description of the Object (optional, case
Control Tag | Control Tag displayed in the ETM Input Masks. | sensitive, 80
Description characters): the
descriptionisentered
at Tag specification
and cannot be
modified in this
column
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ETM FUNCTION INFORMATION TABLE

The ETM Function Information Table identifies the commands for a particular class of objects
(typical object). Every object is derived from a class and the commands describe what you can
do with an object of thisclass.

Note: The Function name (Class) is defined in the ETM Object Information
table and displayed in the Input Masks and Select List of the ETM Input Mask
add-on program.

Accessing

In your server application, open Other Tasks > ETM Event Timer Manager > ETM Object
Information > “my ETM” > ETM Function Information.

Field Descriptions

Valid
Field Name Description Valid Entries Database
Types
Command Individual description of the command. The | (required, case sensitive,
descriptions are used in the Event List and | 23 characters): any name
displayed in the ETM Input Masks. By or, 7 for user specified

entering acommand in the Event List or in | input value
the ETM Input Masks, ETM executes the
appropriate action and processes the event
with the *Standard Value or with the higher
ranking *Preset Value. Or, on the special
command "?" the user can enter avalue that
even supersedes the *Preset Value.

*Preset Value | Tag or character constant representing the | (optional, case sensitive, | DIGITAL,

value of the command if no other value 48 characters): any valid | ANALOG,

supersedesiit. If specified, thisfield tag name or character LONGANA,

supersedes the * Standard Value. constant FLOAT or
MESSAGE
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Field Name

Description

Valid Entries

Valid
Database
Types

Action

Standard action applied on the value for this
command.

The following actions are available, enter a
name or select one from the list:

ON - The object control tag will be set to ON
(vauel).

OFF - The object control tag will be set to
OFF (value 0).

SET - The object control tag will be set to
the value valid for this command.

ADD - The vaue valid for this command
will be added to the current control tags
value.

SUB - The value valid for this command
will be subtracted to the current control tags
value.

TGL - The object control tag will be set
depending on the actua value

(if thevalueisO setto 1, if value differsfrom
Osetto Q)

(required, case
insensitive, 7 characters):
any valid action, default
is SET.

Mode

Flags to modify a command with regard to
Enable, I nterlock and Startup behavior. See
the table below for valid modes.

(optional, case
insensitive, 7 characters):
any valid mode or none
(default)
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The following table provides the valid Mode entries.

Mode Description

E Store and forward this command until the control tag is enabled. Processing of this
command can be delayed if it was disabled at the last proposed event time. However, it will
be abandoned if superseded by any other command appearing as a possible event prior to
enabling. This mode is used to shift a command using the enable tag; for example, the
command to turn off the lights at 7:15 pm can be disabled only after enabling at 10:20 pm.

I Thiscommand is processed at the proposed event time regardless of its actual interlock. This
mode is used to unconditionally force the control tags value, such as to aways turn off the
lights at 2:30 am.

S This command is processed at ETM start-up to initialize the Control Tags value. The last
command prior to start-up (first one found backwards in the Event List) with this mode is
applied. You can set the span (event history time) to scan backwards from start-up for
finding commands with this mode (Program Argument — StartupTime#). For example, mode
S can be used to turn on the lights | ater, if the system was down at the actual event time.

SE This command combines mode Sand E. It is processed when ETM is started to initialize the
control tags value, and a possible disabled command is stored and forwarded until the
control tag is enabled.

Sl This command combines mode Sand I. It is processed when ETM is started to initialize the
control tags value, and it is processed at the proposed event time regardless of its actual
interlock.

The following graphic illustrates the behavior of Startup and Enable mode.

Mode S [Start) Mode E (Enable)
EThi @ sk stopped | ETM task running | EThd Control disable d Cortral erabled | ETHhd
1
| 0N | aFF ON OFF OH Scheduled Output | 0N | aFF | ON OFF OH Scheduled Output
Start-up walue fom “ale at enable L
last scheduled Buvent Cortrolled Output as scheduled Controlled Ouput
Mode = & Mode= E
i i i i i i
| | | |
Start-up walue from E ke 3t enable E L
most current Evert 1 Cortrolled Cutput unchanged 1 Controlled Cutput
¥ Mode = none ¥ Mode = none
Value at start-up of ETM = Value according Event List Value at enabling Object = Value according Event List
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ETM RUNTIME PARAMETER TABLE

The ETM Runtime Parameter table allows to determine the Weekday names in a useful

manner, to specify objects with a special meaning (priority processed) or to set theinformation
about the Event List Format.

Accessing

Note: Parametersfor week daysand for the special event can be listed several
timesin order to suit for multiple abbreviations and events, respectively.

In your server application, open Other Tasks > ETM Event Time Manager > ETM Runtime
Parameter.

Field Descriptions

Field Name Description Valid Entries Valid Database Types
Parameter This column is used to select any (optional, case sensitive,
Name desired <Parameter> as described 15 characters): any valid
below. Enter a <Parameter> or select | Parameter name
one from the list.
Parameter Tag | For some parametersatagis Depending on Parameter, | Depends on the
applicable to fulfill the functionality. |any valid tag name Parameter
Parameter For some parameters an argument is | Depending on the
Argument applicable to fulfill the functionality. | Parameter up to 79 char.
See the table below for valid
parameters.
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Table 10-3 lists valid parameters for the Parameter Argument field.

Table 10-3 Valid Parameters for ETM Runtime Parameters Screen

Parameter Description Valid Entries

List Format (required, case insensitive, 23 characters):
any nameor ,?* for user specified input
value. Valid entries are listed below:

db4 dBaselV (CodeBase 4.5);
read Event List through
Database historian and
Database Browser; Event
List location and file name
are freely configurablein
historian.

Cat Default Format. Read
Event List directly; field
size fixed, field separator
{~}, no string indicator;
Event List location and file
name must be
{flapp}/etm/etm_list.dat.

Csv Read Event List directly;
field sizefloating, field
separator {;}, string
indicator {"} (optional);
Event List location and file

name must be
{flapp}/etm/etm_list.csv.
Txt Read Event List directly;

field sizefloating, field
separator TAB, no string
indicator; Event List
location and file name must
be {flapp}/etm/etm_list.txt.

WOoA Read Event List directly;
field sizefloating, field
separator {,}, string
indicator {"}; Event List
location and file name must
be {flapp}/etm/etm_list
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Table 10-3 Valid Parameters for ETM Runtime Parameters Screen (continued)

Parameter

Description

Valid Entries

List
DBBCtName

The argument column (case insensitive)
specifies the corresponding ct name if the
Event List isread by the Database Browser.

Default argument iISETM_EVENTLIST.

Special Event

Specia Events are identified by controlling
the appropriate tags of type DIGITAL,
ANALOG, LONGANA, FLOAT or
MESSAGE in the Parameter tag column. This
can be done by ETM or any other task. A
Special Event is active aslong as the tags
value differsfrom 0. It is handled with higher
priority if two events occur at the same time.
A unique entry in the argument column (case
sensitive) identifies its reference namein the
Event List or in the Input Masks. A Specia
Event can be used as a condition for other
eventsin the Event List.

ReadDB

The Event List is parsed periodically. To
forcereading, thistrigger can be set. Itis
specified by an entry in the Parameter tag
column (type DIGITAL, ANALOG,
LONGANA or FLOAT).

Internal Time

Information on the actual internal time of
ETM. Thetag in the Parameter tag columnis
updated periodically (normally 10 s, while
testing 1 s). The displayed format is
FactoryLink SECTIME for type LONGANA
or ISO 8601 YYYY-MM-DD hh:mm:ssfor
type MESSAGE.

External Time

Thisisthetimer that ETM will follow in the
test mode instead of the system clock. Thetag
in the Parameter tag column must be set in the
format of FactoryLink SECTIME for type
LONGANA or ISO 8601 YYYY-MM-DD
hh:mm:ss for type MESSAGE.
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Table 10-3 Valid Parameters for ETM Runtime Parameters Screen (continued)

Parameter Description Valid Entries

Clock Tick | Normally ETM runs synchronous to the
system clock. If ETM ismorethan 1 sbehind,
it takes the interval time [mg] set to the tag
(type ANALOG) in the Parameter tag column
until ETM has caught up the system clock.
With this parameter, the user can at run time
control ETM so asto catch up time (clock
tick value < 1000 ms) or run delayed (clock
tick value > 1000 ms). The configuration of
this Parameter supersedes the program
argument used for the same effect.

OpMode Tag (type LONGANA) in the Parameter tag | See “ Operational Modes’ on page 188.
column used to set / display the operation

mode of ETM.
Monday, The entry in the program argument column | Case-sensitive weekday entry
Tuesday, identifies this weekday. It isused in the Event

Wednesday, |Listandinthe Input Masks. This Parameter
Thursday, can be listed severa ways, such as Mon, Mo,

Friday, MO, Lun, to suit multiple abbreviations or

Saturday, languages.

Sunday

Workday Same as <Monday>..<Sunday>. This Optional tag (type DIGITAL, ANALOG,

Parameter can be listed several ways, such as | LONGANA, FLOAT or MESSAGE)
Workday, WRK. With this setting, the user
can control the span of the workday. If no tag
is specified, ETM identifies the time span
from Monday 00:00:00 to Friday 23:59:59 as
workday.

Weekend Same as Monday. This Parameter may be Optional tag (type DIGITAL, ANALOG,
listed severa ways, such as Weekend, WND. |LONGANA, FLOAT or MESSAGE)
With this setting, the user can control the span
of the weekend. If no tag is specified, ETM
identifies the time span from Saturday
00:00:00 to Sunday 23:59:59 as weekend.
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Operational Modes

The following operational modes can be set by the user to force ETM in the desired mode and
ETM will use them to display the mode it is running:

Mode Dec HexaDec Description

Auto 0 0x0000 ETM follows the system clock

Test 1 0x0001 ETM follows the <Externa Time> tags
value

Off 2 0x0002 Stop the internal clock

The following operational modes can be displayed in addition to ones above:

Init 256 0x0100 Processing an initialization routine
(same as required on start up)
ReadDB 512 0x0200 Reading the Event List database

The following examples show the possible combinations:

Auto/ Init 256 0x0100 Initializing for Auto mode

Test / Init 257 0x0101 Initializing for Test mode

Auto/ ReadDB 512 0x0200 Reading the Event List while running in
Auto mode

Test / ReadDB 513 0x0201 Reading the Event List whilerunning in Test
mode

Auto/ Init/ ReadDB 768 0x0300 Reading the Event List while initializing for
Auto mode

Test / Init / ReadDB 769 0x0301 Reading the Event List whileinitializing for
Test mode
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ETM EVENT CONFIGURATION MASKS

The ETM Input Mask Program can be started by double-clicking the specific icon on your
desktop.

Event Overview and Select List

The startup screen shows an overview of all objectsin alphabetical order of the defined events.
The following window shows all weekly events after filling in the input masks:

#2  PROLINK-ETM
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The following screen shows all specified objects after clicking Choice on any menu.

€2 PROLINK-ETM = B
File Event Pos Window
€2  Select Object [[=] B3
Selection Pos  wWindow ETh_Maski
Object Name Ohject Description Function Unit ‘
<
LKOBMMO1_AS ‘Water Pump OnOff l
LKOBMMOZ_AS Multistage Motor Step 0...4
LKO6TJO1_AV Room Temperature Temperature [15...25 DegC s
RF12WW02_AS Wast Water Pump OnOff
RF12WW02_AvV Wast Water Pump Speed 0...100 %
RF12VV02_AV Wast Water Valve Position 0...100 % =
RF12TJ01_AV Room Temperature Temperature (15...25 DegC

2|
-]

>|
Cancel | Selection Unselect J

I 7

All functions can be accessed by mouse, Tab and Enter key, or by selecting an item from the
menu. To copy, modify or delete arecord, the desired object must be selected prior to releasing
the function. For copy and modify, open the Event Configuration Mask to define the events for
the selected object.

Scroll Buttons are on the right hand side of the list:

[< Go to thefirst page
<< Page up

< Lineup

> Line down

>> Page down

>| Go to the last page

The following main functions are available:

Add Select anew object and define eventsfor it.
Copy Copy the events of the selected object to another one and modify it.
Modify Modify the selected object.
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Delete Delete the selected object and its events. You will be prompted to
acknowledge deletion.

Selection Specify alist of selected objects matching user defined criterion (filter). A
window displays where the desired criterion can be defined. After defining
the criterion and clicking OK, the Select List displays.

Unselect Cancel any selection and clear the criterion entered before. A list of all
objects will display again.

End Shutdown the ETM Input Mask program. If changes were made, a
confirmation message appears to update the Event List. Click Yesto store the
information, No to ignore the modifications, or Cancel to not end the session.

Event Configuration Input Mask

For functions Copy and Modify the fields in the Event Configuration Mask will appear with
data already existing, for function Add they will be set default (normally empty).

The screen below shows the input mask for a weekly program with the function Step:

€2 PROLINK-ETM M= E3
File Event Pos Window ETM_Mask4
Modify o=
| LKOBMMOZ_AS Choice| Step ~Day of Week
" Mon
Multistage Motor 0.4 C Tue
el SRl (! ‘ Special Events R Wed
NOT |Easter Easter I Thu
Insert | |Master ;
NOT |Xmas Weekend P
Workday [ Sat
Del | [xmas K Sun
Hr Min Sec Command ‘ TS
04 |10 Levelt Levell |  FixDate |
Level2
04 |10 |30 Level2 Level3 )
nsert | IEovert valid from 2001 (03 |01
07 |15 Leveld Off Through 2003 [12 |31
18 |30 Leveld Del
22 |20 off Cancel ‘ oK

&
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The screen below shows the input mask for weekly program with the function Temperature.

€2 DROLINK-ETM =] B
File Event Pos Window ETH_Masks
Modify o=
‘LKOGTJOLAV Choice| Temperature ~Day of Week
—I " Mon
Room Temperature 16...26 DegC
™ Tue
e SHEEIZIE E ‘ Special Events I~ Wed
Workday Easter " Thu
Insert | |Master ;
NOT (Xmas Vveekend LIFri
Workday | Ll
Del | [xmas I Sun
Hr Min| Sec Command ‘ Commands
04 (03 ?=19 2 Fix Date e
Decrease
o e (IR T | kel valid from 1209 [09 (15
05 |30 Increase Through 2002 ’E ’?
19 30 Decrease Del
20 (o0 Decrease Cancel ‘ oK
I 4

The following main functions are available:

Cancel
OK
Choice

Insert

Del
NOT

Cancel the changes and go back to the Event Overview.
Save the changes and go back to the Event Overview.

Shows the Select List of objects matching the Selection Criterion. For
selection, double-click an item or click and press OK.

A list of available entriesis on the right side of the button. The entry
marked in thislist isinsert to the list on the left. The list shows the current
Specia Events or Commands for the actual object. When clicking an item
inthelist of available entries, the selected item in the list of Special Events
or Commands is overwritten.

Delete the selected item in the list of Special Events or Commands.

The selected Special Event can be negated (inverted) by clicking the NOT
column of the entry. A second click cancels the negation.

The cursor can be set into afield by mouse click or by stepping through with the Tab key. Input
fields are displayed with a white background.

192 / FactoryLink Task Configuration Reference Guide



EVENT TIME MANAGER | 10
ETM Event Configuration Masks

The special ? command allows you to enter a user specified value. It isindicated by a prompt
?=inthelist of commands and accepts any useful value. Just enter the value after the prompt
e.g. ?=23 or ?=Alarm.

You can limit an event to a Day of Week by simply checking the appropriate box and/or you
can limit it to a Fix Date and/or Valid from Through. Note that periods for Day of Week,
Special Events, can exclude each other and thus prevent an action. Asalogical rule consider an
Event to bevalid at the time given by: [Day of Week OR Special Event] AND [Fix Date] AND
[Valid from..Through] AND [Event Time].

An empty field generally means always. An empty time field means at 00: 00: 00.

Selection Criterion

If you press Selection, a mask displays where the criterion for filtering can be entered. Note, a
blank field will be interpreted as all. The syntax of a criterion depends on the field type where
it is entered. More information about filtering isin the appendix Regular Expressions of the
SuperNova user manual.

Overview of criterion in numerical fields (##=number):

## field value must be equal ##

<# field value must be smaller than ##

<=## field value must be equal or smaller than ##

SH field value must be greater than ##

>S=H# field value must be equal or greater than ##

I=## field value must be different (not equal) from ##

Overview of criterion in aphanumerical fields where even wildcards can be used:

* field must be empty (blank)

I* field must have an entry (not empty)
*string field value must be equal to string
I*string field value must be different from string
*Astring field value must begin with string

Example: To see only the objects whose name begins with MBO01, type **MBO01 in the object
name field.
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Advanced selection criterion:

[A-Z]

[a-f]

[0-9]

[A-Z]\{10)
B[0-9]\{4\}
["0-9]*
[A-Z]1,3\}[0-9]*

one capital letter

one small letter from athrough f

one digit

10 consecutive capita letters

aB followed by four digits

no digits are allowed (* in the bracket means NOT)
1, 2, or 3 capita letter followed by digits
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PROGRAM ARGUMENTS

You can control the behavior of ETM by program arguments. A program argument is marked

by ahyphen {-} followed by a argument name and avalue if required. Program arguments are
not case-sensitive and must be separated by at |east one space. An argument without a hyphen
isinterpreted as afile name where the program arguments are read.

The ETM task writes information about startup, shutdown, version, actual program argument
values and log output into file {flapp}{FLNAME}NFLDOMAIN}NFLUSERNog\etm.log. Asan
example, alog file name can be c:\flapp\flapp1\shared\shareusrlog\etm.log.

Description
(also see sample file ETM_para.run on the installation media)
file Program Argument File None
The file must be specified by full path and file namein the System
Configuration table. Environment variables can be used; they must be
set in braces{ }, such as{flapp}\etm_para.run.

-OpModeff Startup Command Oper ation M ode #=0..2 0
ETM will start up in the specified mode.

-SleepTime# Cyclic Sleep Time#=100..1000 [ms] (Normal Interval) 900 ms
After each process cycle, ETM is suspended for the specified time if
the internal clock is not more than 1 second behind the external clock
(system clock or test clock).

See < Parameters <ClockTick>, <Internal Time> and <External Time>.

-ShortSTeepTimedt |Cyclic Short Sleep Time #=50..500 [ms] (Catch-up Interval) 300 ms
After each process cycle, ETM is suspended for the specified time if
the internal clock is more than 1 second behind the external clock
(system clock or test clock).

See < Parameters <ClockTick>, <Internal Time> and <External Time>.

-StartupTimedf Span Considering Sartup Events#=1..100 [hour g 6 hours
At startup, ETM considers events in this span if the appropriate
command uses Mode Sto initialize the control tags value,

see Function Table Mode column.

-BufferTimedf Additional Span for Events#=1..10 [days] 1 day
When scanning the Event List, ETM stores every event for the
specified day(s). This span isused to prevent the loss of eventsin case
the Event List is not available for any reason.

-ReadPeriodi Rate of Reading the Event List #=600..100000 [sec] 900 sec
Thisisthe period the Event List is scanned for events valid for this
day and the time buffer. Use < Parameter Tag <ReadDB> to force
reading the Event List.

Argument Default
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On the run-time manager, only the latest message of atask isvisible.
If this argument is set, every status message of ETM iswritten into
the ETM log file for protocol information.

Description
T A S (also see sample file ETM_para.run on the installation media) Default

-MaxMsgSized Maximum Length of Sringin MESSAGE Tags#=1..30000 8096
[bytes] bytes
Thisisthe largest message that ETM will handle.

-LogEventO Event Log TypeO None
Information of every processed event iswritten into the ETM log file
(other types not supported)

-LogCtLoad CT-FileLoad Log None
At startup of ETM, the results of reading the configuration tables and
generating the input triggers are written to the ETM log file.

-LogTrigger Input Trigger Log None
If aninput trigger occurs at run time, it iswritten in the ETM log file.

-LogStack Function CallsL og None
Every internal function call of ETM iswritten in the ETM log file.

-LogMemory Memory Management Log None
Allocating and freeing memory are written in the ETM log file.

-LogStatus Satus M essages L og None

Program Argumentsfor Input Masks

When starting the ETM Input Masks, you can preselect the list of objects to display by the
program argument OBJECTNAM E=<expr>, where expr isaregular expression defining the

filter.

Do not use an asterisk at the begin of expr athough it isrequired in the selection mask. This
can be useful in conjunction with MMI in order to display the Input Mask for a currently
selected object; for example, to see the events of object named LKO6MMO1_AS, enter:
nova -w etm OBJECTNAME=LK0O6MMO01_AS

or for events of the first object beginning with LK06, enter:nova -w etm
OBJECTNAME="LKO06
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INFORMATION AND ERROR MESSAGES

The following messages can display on the Run-time Manager. Note, %s, %d, etc. represent
values created at run time, #nnn isa 3 digit unique message number, and %03d:%05d indicates

atag index.

Label in file ETM.TXT

Information and Warning Messages = #0xx

PROG_STARTING

ETM Vx.xx starting

PROG_RUNNING

ETM VX.xX running

PROG_STOPPING

ETM Vx.xx stopping

PROG_INACTIVE

ETM Vx.xx normal shut down

PROG_FILE_PROC

Processing file %s

PROG_REC_DAT_PROC

Processing all records for internal use

PROG_NO_JOB

#001 No objects defined to schedule

ACE_INV_AUTHORIZATION

#002 No authorization: shut down by time-out

ACE_DRV_NOT_INSTALLED

#003 Driver not installed: shut down by time-out

ACE_PRINTER_NOT_READY

#004 Printer not ready: shut down by time-out

ACE_RESTART_PREVENTED

#005 Restart prevented: shut down FactoryLink first

FLOAT_VAL_WRONG

#010 Invalid float in assembled value

E_FLCHANGEREAD

#020 Error while FL_Change_Read code=%d

E_FLCLEARCHANGEFLAG

#021 Error clearing change flag tag %603d:%05d code=%d

E_FLREAD

#022 Error reading tag %03d:%005d code=%d

E_FLSETCHANGEFLAG

#023 Error setting change flag tag %03d:%05d code=%d

E_FLWRITE

#024 Error writing tag %03d:%05d code=%d

E_UNKNOWN_COMMAND

#040 Error command %s not allowed on function %s for object
control tag %s

E_UNKNOWN_TRIGGER_TYPE

#041 Error unknown trigger type %d

E_UNKNOWN_VAL_TYPE

#042 Error unknown value type in function %s

E_UNKNOWN_SPECEVENT

#043 Error unknown Special Event %s defined on an event for
object control tag %s
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Label in file ETM.TXT

Information and Warning Messages = #0xx

E_EXTTIMEINPUT

#044 Error invalid time format in external time tag, use 1SO 8601
(YYYY-MM-DD hh:mm:ss)

E_AF_GENERAL

#070 Error Event List ascii file general failure

E_AF_READ_RECORD

#071 Error reading Event List ASCI|I filerecord

E_AF_FILE_OPEN

#072 Error opening Event List ASCII file

E_AF_FILE_READ

#073 Error reading Event List ASCII file

E_AF_UNKNOWN_INTERFACE

#074 Error unknown interface for Event List ascii file

E_AF_WHERECLAUSE

#075 Error creating where clause for Event List ascii file

E_DB_GENERAL

#080 Error Event List general database error

E_DB_READ_RECORD

#081 Error reading Event List record

E_DB_READ_MOVEABS

#082 Error reading Event List position trigger

E_DB_READ_STATUS

#083 Error reading Event List status tag

E_DB_READ_CURRENTROW

#084 Error reading Event List current row tag

E_DB_WRITE_MOVEREL

#085 Error writing Event List move trigger

E_DB_WRITE_SELECT

#086 Error writing Event List select trigger

E_DB_WRITE_SQL

#087 Error writing Event List SQL statement
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Label in file ETM.TXT Failure Shutdown Messages = #1xx

SOFTWARE_NOT_LICENSED #100 Option not installed or License not enabled
Verify the option key isinstalled and the license is enabled. Use the
License Wizard to see the purchased options.

ACE_ERR_IN_INSTALLATION |#101 Authorization executable file may be corrupted

ACE_ERR_IN_KEYFILE #102 Authorization key file may be corrupted

PROG_INIT_FAIL #103 Error registering ETM to kernel, code=%d

E CT_GET_HDRLEN #110 Error header length %sin ct file %s len=%d

E_CT_GET_NCTS #111 Error empty ct file %s

E CT_GET_NRECS #112 Error no recordsin ct file %s

E_CT_GET_RECLEN #113 Error record length %s in ct file %s len=%d

E CT_OPEN #114 Error opening ct file %s

E CT_READ_HDR #115 Error reading header %sin ct file %s

E CT_READ_INDEX #116 Error reading index in ct file %s

E_CT_READ_RECS #117 Error reading %s recordsin ct file %s

E CT_TYPE #118 Error unknown ct type %d in ct file%es

SYS NO_MEMORY #130 Error getting memory

SYS FOPEN_ERR #131 Error opening file %s

PROG_THREAD_START_ERR #132 Error starting thread %s : %s

E GET_GLOBAL_TAG #133 Error global tag with id=%d not found

E DCREATE #134 Error creating directory %s

E MKDIR #135 Error creating directory %s

E_NPATH #136 Error getting memory for NPATH
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Label in file ETM.TXT

Configuration Error Shutdown Messages = #2xx

PROG_ARG_UNKNOWN

#201 Program argument %s unknown

E_PROGENVVAR

#202 Environment variable %s unknown

E_FOPENARG

#203 Error opening program argument file %s

E_WRONG_TAGTY PE

#210 Error wrong tag type %d for tag %s

E_UNKNOWN_LISTFORMAT

#220 Error unknown format %s of Event List

E_DB_ALIAS NOT_FOUND

#221 Error database alias %s not found in historian table which
handles the Event List

E_DB_ALIAS NOT_LOCATABLE

#222 Error database alias not locatable in DBBROWSER table
“ O/OS”

E_DB_FIELD_NOT_FOUND

#223 Error field %s not found in DBBROWSER table %s

E_LOGEXPR_COUNT

#224 Error count of logical expressions lines not %d

E_LOGEXPRTAG_NOT_FOUND

#225 Error tag describing logical expression ,,%s"* not found in
DBBROWSER table %s

E_EVENTLIST

#226 Error Event List database schema

E_DUPOBJECT

#227 Error duplicated object control tag %s

E_DUPFUNCTIONANDCOMMAND

#228 Error duplicated command %s on function %s

E_NOFUNCTION

#229 Error function %s for object control tag %s not defined

E_INVALID_PARAARG

#230 Error invalid Parameter argument %s, no white-space
characters allowed
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File Manager allows you to perform basic operating system file management operations
initiated by a FactoryLink application at run time. This task worksin conjunction with
FactoryLink’s FLLAN option to initiate operations within other FactoryLink stations on the
network.

OPERATING PRINCIPLES

The File Manager initiates the following operations:
e Copy afile

* Rename afile

- Deleteafile

» Print afile

 Display adirectory

« Typeafile

File Manager initiates these operations with six commands:
- COPY - PRINT

- REN -DIR

- DEL -TYPE

These commands perform the same functionsjust like their operating system counterparts. The
File Manager controls all file operations through the FactoryLink real-time database.

You can configure other FactoryLink tasksto initiate File Manager operations. For example:

* You can configure input functions in Graphics so an operator can use them to initiate
file-management operations at run time, such asto display alist of recipes or reports.

e The Timer task can trigger File Manager to automatically back up filesto a networked
server at certain intervals, such as each day at midnight.

e The Timer task can aso trigger File Manager to delete log files automatically at certain
intervals, such as once every four hours, or after certain events, such as when log files reach
aspecified size.

 Alarm Supervisor can trigger File Manager to print alarm files.
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To enable aloca node to perform file management operations with aremote node at run time,
the FLFM_SERVER task must be running on the node that does not initiate the FLFM
command. Either start the FLFM_SERVER task manually from the Run-Time Manager screen
at startup or configure FactoryLink to start the FLFM_SERVER task automatically at system
startup. Complete the following steps to do this.

1 Open the System Configuration Information table on the remote node.
2 Locate the row containing the entry FLFM_SERVER in the Task field.

3 IntheFlags field for that row, enter an R. This configuresthe FLFM_SERVER task on the
remote node to start up automatically whenever FactoryLink is started.

FILE MANAGER CONTROL TABLE

The File Manager Control table sets up triggers for the File Manager commands you want to
perform and required source and destination path information.

File manager defaults to the User domain, but you can configure it in to run in either the
Shared or the User domain.

Accessing

In your server application, open Other Tasks > File Manager > File Manager Control.

Field Descriptions

Table Name Specifies the name of the operation being defined or modified. For TYPE
and DIR operations, this field connects the entry in the File Manager
Control table with the associated File Manager Information table for that
entry.

Thisfield is optional for COPY, REN, DEL, and PRINT operations and is
required for TY PE and DIR operations. You can use it to distinguish
different operations of the same type.

Valid Entry: up to 16 alphanumeric characters
Command Trigger Name of atag used to initiate the file operation.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
Position Trigger Name of atag that tellsthe File Manager wherein adirectory to start listing

files or wherein afileto start typing. The File Manager starts reading after
the line number specified by the value of the Position Trigger tag.
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For example, if the value of the Position Trigger tag is 6, the File Manager
begins reading the file at line seven. The number of lines displayed or the
number of fileslisted depends on the number of tags defined in the File
Manager Information table. You can configure the system so any
FactoryLink task can change the value of thistag at run time so the File
Manager starts at a different point in adirectory or file.

Required only for DIR and TY PE operations; not used for COPY, PRINT,
REN, and DEL operations. Do not specify the same tag name for DIR and
TY PE operations.
Valid Entry: tag name
Valid Data Type: analog

Command File operation to be performed. This can be one of the following:

COPY

REN

DEL

PRINT

DIR

TYPE

Copies the source file to the destination file. Does not
require a File Manager Information table. Only onefilein
acopy operation can be remote.

Renames the source file to the destination file. Both the
source and destination paths must be the same. Does not
require a File Manager Information table.

Deletes the source file. The DEL command requires only
the source path; the destination path is ignored. Does not
require a File Manager Information table.

Causes the file specified by the source path to be printed
on the device specified by the destination path. The
destination path must contain the name of a device known
to the Print Spooler task. This operation works only with
the Print Spooler and does not require a File Manager
Information table.

Displaysalist of all filesin the directory specified by the
source path, which can include wildcard characters.

The destination path isignored. This operation requires
you to compl ete a File Manager Information table and to
animate Text objects in mimicsto display lines from the
file.

Displays the contents of the source file. The destination
path isignored. This operation requires you to complete a
File Manager Information table and to animate Text
objectsin mimics to display lines from the file.
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Source File Spec. Full path name of the sourcefile. The source file spec. can use the file name
syntax for the operating system of either the remote or the local station.

If you areusing FLLAN, the source can reference aremote station. The two
stations must be the same if you specify a remote station for the destination
and a remote station for the source. You have no restriction on the source
station if the destination islocal or on the destination if the sourceislocal.
For more information about referencing remote stations, see “Using File
Manager with Networks” on page 217.

Type wildcard characters in the path name to show aroot directory’s
contents using the DIR command. For example, in thisfield type:

Ci\xx
For standalone systems:
/DEVICE_NAME/DIR_NAME/SUB_DIR_NAME/FILE_NAME
For networked systems:
\STATION_NAME\DEVICE_NAME/DIR_NAME/SUB_DIR_NAME/FILE_NAME

In the case of the COPY, DEL, and DIR commands, the source file
specification may contain variable specifiers or wildcard characters (*). For
more information about variable specifiers and wildcard characters, see
“Using Variable Specifiersin File Specifications’ on page 214 and “Using
Wildcard Charactersin File Specifications’ on page 216.

Valid Entry: full path name

Note: Whenusingenvironment variablesin path names, you can enter
the name of the environment variable surrounded by braces{ } and
FactoryLink extends the pathname using the default setting. For
example, use {HOME}/flink/csinfo.txt for DIR and TY PE.

Source Variables Names of tags whose val ues replace the variabl e specifiers in the source
1-4 path name. Thesefieldswork in conjunction with the Source File Spec. field
to form the path of the file the File Manager performs operationsto. The
value of the tag in the Source Variable 1 field replaces the first variable
specifier, the value of the tag in the Source Variable 2 field replaces the
second variable specifier, and so on.

If the tag specified in this field is undefined, the Tag Editor appears when
you click Enter.

Ensure the data type of the tag matches the variable specifier typeif using
variable specifiers.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
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Destination File Full path name of the destination file. The Destination File Spec. can use the
Spec. file name syntax for the operating system either the remote or the local
station resides on.

If you areusing FLLAN, the destination can reference aremote station. The
two stations must be the same if you specify aremote station for the
destination and a remote station for the source. You have no restriction on
the source station if the destination islocal or on the destination if the
sourceislocal. For more information about referencing remote stations, see
“Using File Manager with Networks’ on page 217.

For standalone systems:
/DEVICE_NAME/DIR_NAME/SUB_DIR_NAME/FILE_NAME

For networked systems:
\STATION_NAME\DEVICE_NAME/DIR_NAME/SUB_DIR_NAME/FILE_NAME

Unless you use wildcard characters in the source file specification, specify
the full path name of the destination. If you use wildcard characters, do not
specify the full path; specify only the directory.

In the case of the COPY, DEL, and DIR commands, the destination file
specification can contain variable specifiers or wildcard characters (*).

Use the following destination file specification format if using the PRINT
command:

[\station_name\] [flags] [spool_device]
where

station_name Isthe optional FactoryLink station name (defaults to
LOCAL). Not used on standal one systems.

flags Optional flags, which can be one of the following.
NONE—Thisis the defaullt.
B—Binary file.

S—Suppress Beginning and End of File. Used to
concatenate files.

spool_device Istheoptional spool device (defaultsto 1; legal devices
are 1 through 5).
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Valid Entry Format Description Example
DRIVE:\DIR\SUBDIR\ For CA\LOG\HISTORY\
FILE.EXT standalone HISTORY.ARC

systems
\\STATION\DRIVE:\ For \\NODEL\C:\HIST\PIC\
DIR\SUBDIR\FILE.EXT networked SCREENLPIC
systems

Destination Names of tags whose val ues replace the variabl e specifiersin the
Variables 1-4  destination path name. These fields work in conjunction with the
Destination Format field to form the path of the file the File Manager
performs operations in. The value of the tag in the Destination Variable 1
field replaces the first variable specifier, the value of thetag in the
Destination Variable 2 field replaces the second variable specifier, and so on.

Ensure the data type matches the variable specifier typeif you use variable
specifiers.
Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message
Completion Trigger Name of atag used to indicate afile-management operation is complete, but
not necessarily successful. Thistag, if defined, is set by File Manager and
can be referenced by any FactoryLink task, including File Manager to
monitor file-management operations or trigger an event.
Valid Entry: tag name
Valid Data Type: digital

Completion Status Name of atag set by the File Manager task to indicate the status of an
operation. The Completion Status tag can be referenced by any FactoryLink
task, including the File Manager to handle file error situations or trigger the
next File Manager table to start an operation.

Valid Entry: tag name
Valid Data Type: anaog

The File Manager writes an analog value to the Completion Status tag to
indicate the status of a file management operation. In addition to the
Completion Status tag, you can usethetask’'s TASKMESSAGE_UJ[x] tag to
report messages on the application screen.
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This tag can have any of the following status values.

Value Description Value Description
0 Operation completed successfully. | 12 Can't open file (path/file name).
1 Current operation in progress. 13 Error occurred while reading afile.
2 Specified file(s) not found. 14 File could not be created.
3* Requested a line beyond end of file. |15 Error occurred while writing to afile.
5 Remote system could not perform 16 [1legal spool device was specified.
requested action.
6 Attempt to log onto a remote station | 17 Not enough memory to perform
failed operation
8 Network transmission error occurred | 97 Illegal file name was specified
* |f the TY PE/DIR position trigger offset values are increased beyond the end
of the file, the File Manager reads in as many lines as possible, setsthe
completion trigger, and sets the completion status to 3.

For examples of File Manager operations, see “ Sample File Manager Operations’ on page 208.

FILE MANAGER INFORMATION TABLE

The File Manager Information table defines the tags that will display the results of a TY PE or
DIR operation. Animate these tags as Text objects on a graphics screen. Complete this table
ONLY if you are configuring a DIR or TY PE operation. Otherwise, you have completed the
configuration of the File Manager task.

Accessing

In your server application, open Other Tasks > File Manager > File Manager Control > “your tag
name” > File Manager Information.

Field Descriptions

Tag Name Name of amessage tag that, asaresult of aDIR or TY PE command,
receives a message value to be displayed in asingle line on a graphics
screen. The number of Tag Name fields defined in this table determines the
number of lines displayed as aresult of aDIR or TY PE command at run
time. (Required only for DIR and TY PE operations; not used with COPY,
PRINT, REN, and DEL operations.)
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If the tag specified in this field is undefined, the Tag Editor appears when
you click Enter with atag type of message in the Type field. Accept this
default.

Values are written to the tags defined in the Tag Name field whenever aDIR
or TY PE operation is triggered or whenever the operator changes the value
of the Position Trigger tag defined in the control table. A different valuein
the Position Trigger tag means information from a different place in the
directory or fileis displayed.

Valid Entry: tag name
Valid Data Type: message

SAMPLE FILE MANAGER OPERATIONS

The examples below illustrate each type of file-management operation. In these examples,
entries for each type of file-management operation are displayed in separate sample Control
tables. In an actual FactoryLink application, all file-management operations are configured in
one control table.

Thefirst four examples do not require you to compl ete an associated File Manager Information
table. The last two examples do require you to complete a File Manager Information table.

Example 1: COPY

Example 1 demonstrates how to configure a COPY operation using Windows file syntax. You
can configure the Math & Logic task or an analog counter in the Counterstask to use this
operation to increment the alarm history file number. This resultsin arolling count of the
history file being transferred: Hist.001, Hist.002, and so on. Complete the control table to
configure a COPY operation,

Sample File Manager Control Table

. Sample i
Field Enitry Explanation

Table Name WINCOPY | Leavethisfield blank because the COPY operation
does not require completion of the File Manager
Information table; however, we recommend you
complete thisfield to distinguish different operations of

the same type.
Command copytrig Name of the digital tag that triggers the copy operation.
Trigger You can configure other tasks to write to this tag to

trigger the copy operation.
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Sample File Manager Control Table

q Sample f
Field Eifry Explanation
Command COPY Designates a COPY operation.
Source c:\history\ The path and file name of thefileto be copied. In this
File Spec. hist.%03d exampl e, the source path name contains a variable

specifier. At run time, whenever the operator or another
task triggersthe digital tag copytrig, File Manager
replaces this variable with the value of the analog tag

fx1_ext.
Source fx1_ext At runtime, File Manager replacesthe variable %03d in
Variable 1 the Source File Spec. field with the value of this analog

tag. In this example, this value is a three-number file
extension, such as .001.

Destination File | a\archive The path name where the source file is to be copied.
Spec. Destination Variables are not necessary because this
entry contains a static specifier.

Completion copydone When the COPY operation has been completed, File

Trigger Manager forces the value of thistag to 1 (ON),
indicating the operation is complete.

Completion copystat When the COPY operation is complete, File Manager

Status indicates the status of the operation by writing an

analog valueto thistag. Use thetask’s
TASKMESSAGE_U[6] tag to report messages on the
application screen in addition to the Compl etion Status
tag. For example, if you get astatus 12 in the
Completion Status tag, you also see the message: Can't
open file (path/file name).

If you want to use Math and Logic for this function, set
up amath procedure triggered by the status tag itself. In
the procedure, assign the appropriate ASCI| string for
each possible status code to a message tag in a series of
IF THEN statements. For example,

IF status=1 THEN
MSG = “whatever”
ENDIF
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Example 2: PRINT

Example 2 demonstrates how to configure a PRINT operation. Configure the control table to
configure a PRINT operation. PRINT command file syntax is the same for all operating
systems.

Sample File Manager Control Table

Field Sample

Entry Explanation

TableName |PRINT Designates the name of a PRINT operation.

Command printtrig Name of the digital tag that triggers the print operation. You can

Trigger also configure other tasks to write to this tag to trigger a print
operation.

Command PRINT Designates a PRINT operation.

Source %s The name of the file to be printed. In this example, the file

File Spec. nameis avariable specifier. At run time, File Manager replaces

this variable with the value of the message tag printpath,
specified in the Source Variable 1 field.

Source printpath | At run time, the File Manager replaces the variable %s in the

Variable 1 Source File Spec. field with the value of this message tag. In
this example, thisvalueis afile name.

DestinationFi |1 1 designates the print spool device that prints the file specified

le Spec. by printpath. This example assumes you have aready defined

print spool device 1in the Print Spooler task. At run time, when
the operator or atask triggersthe digital tag printtrig, File
Manager prints the file to Print Spooler device number one.
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Example 3 demonstrates how to configure a REN (rename) operation using Windowsfile
syntax. Configure the control table to configure a REN operation.

Sample File Manager Control Table

Field Sample Entry Explanation

TableName |WINREN Designates the name of a REN operation.

Command rentrig Name of the digital tag that triggers the rename

Trigger operation.

Command REN Designates a REN operation.

Source c:\temp\%s.log Thisfield contains a variable specifier, which File

File Spec. Manager replaces at run time with the value of the
message tag s_file, specified in the Source Variable 1
field.

Source s file File Manager replacesthe variable %sin the Source File

Variable 1 Spec. field at run time with the value of this analog tag.

Destination %s.tmp %s.tmp contains a variable specifier, which File

File Spec. Manager replaces at run time with the value of the
message tag rento, specified in the Destination Variable
1field.

DestinationVa | rento When the value of the digital tag rentrig isforced to 1

riable 1 (ON), File Manager renames the file specified in s_file

with the file name contained in rento.
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Example 4: TYPE

Example 4 demonstrates the TY PE command. TY PE command file syntax is the same for all
operating systems.

Sample File Manager Control Table
Field ngg}l{e Explanation

TableName |TYPE Designates the name of a TY PE operation.

Command typetrig Name of the digital tag used to trigger the type operation.

Trigger

Command TYPE Designates a TY PE operation.

Position typescroll Name of the analog tag that controls the output of the TY PE

Trigger command

Source %s Thisfield contains a variable specifier, which the File

File Spec. Manager replaces at run time with the value of the message

tag typepath, designated in the Source Variable 1 field.

Source typepath At run time, when the value of the digital tag typetrig is

Variable 1 forced to 1 (ON), the File Manager types thefile specified by

typepath. Because TY PE operations do not need a
destination, the Destination Variable fields are left blank.

Tag Name typlinl At run time, when the value of the digital tag typetrig is
typlin2 forced to 1 (ON), the File Manager reads the file specified in
typlin3 the Source Tag 1 tag typepath. The File Manager starts
typlind reading after the line number specified by the Scroll tag
typlins typescroll. In this example, eight lines of text from the
typlinG specified file are read into message tags typlinl, typlin2,
typlin7 ...typlin8. These message tags may be referenced by other
typlin8 FactoryLink tasks or displayed on a graphics screen.
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Example 5: DIR (Directory)

Example 5 demonstrates the DIR (Directory) command. DIR command file syntax is the same
for all operating systems.

Sample File Manager Control Table

Field ngwe Explanation

TableName |DIR Designates the name of a DIR operation.

Command dirtrig Name of the digital tag used to trigger the dir operation.

Trigger

Position dirscroll | Name of the analog tag that controls the output of the DIR

Trigger command.

Command DIR Designates a DIR operation.

Source %s Thisfield contains a variable specifier, which the File Manager

File Spec. replaces at run time with the value of the message tag dirpath,
designated in the Source Variable 1 field.

Source dirpath At runtime, when the value of the digital tag dirtrigisforced to 1

Variable 1 (ON), File Manager displays the directory specified by dirpath.

The Destination Variable fields are blank because DIR operations
do not need a destination.

At run time, when the value of the digital tag dirtrig isforced to 1
(ON), File Manager reads the directory specified in the Source
Tag 1 tag dirpath. File Manager starts reading after the line
number specified by the Scroll tag dirscroll. In this example,
eight lines of text from the specified file are read into message
tags dirlinl, dirlin2, ...dirlin8. These message tags may be
referenced by other FactoryLink tasks or displayed on a graphics
screen.
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Example 6: DEL (Delete)

Example 6 demonstrates the DEL (Delete) command using Windows file syntax.

Sample File Manager Control Table
Field Sample Entry Explanation

TableName | WINDEL Designates the name of a DEL operation.

Command deltrig Name of the digital tag used to trigger the delete

Trigger operation.

Command DEL Designates a DEL operation.

Source c:\hist\%s.tmp Thisfield contains a variable specifier, which File

File Spec. Manager replaces at run time with the value of the
message tag delfile, designated in the Source Variable 1
field.

Source delfile At run time, when the value of the digital tag deltrig is

Variable 1 forced to 1 (ON), File Manager deletesthefile specified
by delfile. The Destination Variable fields are left blank
because DEL operations do not need a destination.

USING VARIABLE SPECIFIERS IN FILE SPECIFICATIONS

Use variable specifiersif the operator or the system isto enter all or part of the source or
destination specification; however, do not use variable specifiersif the same files are to be
used for all operations. Use the Source and Destination Variable fields to designate variables to
replace the variable specifiers.

You can include up to four variable specifiers (each one designated by aleading percent sign
%) in the path or file name. These variable specifiersindicate a portion of the path or file name
that is variable (replaced with data from tags when the file operation is performed). The
variables can be digital, analog, long analog, floating-point, or message tags. Multiple
variables can be used together, asin afile name and extension (for example, %8s.%3s).

If you want to vary the actual path/files used in either the source or destination paths, use one
or more of the four variables and %xx type specifiers to dynamically build these at run time
from tags; otherwise, hardcode the exact path/file names desired and leave the four tag variable
fields blank.
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The data type of the tag must match the variable-specifier type as follows.

Variable Variable FactoryLink
Specifier Specifier Type Data Type
%d Decimal Digital, Analog, Longana, Float
%s String Message

The table below contains examples of variable specifiers using generic syntax.

Variable Specifier Examples
Variable Description Entry Sample Results
Directory, subdirectory, or file name %8s FLINK
Numeric file extension .%d A1,.2,.3
%.03d .001, .002, .003
File name and extension %8s.%603d file.001
%08s.%03s file.exe

The following table contains Windows-specific examples of variable specifiers used to
designate paths. The last example shows the path name of a station on a network.

Samples of Variable Specifiers in Path Names
Description Example Comments

Standard path c:\history\exe\sample.exe Base example

1lvariable c:\%8s\exe\sample.exe Variable for directory

2 variables c:\%8s\%8s\sample.exe Variables for directory and
subdirectory

3variables €:\%8s\%8s\sampl e.%3s Variables for directory, subdirectory,
and 3-character file extension

4 variables %15:\%.85\%.83\ Variables for drive, directory,

sample.%3s subdirectory, and file extension
Standard path for |\\node2\c:\history\exe\sample.exe | \\node2\ is the name of aremote
anetwork station station
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USING WILDCARD CHARACTERS IN FILE SPECIFICATIONS
The File Manager task accepts the following wildcard character specifiersin the source and
destination path names:
* (asterisk)  For string replacement.

? (question  For single-character replacement.
mark)

Format path names:

source /DEVICE_NAME/DIR_NAME/SUB_DIR_NAME/WILDCARD FILESPEC.

destination IDEVICE_NAME/DIR_NAME/SUB_DIR_NAME.

Do not specify afile name for the destination path with COPY as
File Manager does it for you.

Path names with wildcard charactersin the file specifications might resemble this example:

source IDEVICE/FLINK/SAMPLE/SAMPLE .*

destination IDEVICE/FLINK/EXE.

Example of aFile Manager operation using wildcard characters Windows file syntax):

Sample File Manager Control Table Using Wildcard Characters
Field Sample Entry Explanation

Command COPY Designates a COPY operation.

Trigger copytrig Name of the digital tag used to trigger the copy
operation.

Source c:\hist\report\rpt*.* | Designates the source path.

Format

Destination | C:\HIST\ At runtime, al filesin the REPORT

Format RECORDS subdirectory that begin with RPT are copied to
the RECORDS subdirectory.

Do not specify afile name for the destination path as File Manager will do it for you.
Pathnames with wildcard charactersin the file specifications might resembl e this example:

source C:\FLINK\SAMPLE\SAMPLE *

destination C:\FLINK\EXE
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USING FILE MANAGER WITH NETWORKS

In addition to being fully compatible with FactoryLink, the FactoryLink File Manager is
compatible with networks using the TCP/IP protocol type.

File-management functions, such as copying, deleting, printing, and renaming files, can be
performed between the local FactoryLink system and any remote computer running File
Manager as long as the FactoryLink system contains the FactoryLink Local Area Networking
(FLLAN) option.

If using FLLAN, create the LOCAL file before filling in the configuration tables. Define the
local station name in the ASCI| file LOCAL in the FLAPP/NET directory. Remember:
standal one systems require the LOCAL file.

Either the source or destination path name can refer to afile on aremote station. The format for
aremote file path is

\\(station)\(path)
where

station Isthe name of the remote station, up to 256 characters.
path Isthefull path name of the file on the remote station.

The source and destination are interchangeable aslong as one of them isthe local FactoryLink
station. The only difference between local file operations and remote file operations is remote
file names must include the disk/drive specification if required by the operating system and
must conform to the file name syntax for the remote computer’s operating system.

Only one file can be remote in a copy operation. Both files must be on the same station in a
rename operation.

For example, to copy afile from alocal FactoryLink station to aremote FactoryLink station,
use the following format for the remote path name:

\STATION_NAME\DEVICE_NAME/DIR_NAME/FILE_NAME
Other file-management operations can be performed with File Manager using the same format.

Do not use the remote file name (\\(STATION)\) when performing File Manager operations on
networks unless you installed FLLAN on the local and remote computers. Using the FLLAN
FactoryLink station name instructs FLLAN rather than the network to perform the operation.

At run time, ensure the FLFM_SERVER task is running on the remote node before invoking
file management operations between local and remote nodes.
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Using the COPY Command with FLLAN

COPY operations are the most common File Manager operations performed on a networked

system and have the following uses:

» Copy locdl filesto aremote station
» Copy remotefilesto alocal station
e Copy locdl filesto the local station

Example of a copy operation on a networked system (Windows file syntax)

Sample File Manager Control Table
Field Sample Entry Explanation
Table Name WINXFER Designates afile-transfer operation on a network using
FLLAN.
Command COPY Designates a COPY operation.
Trigger filexfertrig Name of the digital tag used to trigger the copy
operation.
Source c\arc\ Source path where % s is the variable specifier. The
Format %s.log string specified by the value of the messagetag s_file
replaces the %s in the source specification.
SourceTagl |s file At run time, File Manager replacesthe variable %sin
the Source Format field with the value of this analog
tag.
Destination \\nod2\%s File Manager computes the destination path in the
Format same way as the source path.
Destination S path If the message tag s_path contains the following
Tagl message;
{FLINK)\RECIPE
the computed destination specification is
\NOD2\{FLINKNRECIPE
Completion copydone File Manager forces the value of thistagto 1 (ON)
Trigger when the COPY operation is complete. Another
FactoryLink task can use thistag or to trigger another
File Manager operation.
Completion copystat File Manager writes the status information to this
Status analog tag when the COPY operation is complete.

For information about variable specifiers, see the Fundamentals Guide.
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Using the COPY Command with a Network Without FLLAN

When specifying a COPY command for networks without FLLAN, do not specify a station
name in the Source Format and Destination Format fields. Instead, specify a network device
that isany logical device on aremote computer used asif it were alocal device.

Different operating systems reference network devicesin different ways. Consult the user’s
manual for the appropriate operating system to find the proper syntax for referencing these
devices.

PROGRAM ARGUMENTS

Task Argument Description
FLCM -alx> Each request is acknowledged. File
. Manager will wait adefault of 15
Where <x> is the ACK seconds for the ACK. Use this
timeout in seconds parameter if you wish to change this
time-out.
FLFM -C Do not replacefirst period in file name
with a space.
-D<ip> Set verbose level. (#=0to 22)
-L Enables logging of debug information
toalogfile.
-S<> Closes and reopens log file every #
messages.
-T Insert timestamp at beginning of each
debug statement.
W< Wraps log file every # messages.
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ERROR MESSAGES

Error Message

Cause and Action

Can't determine fluser name

Cause:

Action:

No FLUSER name is specified.
Specify an FLUSER name.

Can't find Network

Cause:

Action:

Cause:

Action:

Cause:

Action:

Either the network shut down or is not installed correctly.

Restart the network if it shut down. Reinstall it if
installed incorrectly.

The wrong name is entered in the LOCAL file.

Enter the name the network is registered under in the
LOCAL file.

The ETC servicesfile may not have any entriesif using a
TCP/IP network.

See“FLLAN” on page 227 for information about adding
the correct entries to the ETC servicesfile.

Can't add local name to the network

Cause:

Action:

Either the name specified in the LAN Local Namestable
isnot avalid network name or the network software may
not have been installed properly.

In Configuration Explorer, open Local Area Network
Groups and modify the local names on the LAN Local
Namestable. If error is not corrected, ensure the network
software is operating properly.

Can't determine local node name

Cause:

Action:

Either the LAN local namesfile (FLAPP/NET/LOCAL)
does not exist or it contains invalid data.

Ensure FLAPP/NET/LOCAL exists. Create it if it does not
exigt. If it exists, find and correct any invalid data.

Can't open file filename

Cause:

Action:

The specified file may not exist or another task may have
opened it.

Ensure the specified file exists. Createiit if it does not
exist.

Can’t send ACK to inform client I'm
ready

Cause:

Action:

The client or network may not be operating.
Check state of client and network connection.
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Error Message Cause and Action

Error creating temp file; check SPOOL | Cause: The hard disk isfull.
dir Action: Delete any unnecessary files.

Cause:  The/SPOOL directory was not created during installation.
Action: Create a/SPOOL directory or reinstall FactoryLink.
Cause: The/SPOOL directory was del eted.

Action: Create a/SPOOL directory or reinstall FactoryLink.
Cause:  The permissions are corrupt.

Action: Change the permissions so the FactoryLink user nameis
authorized to create files in the /SPOOL directory.

Error opening CT Cause: The/FLINK/CT/FLFM.CT file does not exist, may not be
opened, or may be damaged. The installation may not
have completed successfully.

Action: Ensure the /FLINK/CT/FLFM.CT file exists. If the file does
exist, delete /[FLINK/CT/FLFM.CT and restart the
application to rebuild the FLFM.CT file.

Error opening filename Cause: Thefile does not exist.
Action: Specify adifferent file or create thefile.

Cause: A syntax error occurred when specifying the path or
filename.

Action: Retry the command using the correct path and filename.

Cause: The File Manager task does not have permission to read
the specified file.

Action: Change the permissions so the FactoryLink user nameis
authorized to open filesin the specified directory.

Error printing file Cause: Either the printer is disconnected, is not powered on, is
not online, or has some other problem.

Action: Ensure the printer cables are connected, the power ison,
and the printer is online. If thefile still does not print,
contact the system administrator for the printer in use.

Error reading CT index Cause:  The /FLINK/CT/FLFM.CT fileis damaged.

Action: Delete /FLINK/CT/FLFM.CT. Restart the application to
rebuild the FLFM.CT file.
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Error Message

Cause and Action

File Manager task init. failed, err = Cause:
number

Action:

The File Manager task could not register with the
FactoryLink kernel.

Ensure the System Configuration Table contains the
entry FLFM. Also, ensure the File Manager option is
enabled on the FactoryLink key.

File Manager option bit not set Cause:

Action:

The option bit for the File Manager task is hot enabled on
the FactoryLink key. Either you entered the configuration
sequence incorrectly during installation or you have not
purchased the File Manager option.

First, check the license material on the Exhibit A form
that accompanies the FactoryLink package to seeif File
Manager islisted asalicensed option. If it islisted on the
Exhibit A form, reenter the configuration sequence and
authorization code to enable the option. For information
about the configuration sequence and authorization code,
see the Install ation Guide.

If File Manager is not listed on the Exhibit A form,
contact your FactoryLink sales representative to
purchase the File Manager option.

File not found Cause:
Action:

Cause:

Action:
Cause:

Action:

The file does not exist.
Specify adifferent file.

A syntax error occurred when specifying the path or
filename.

Retry the command using the correct path and filename.

The File Manager task does not have permission to print
the specified file.

Change the permissions so the FactoryLink user nameis
authorized to print files in the specified directory.
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Error Message Cause and Action

File read ERROR on filename Cause: The disk may be corrupt.

Action: For Windows, run the disk diagnostic program CHKDSK
to determineif the disk is corrupt. If the disk is corrupt,
recreate the file from scratch or from the backup disk or

tape.

If the corruption is not on the root drive, inform your
system administrator of the corruption asfsck will not be
ableto repair it.

File write ERROR on filename Cause: The disk may befull.

Action: Delete any unnecessary files. Add disk space if thiserror
occurs freguently.

FLFM port in use-do file operation later | Cause: If the File Manager server gets this error, another server
may already be up on that machine. If the File Manager
client gets this error, then too many clients may be
running on that machine. (The current limit is 10.)

Action: Check for existing File Manager server or clients. Try the
file operation again later.

FLFM port in use-do file operation later | Cause: If the File Manager server getsthis error, another server
may already be up on that machine. If the File Manager
client gets this error, then too many clients may be
running on that machine. (The current limit is 10.)

Action: Check for existing File Manager server or clients. Try the
file operation again later.

Internal request queue is corrupt Cause: Aninternal FLFM error occurred.
Action: Contact your technical support representative.

Invalid character in PRINT destination |Cause: Aninvalid character isentered after the node namein the
Destination Format field of the File Manager Control
table.

Action: Open the File Manager Control table. Specify avalid
entry in the Destination Format field.

FactoryLink Task Configuration Reference Guide / 223



11 | FILE MANAGER
Error Messages

Error Message

Cause and Action

Invalid command

Cause:

Action:

An invalid command is entered in the Command field of
the File Manager Control table.

Open the File Manager Control table. Specify avalid
command in the Command field:

COPY PRINT

DEL REN

DIR TYPE

Invalid CT file

Cause:

Action:

The /FLINK/CT/FLFM.CT file is damaged.

Delete /FLINK/CT/FLFM.CT. Restart the application to
rebuild the FLFM.CT file.

Invalid local name file

Cause:

Action:

Aninvalid character or parameter is entered in the
LOCAL field.

In your server application, open Networking > Local Area
Network Groups > local. Ensure all information defined
on the LAN Local Namestable isvalid. Correct invalid
information. See “FLLAN" on page 227 for information
about the correct syntax for thisfile.

Local wild-card copy failed on filename

Cause:

Action:

Not enough RAM to build thefilelist.

Shut down unnecessary tasks. Add RAM if this error
occurs often.

Network open did not connect

Cause:

Action:

The session is not properly connected.
Retry the operation.

Network open failed network name

Cause:

Action:

Either no available sessions exist or the node nameis not
valid.

Ensure the remote node name (part of the file path name)
isvalid and retry the operation.

Network open timeout

Cause:

Action:

The network may be down.
The node may be down.
The node name in the file path name may beinvalid.

Ensure the node name is valid and the node and network
are up and running.
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Error Message Cause and Action

Network write error Cause: The system cannot write to the network because the
remote program shut down or terminated
communications.

Action: Ensure the remote node is up and connected.

Never got ACK from server-givingup | Cause: Server or network may be down or may have gone down.
Action: Check state of server and network connection.

New client communications setup Cause:  The client or network may not be operating.

failed Action: Check state of client and network connection.

No network for receive Cause: You have specified a remote node name for a File
Manager operation; however, the FactoryLink system
does not contain the FLLAN option. File Manager
operations cannot be performed to remote nodes unless
the FLLAN option isinstalled.

Action: Specify alocal node or install the FLLAN option.

No network for send Cause: You have specified a remote node name for a File
Manager operation; however, the FactoryLink system
does not contain the FLLAN option. File Manager
operations cannot be performed to remote nodes unless
the FLLAN option isinstalled.

Action: Specify alocal node or install the FLLAN option.

No tables configured for this task Cause: No File Manager configuration tables have been defined.

Action: Inyour server application, open Other Tasks > File
Manager > File Manager Control and specify information
in the File Manager's configuration tables.

Out of RAM Cause: Not enough memory to run this task.

Action: Restart thetask. If it fails again, allocate more memory
for thistask or allocate more virtual memory.

Partial wild-card copy filename Cause: An error occurred during a multi-file copy. The File
Manager copied al filesin thelist prior to the specified
file. The File Manager did not copy the specified fileand
any files after it on thelist.

Action: Copy thefilesthat were not copied or retry the operation.
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Error Message

Cause and Action

Received error or hangup during Cause: The client or network may not be operating.
connect Action: Check state of client and network connection.
Received no ACK or BUSY msg from | Cause:  Server or network may be down or may have gone down.
Server Action: Check state of server and network connection.
Remote wild-card copy failed Cause:  Not enough RAM existsto build the file list.
Action: Shut down unnecessary tasks. Add virtual memory if this
error occurs often.
Request to allocate zero size RAM Cause: Either the operating system, third-party software, or
block hardware setup on your system isincorrect or
incompatible or an internal error occurred.
Action: Run adisk diagnostic program to determine if the disk is
corrupt. If itis, recreate the files from a backup disk.
Server busy-waiting for ACK from Cause: The server is currently servicing another client’s request.
server Action: No action is needed. The server will automatically serve
the request when it is freed up.
Two different remote nodes, node name | Cause: A different remote name is entered in the Source Format
node name field than was entered in the Destination Format field of
the File Manager Control table for the PRINT command.
A remote name must be the same in both fields.
Action: Inthe File Manager Control table, ensure both names are
the sameif remote names are specified in both the Source
Format and Destination Format fields.
Unknown configuration option Cause: Aninvalid parameter or character is entered in the LAN
local namesfile (/[FLAPP/NET/LOCAL).
Action: Ensureavalid local nameis defined on the LAN Local

Names table. Enter the correct information. See the
“FLLAN” on page 227 for information about the
LOCAL file syntax.
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The FactoryLink Local Area Networking (FLLAN) module transmits FactoryLink data
between computers (called stations) across a network. A network isacombination of hardware
and software that lets multiple computers share resources, such asfiles, printers, or data. A
network consists of the following parts:

» A Network Operating System (NOS)—Software that transports data between software
applications on different computers.

A network application—Software that sends data to a similar application on another
computer viathe Network Operating System.

» The network hardware—Network interface cardsinstalled on each computer on the network
and cables that link them all together.

Note: FLLAN wasthe first FactoryLink task for sharing data between nodes
on anetwork. In alater version of FactoryLink, the Virtual Real-Time Network
and Redundancy (VRN/VRR) task was introduced. VRN/VRR has al of the
functionality of FLLAN and is more flexible. FLLAN is still supported, but if
you are starting a new application, it is recommended that you use VRN/VRR
instead. For more information, see “Virtual Real-Time Network and
Redundancy” on page 521.

OPERATING PRINCIPLES

Tags are sent between one station and another using send and receive operations. The tags and
operations are defined in the Local AreaNetwork Send and Receive tables. These tables define
the conditions under which the send operations are initiated and whether or not the remote
station iswilling to receive the data.

Sending and Receiving Data

Sending Tag Values to Remote Stations

During a send operation, the FLLAN on the local station sends tag values from the
FactoryLink real-time database across the network to the FLLAN on the remote station. The
FLLAN on the remote station writes these values to the real -time database on the receiving
station.
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Receiving Tag Values from Remote Stations

During areceive operation, FLLAN receives values from a remote station and stores them in
the FactoryLink real-time database as tags.You do not need the module FLLAN on two or
more FactoryLink stationsin order to share and store files on a network server or use network
printers. External networking software allowing peer servicesis sufficient to achieve this goal.

Local and Remote Stations

Each station on the network must have a unique station name so FLLAN can identify it. Each
station views itself asthe local station and views all other stations on the network as remote.

Network Groups

You can combine one or more stations into groups. Grouping permits you to transmit the same
data to multiple stations with a single operation. A single station can belong to more than one
group. You can use the same group name on more than one remote station; however, these
groups are independent and do not correspond to each other.

Using Multiple Platforms on a Network

Because the Network Operating System is transparent to FactoryLink, you can use a different
Network Operating System program on each station on a network. Thisletsyou use
FactoryLink for different platforms within the same network. You must use the same protocol
on al stationsin the network.

Monitoring the Network

You can monitor the status of remote stations on the network, such as the number of
transmissions the remote station has sent and received and whether these transmissions were
successful. You can view the status at run time and other FactoryLink modules can use this
information for other activities.

Local Station’s Default Values

Thelocal station name and the default values FLLAN uses to transmit datais stored in the
local name file FLAPP/net/local on each FactoryLink station. We recommend you consult your
network administrator if you need to change the default values.

Ordering Tag Names
When sending tag values, FLLAN groups the tags into packets by data type and sends them in
the following order: digital, anal og, floating-point, message, long analog, and mailbox. To

maximize efficiency, place tags of like data-typesin the same order in the LAN Send
Information table.
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Defining TCP/IP Hosts and Service Ports

You must define host and service port information on each station using the following
procedure if you are using TCP/IP. If you are using a name server, you may not need to
perform some of the stepsin this procedure as the name server automatically performs some of
these actions.

1 Definethe TCP/IP Internet addresses for al stations in the hosts file if you are not using a
name server or if you are using aname server but the local station nameisnotinit.

Refer to the vendor’s documentation for details on how to modify these files. Contact your
system administrator if you do not know your TCP/IP addresses. The syntax for defining the
TCP/IP addressis

address sta_name STA_ALIAS

where
address Isthe TCP/IP internet address.
sta_name Isthe unique name assigned to the station.
STA ALIAS Isthealias used to reference the station. This must be in all uppercase. For

example,
192.195.178.33 stationl STATION1
192.195.178.121 station2 STATION2
TCP/IP Internet station uppercase
addresses aliases

names

FLLAN restricts you to 1024 sessions. For each read-only entry in the external domain table, a
session is needed for the client and the server. If the entry is aread-write connection, two
sessions are created on both the server and client. The 1024 session limit isfor each FLLAN
application. This means a client can have 1024 sessions and the server can also have 1024
sessions. See the -n option for changing the session limit.
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2 Definethe service portsfor FLLAN. The file where you define these depends on your
operating system.

Enter the following lines in the file defined for your operating system to define the service
ports. Use all uppercase letters for the service names.

FLLAN 4096/tcp fllan
FLFM 4097/tcp flfm
FLFMSERV 4098/tcp flfmserv
Y Y )
service name service port service name
number alias

Use the service port numbers unless another service namein the servicesfile isaready using
one of these numbers. If you use different service port numbers, make them consistent for all
stations on the network. See the vendor’s documentation for details about service port
numbers.

FLLAN Wakeup Tag

If datais not sent to remote stations regularly, network connections may time out. You must
configure the FLLANSIG tag to prevent network timeouts from occurring.

FLLANSIG is apredefined digital tag that sends a wakeup to the FLLAN task at a
configurable interval to all connected remote stations. FLLANSIG also triggers FLLAN to
determine whether it is time to attempt connections to unconnected remote stations.
FLLANSIG is defined in the Interval Timer Information Table.

FLLANSIG isanumber that is less than or equal to the number of secondsin either the TX or
CALL parameter, depending on which isless. If you did not change the local station default
TX or CALL values, thisis a number less than or equal to 10. If you changed the local station
default TX or CALL values, thisis anumber lessthan or equal to the lesser of the two.

FLLAN does not wake up when the TX or CALL intervals have passed. When the value of
FLLANSIG changes, FLLAN wakes up to check whether either of these two intervals have
passed.

TESTING THE NETWORK CONNECTION

After your network isinstalled, test the communication between stations using the following
utilities.

« NR—Tests whether a station can receive data from another station on the network.

» NS—Tests whether a station can send data to another station on the network.
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These test programs send and receive data using the same format as FLLAN. Run NR on one
station (the local station), and run NS on the remote station to test the communications

between two stations on the network. Then, reverse the process for the same two stations. Test
every station on the network and test every station as both alocal station and a remote station.

Perform the following steps to run the NR and NS test programs:

Start NR on the local station. Use the following syntax for this command:

nr local_name remote_name [-dverbose_level][-xdebug_level][-I]

[-bbufsize] [-a]
where
local_name
remote_name

verbose level

debug_level

bufsize

Is the name of the computer that receives the data.
Is the name of the remote computer that sends the data.

Controls how much information NR displays about each packet it receives.
This can be one of the following:

0 Displaysthe sequence number of messages in multiples of
10 when every 10th message is received. The messageis
displayed on the same line as the sequence number; the
message does not scroll. Thisisthe default.

1 Displaysthe sequence number of the current message. The
message is displayed on the same line as the sequence
number; the message does not scroll.

2 Displaysthe sequence number of the current message. The
message is displayed on different lines and scrolls.

>3 Inaddition to level 2 output, the message is displayed in
hexadecimal format. Any value greater than 3 displaysthe
same information as 3.

Is anumber >0 that indicates how much information the network debug
layer displays about each packet. The higher the value, the more
information NR displays. The default is 0.

Writes debug information to alog file named nr.log in the current directory.

Isanumber from 128 to 2048 that specifies the number of bytesin abuffer
(message). The default is 512.

Acknowledges al received messages. If you include -a with this command,
you must include it with the NS command on the remote station.
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Inthefollowing example, STATION1 isthelocal station running NR. STATION2 istheremote
station running NS. The local station acknowledges all messagesiit receives from the remote
station.

nr STATION1 STATIONZ2 -a

2 Start NS on the remote station when NR isin the listening mode. Use the following syntax for
this command:

ns local_name remote_name [-dverbose |evel][-xdebug_level] [-]
[-bbufsize][-psecs] [-a]

where
local_name Isthe name of the computer that sends the data.
remote_name |sthe name of the computer that receives the data.

verbose_level  Controls how much information NS displays about each packet it sends.
This can be one of the following:

0 Displaysthe sequence number of messagesin multiples of
10 when every 10th message is sent. The messageis
displayed on the same line as the sequence number; the
message does not scroll. Thisis the default.

1 Displaysthe sequence number of the current message. The
message is displayed on the same line as the sequence
number; the message does not scroll.

2 Displaysthe sequence number of the current message. The
message is displayed on different lines and scrolls.

>3 Inaddition to level 2 output, the message is displayed in
hexadecimal format. Any value greater than 3 displaysthe
same information as 3.

debug level Isanumber >0 that indicates how much information the network layer
displays about each packet. The default is 0. The higher the value, the more
information NS displays.

-  Debug information to alog file named ns.log in the current directory.

bufsize Isanumber from 128 to 2,048 that specifies the number of bytesin a buffer
(message). The default is 512.

secs Isanumber from 1 to 59 that specifies the number of seconds between
packet sends.
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-a  Acknowledges al received messages. If you include -a with this command,
you must include it with the NR command on the other station.

In the following example, STATIONZ2 isrunning NS. STATION1 is running NR. STATION2
acknowledges all transmissions from STATION:

ns STATION2 STATION1 -a

After you start NR and NS, they display the following message on the computers they are
running on:

n sessions, n buffers, buffer size = n
addname: local_station_name

The programs then display the following message until the two computers establish a
connection:

open remote_station_name

You may experience adelay of several seconds between the two messages. Then the computers
display the following message:

wait on call

Verify the computers establish a connection. After the computers establish a connection, NR
and NS automatically begin transmitting messages. The computer running NR displays
data-transfer information on its screen each time it receives data. The computer running NS
displays data-transfer information on its screen each time it sends data.

Press Esc on either computer to stop the test.

Run NR and NS again at a higher debug level if the computers do not connect. Note any errors
that display.

Repeat Step 5 until the computers connect.

Repeat this procedure again, but run NR on the station you first ran NS and run NS on the
station you first ran NR.

Repeat this procedure on each station in the network.
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NAMING STATIONS AND NETWORK GROUPS

FactoryLink must know the name of each local and remote station on the network running a
FactoryLink application as well as any groups defined for the station. Thisinformation is
defined in Local Area Network Groups configuration table, which consists of two tables:

e LAN Loca Names—Defineslocal station name and any changes to station default values.
« LAN Remote Names—Defines the network groups and stations belonging to a group.

You can fill out as many Send tables as the RAM on your system allows. You can enter as
many tags asthe available RAM allows. The Local AreaNetwork Send tableisfilled out in the
Shared domain.

The example table defines the following information:

* Namesthe local station

¢ Changesthe default values of TX and RX

 Defines two network groups and assigns the remote stations to them

LAN Local Names Table

Local station names are defined in the LAN Local Names table.

Perform the following steps to define the station name for the local computer. You must repeat
this procedure for each computer in the network running FactoryLink.

1 Inyour server application, open Networking > Local Area Network Groups > local.

2 Enter the computer name of the local station as defined in the network operating system. (To
find out what your computer name is, open the control table and click the Network icon.)

Computer names are case-sensitive. Enter the computer name in the LAN Local Names
exactly asitis spelled in the control table.

D:¥Program Files\TecnomatixiFactorylLinkipplications\Starter Appinetiocal g @

QS| s|=le] =] 2] afe] v|»g] £ 2

STATIONL Tal
TX=30 —
rRx=120|
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3 (Optional) To change any of the transmit parameters from their default values, enter the
parameters and their new values beneath the station name.

In the example, TX=30 changes the maximum time between data transmissions to 30 seconds,
RX =120 changes the maximum time between receipts of datato 120 seconds. The possible
transmit parameters and their default values are given below.

4 Press Enter at the end of the last line to enter ahard return. If only a station name is entered,
then press Enter after the station name. Thishard return isrequired.

5 Complete the LAN Remote Names table to define the network groups. (See page 239.)

Local Station Transmit Parameters and Default Values

The table below lists al the transmit parameters used by the local station and their default
values. The parameters are explained following the table:

Parameter Default Value
TX 20
RX 60
INIT 0
CALL 10
BUFSIZE 512
MAXLEN 512
MAXSESS 32
ACK 0
ST 10
SD 10

Note: It isrecommended that you consult your network administrator before

changing any default values.

TX (Transmit Time-out)

A number between 0 and 65,527 that sets the maximum time, in seconds, between
transmissions. The default is 20. If the local station does not send any datato a given remote
station after the indicated time, the local station sends an “I am still here” packet to the remote

station.
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RX (Receive Time-out)

A number between 0 and 65,527 that sets the maximum time, in seconds, between receptions.
Thedefaultis 60. Make surethisvalueisat least threetimes greater than the TX value. If
the local station does not receive any data from aremote station after the indicated time, the
local station disconnects from the remote station and attempts to reconnect.

If you specify an RX value greater than 60, modify the -t program argument in the System
Configuration table; otherwise, FLLANRCV may not shut down properly. To do this, complete
the following steps:

1. Open the System Configuration table in the Shared domain. The System Configuration
editor appears.

2. Click theright arrow at the bottom of the editor to select the FLLANRCYV task.

3. Inthe Program Argumentsfield, enter the -t argument with the required RX value. For
example, if the RX value in the Local Names table = 90, then enter -t90.

4. Click Apply to save the change and then close the System Configuration editor.
INIT

A valueof 0 or 1 that specifies whether the local station sends all datawhen it first connects
with another station. The default is 0. The local station uses this value only when a remote
station starts up.

« [f INIT =0, when thelocal station first connects to another station, it does not send values
until one of the values has changed.

o If INIT =1, whenthelocal station first connectsto another station, it sendsall values during
the first real-time database scan. This can be useful when you start aremote station after the
local station has been running. The new station has no values when it starts, so the loca
station sends the values it has at that time. After that, the local station values are updated
normally.

Because startup data can contain uninitialized values, it is recommended that you leave INIT at
0.

CALL

A number between 0 and 65,527 that defines the minimum amount of time, in seconds, the
local station waits for a call to aremote station to connect. The default is 10. If the remote
station does not connect to the local station, the local station waits at least CALL seconds
before attempting to reconnect. The remote station may still connect to the local station in the
interim.
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MAXLEN

Only FLLAN usesthe MAXLEN parameter. The largest number of bytes a station can send or
receive in asingle data packet. The minimum is 512; the maximum is 65,536. The default is
512. The tag datais truncated if amessage or mailbox tag is sent that is larger than MAXLEN.
Make sure this number is the same on all stations.

« If you enter avalue less than the minimum of 512, FLLAN uses 512.
« If you enter avalue greater than the maximum of 65,536, FLLAN uses 65,536.

Each tag uses a specific number of bytes, depending on its datatype. All tags use 4 bytesto
storeits tag name + x humber of bytes to store the value, as shown in the table below:

The tag type... uses ... for the tag name + ... for the value which =
Digital 4 bytes 2 bytes 6 bytes
Analog 4 bytes 2 bytes 6 bytes
Longana 4 bytes 4 bytes 8 bytes
Float 4 bytes 8 bytes 12 bytes
Message 6 bytes the number of characters |y bytes

(4 + 2 bytesfor thelength) | inthestring
Mailbox 30 bytes the number of characters |y bytes
(4 + 26 bytes for the header) | in the string

The MAXLEN parameter must be configured to specify the maximum number of bytes each
node requires to send or receive a single data packet.

To distribute alarms and logbook entries along the network, use the following formulato
calculate the number of bytes required at each node:

((84 x number of active alarms) + 38) + (number of logbook entries x (24 + msg space)) = bytes

where

number of active  isthe maximum number of alarms defined for display in the Active Alarms
alarms field in the General Alarm Setup Control table.

number of logbook isthe maximum number of logbook entries expected to be generated for the
entries  alarms defined. This number can be smaller than or equal to the number of
active alarms. A practical estimate of the normal volume of logbook entries

is 20-30% of the total alarms.

msg space this number is smaller than or equal to the number of input lines.
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MAXLEN parameters must match on all nodes that receive distributed alarms.
BUFSIZE

Only File Manager uses the BUFSIZE parameter. A number between 128 and 2,048 that sets
the size of each buffer in bytes. The default is 512 bytes. The size of the buffer determines the
amount of data File Manager can transmit across the network in a single message.

MAXSESS

The maximum number of stations to which the local station can connect at the same time.
These are called connections. The default is 32. The maximum number of connections varies
by network protocol:

e For NetBIOS, any number from 1 to x where x is the maximum allowed by NetBIOS. See
the NetBIOS documentation.

e For TCP/IP and DECnet, any number from 1 to 64.
ACK

A number from 0 to 1,024 that specifies the number of seconds the local station will wait for a
remote station to send a data packet acknowledgment before disconnecting from that station.
The default is O, which indicates the local does not require an acknowledgment from aremote.

ST (Send Time-out)

A number from 0 to 1,024 that specifies the number of seconds the local station will keep
trying to send its dataif the remote station cannot accept it because it cannot process data fast
enough. The default is 10 seconds. When the time-out expires, the local station generates an
error.

SD (Send Delay)

A number from 0 to 1,024 that specifies the number of secondsthe local station waits between
triesto send its data if the remote station cannot accept it because it cannot process data fast
enough. The default is 10 seconds. If you increase this number, you will reduce CPU
consumption but you may cause the overall performanceto drop.
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LAN Remote Names Table

Network groups are defined in the LAN Remote Names table. You must assign each remote
station on the network to a network group. Do not include the name of the local stationin a
network group.

Perform the following steps to define network groupsfor thelocal station. You must repeat this
procedure for each computer in the network running FactoryLink.

1 Inyour server application, open Networking > Local Area Network Groups > Groups.

D:¥Program Files\Tecnomatix\FactoryLinkWApplications\Starter Appinet\groups g @

Q& &[=e| o] 2| ]l o|v]»|F] £ 2
ALAPM=ETATIONZ, 3TATICONS, 3TATICNG, 3TATIONS; I
REPCORT=STATIONS; =1

2]
| | :

2 Completethe LAN Remote Names table. Enter all group names on a separate line using the
following format.

group = STATION[, STATION,...J;

where
group Alphanumeric name of 1 to 16 characters assigned to a network group.
Group names can be either upper or lowercase.

STATION Computer name, as defined in the network operating system, of one or more
remote stationsto include in the group. Spell the name of the remote station
asit isspelled in the control table.

Separate each name with a comma but no space. The station list can be split
at the end of the line, but the commamust be on the same line as the station
name. Place a semicolon (;) at the end of a group name definition.

In this example, the ALARM group consists of STATION2, STATION3, STATION4, and
STATIONS. The REPORT group consists of STATION3. Note that STATION3 belongsto both
groups and that each line ends in a semicolon.

3 PressEnter at the end of the last lineto enter ahard return. Thishard return isrequired.

4 Click Save and close this table.
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SENDING TAG VALUES TO OTHER STATIONS

Datais sent from one station to another using send operations. Each send operation defines
which data to send when the operation executes. The operations and the data to send with each
operation are defined in the Local Area Network Send configuration table.

This chapter provides afield-by-field description of the following two tables:

« LAN Send Control table—Defines the stations to receive data and the conditions under
which FLLAN sends the data.

¢ LAN Send Information table—Defines the tags sent to the remote stations with the send
operation.

You can complete as many Send tables asthe RAM on your system allows. You can enter as
many tags as the available RAM allows.

LAN SEND CONTROL TABLE
Send operations are defined in the LAN Send Control table.

Accessing

In your server application, open Networking > Local Area Network Send > LAN Send Control.

D:\Program Files\Tecnomatix\FactoryLinkWpplications\Starter Appinet\groups E]@
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Field Descriptions

Specify the following information for this table. Add an entry for each send operation you
want FLLAN to transmit across the network.

Table Name Name to reference the send operation.
Valid Entry: up to 16 aphanumeric characters

Group Name Name of the group of network stations that the local station sends data to.
This name must match a group name defined in the LAN Remote Names
table.

From the example used for the LAN Remote Names, the group ALARM is
defined as STATION2, STATIONS3, STATION4, and STATIONS.
Therefore, the FLLAN task on the local station (STATION1 from the LAN
Local Names example) would send data to the stations belonging to the
ALARM group.

Enter ALL if you want to send the datato al stations named in the
GROUPSfile.

Valid Entry: up to 16 aphanumeric characters

Block Trigger Name of atag that triggers this operation. When the change-status flag for
thistask is set, FLLAN sends the values specified in the LAN Send
Information to the stations included in the group specified in the Group
Name field of thistable. You must activate the send operation with the
Exception Send Flag field if you leave thisfield blank.

You can specify both atrigger in this field and an exception send in the
Exception Send Flag field on this table. The operation executes each time
the trigger is set and each time the tag val ue changes; however, if you do
this, the value may not always be sent on exception because the block
trigger may reset the change status bit before FLLAN processes the
exception send table.

The tag specified must be in the Shared domain.

To send the table only when thistag valueisforced to 1 (on), define thistag
asdigital.

To send this table whenever this tag value changes, define thistag as
analog, longana, floating-point, message, or mailbox.

To send individual values only as the table tag values change, rather than as
atriggered block send, leave this field blank.
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Block Send Flag

Exception Send
Flag

You must define the Block Send Flag if you define thisfield.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message, mailbox

Values sent when this operation istriggered. This can be one of the
following:

W Writes only the values that have changed since the last
send.

YES Force-writes only the values that have changed since the
last send. If you enter YES, FLLAN does not send atag’s
default value at start up. Instead, FLLAN waits to send it
until the tag value changes to something other than the
defaullt.

NO Sendsall values except empty mailboxes, whether or not
they have changed.

You must define a Block Trigger for the Block Send Flag to work.

Defines whether or not to send values of individual tags as they change.
This can be one of the following:

W Writes values that change when they change.

YES Force-writes values that change when they change. If you
enter YES, FLLAN does not send atag default value at
start up. Instead, FLLAN waits to send it until the tag
value changes to something other than the default.

NO Does not send values when they change. If you enter NO,
you must activate the send operation with the Block Trigger
field.Thisisthe default.

You minimize network traffic if this datais changing infrequently to send
only the values that change. If datais changing frequently and at regular
intervals, then it is more effective to send the datain triggered blocks.

You can also specify both atrigger in the Block Trigger field and an
exception send in thisfield for the same operation. The operation executes
each time the trigger is set and sends the individual tags each time atag
value changes.

If you set up FLLAN to send the data as it changes and the change bit for
the datais set before FLLAN establishes communication with the remote
node, FLLAN does not send the data until the next time the data changes.
Define a Send State tag in the Network Monitor table (see “Monitoring
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Remote Station Communications’ on page 247 for more information) and
defineaMath & Logic procedure to monitor the value of the Send State tag
to ensure FLLAN sends the changed data.

Do not use the same tag in more than one exception table if you specify
exception sends. If you have the same tag in a block send table and an
exception send table, the triggered table may reset the change status bit
before the exception send table is processed with the result that the
valueltag is not sent on exception.

Note: For further explanation, the following table lists the flags to use based
on what modes to use.

Block Trigger |Block Send Flag Exceplgilgg Send Flag
secl NO NO 1
secl Wor YES NO 2

none required W or YES W or YES 3

Enable/Disable Name of adigital tag to disable this operation. When the value of thistagis
Tag settoO, thisoperation is not executed, even when the Block Trigger is set.
Thisfield disables the operation for al stations included in the group.

Thistag isuseful if aremote station will not be available for the network for
along period of time.

Valid Entry: tag name
Valid Data Type: digital
Default: 1

LAN SEND INFORMATION TABLE

The data to send with each send operation is defined in the LAN Send Control table.

Accessing

Position the cursor on the line entry on the LAN Send Control table representing the send
operation you are configuring. In your server application, open Networking > Local Area
Network Send > LAN Send Control > “your table name” > LAN Send Information.
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Field Descriptions

Tag Name Tag to send with this operation. The tag specified must be in the Shared
domain. Group tags by data type and order them by digital, analog,
floating-point, long analog, message, and mailbox if you want to maximize
performance.

If you enter message or mailbox tags, ensure the MAXLEN valueis set to
dlightly larger than the longest message or mailbox value. The valueis
truncated if the MAXLEN valueis set lower than the length of amessage or
mailbox value.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, floating-point, message,
mailbox

Network Alias  Alias namethat FLLAN usesto transfer data on the network. The alias
(Optional) nameisatag name used globally by all stations on the network. It identifies
data being sent from one station to another. Define this name on the sending
station and reference it on al remote stations that receive data from the
sending station.

If you leavethisfield blank, FLLAN automatically uses the namein the Tag
Name field as the network alias.

If you use an alias hame, you can be more flexible when naming tags
among systems. For instance, at one station an analog tag may be called
alrm7, while at another station an anal og tag contai ning the same data may
be called temphigh. To transfer data across the network from alrm7 to
temphigh, you can designate an alias name, such as hot, for that data.

Valid Entry: up to 48 a phanumeric characters (Do not use anumber
for thefirst character.)

For example, the local station sends the value of the tag regular_tank_level to a corresponding
tag on some remote station. The tag on the remote station may, or may not, be the same name.
If it is not the same name, then you can specify an aliasto link the “sending” tag on the local
station to the “receiving” tag on the remote station.

Using r87_tank_level as the name of the receiving tag on the remote station, the local station
sends the value of regular_tank_level across the network identified astank_level. The alias
tank_level would also be used on the remote station and map to the tag r87_tank_level. Because
the alias between the two stations is the same, the local station can send the value of
regular_tank_level to the remote station tag r87_tank_level.
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RECEIVING TAG VALUES FROM REMOTE STATIONS

FLLAN can receive data from tags on remote FactoryLink stations and write them to the
Real-Time Database on the local station. This mapping is defined in the Local Area Network
Receive configuration table.

This chapter provides afield-by-field description of the following two tables:

» LAN Receive Control table—Defines the remote stations that can send data to the local
station.

* LAN Receive Information table—Defines the tags in the local real-time database that are
updated by data received from remote stations. Another station cannot change its value
unlessyou list atag name in this table. This provides security for sensitive data.

You can complete as many Receive tables asthe RAM on your system allows. You can enter as
many tags as the available RAM allows.

LAN RECEIVE CONTROL TABLE

Remote stations that send data to this local station are identified in the LAN Receive Control
table.

Accessing

In your server application, open Networking > Local Area Network Receive > LAN Receive
Control.

Field Descriptions
Table Name Name for thisreceive operation.
Valid Entry: up to 16 aphanumeric characters

Group Name Namethat identifies the group of network stationswhere FLLAN receives
the tag values. This name must match a name defined in the LAN Remote
Namestable.

Enter ALL if you want to receive data from all stations named in the
GROUPSfile.

Valid Entry: up to 16 alphanumeric characters
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In this example, the local station receives data from the remote stations bel onging to the
network group REPORT.

LAN RECEIVE INFORMATION TABLE

Define the tags in the Real-Time Database for the local station that are updated with the data
received from aremote station.

Ensure the cursor is positioned on the line entry in the LAN Receive Control table representing
the receive operation you are configuring.

Accessing

In your server application, open Networking > Local Area Network Receive > LAN Receive
Control > “your table name” > LAN Receive Information.

Field Descriptions

The name of the receive operation you are configuring is displayed in the Table Name field at
the bottom of the table.

Specify the following information for this table. Add an entry for each tag received from any
remote station in the network group.

Tag Name Tag to be updated when the dataidentified by network aliasisreceived. The
tag specified must be in the Shared domain.
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If you enter message or mailbox tags, ensure the MAXLEN value is set to
slightly larger than the longest message or mailbox value. Thevaueis
truncated if the MAXLEN valueis set lower than the length of amessage or
mailbox value.

Valid Entry: tag name
Valid Data Type: digital, analog, longana, float, message, mailbox

Network Alias  Alias namethat FLLAN uses to transfer data on the network. This name
(Optional) must match the name assigned to a database tag in a send operation on a
remote station.

The alias nameisatag name used globally by all stations on the network. It
identifies data being sent from one station to another. Define this name on
the sending station and reference it on all stations that receive data from the
sending station.

If you leave thisfield blank, FLLAN automatically uses the namein the Tag
Name field as the network alias.

If you use an alias name, you can be more flexible when naming tags
among systems. For instance, at one station, an analog tag may be called
alrm7 while at another station an analog tag containing the same data may
be called temphigh. To transfer data across the network from alrm7 to
temphigh, you can designate an alias name, such as hot, for that data.

Valid Entry: up to 48 aphanumeric characters (Do not use a number
for the first character.)

MONITORING REMOTE STATION COMMUNICATIONS
Configure the Network Monitor table if you want to monitor the status of remote stations on
the network, such as the number of transmissions a remote station has sent and received and
whether these transmissions were successful. This table consists of the Network Monitoring
table that defines the stations you want to monitor and the tags to hold the information.

You can monitor any or al FactoryLink stations on the network as long as they are running
FLLAN. The example table defines tags to contain the status of the STATION3 remote station.

Accessing

In your server application, open Networking > Network Monitoring > Network Monitor
Information.
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Field Descriptions

Station Name Name of the remote station to monitor. This name must match one of the
station namesin the LAN Remote Names table.

|

D:¥Program Files\Tecnomatix\Factorylink\ipplications\Starter Appinet\groups g@
& o] B[ /] (v ][] 2 8
ALARM=STATIONZ , STATIONS, STATIONS; T‘
2 ey
Network Monitor Infofmation - SHARED ( WUS-RI-WS0032\StarterApp ) =Jloed
HE s 2B X/ 0P BHe e
Station Name Send Receive Send Receive
State State Count Count
1 STATIONI i st3zndstate starcvetate st3sndpktcnt st3rcvpktont
Kl

3

Send State Tag to contain the status of transmissions to the remote station. At run time,
FLLAN updates thistag with values to indicate the status:

0
1
3

10
11

12

The remote station is available.
The remote station is not available and is not yet active.

The local station called the remote station but the remote
station has not responded.

One of the stations has disconnected.

The connection has terminated, because the remote station
buffer is adifferent size from the local station buffer.

The remote station is ready to connect.

The remote station responded to a call request but it is not
yet ready to receive data.

The remote station is ready to receive data. Use thisvalue
to ensure you have established communication with the
remote node before sending any data.

Valid Entry: tag name
Valid Data Type: analog
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Receive State Tag to contain the status of transmissions from the remote station. At run

Send Count

Receive Count

Send Sequence

time this tag uses the following values to indicate the status.
0 Theremote station is available.
The remote station is not available and is not yet active.

2 Thelocal stationislistening for acall from the remote
station.

One of the stations has disconnected.

The connection has terminated. This occursif FLLAN
does not reset the remote station when it disconnects.

10 Theremote station is ready to listen.

11 Theremote station called the local station but the local
station is not yet ready to receive data.

12 Thelocal stationisready to receive data.

Valid Entry: tag name
Valid Data Type: analog
Tag that counts the number of times the local station sent data to the remote
station. FLLAN does not reset this value to 0 when the remote station
disconnects.
Valid Entry: tag name
Valid Data Type: analog
Tag that counts the number of times the local station received data from the
remote station. FLLAN does not reset this value to 0 when the remote
station disconnects.
Valid Entry: tag name
Valid Data Type: analog

Tag that indicates the number of the packet the local station sent.

FLLAN assigns a number, called the send sequence number, for each
packet the local station sends to the remote station you are monitoring. As
the local station sends each packet, this number increments. You can
monitor this number to see whether the local station is sending data packets
in the correct order. FLLAN resets this value to 0 each time the stations
reconnect.

Valid Entry: tag name
Valid Data Type: analog
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Receive Sequence

Sequence Errors

Send Errors

Receive Errors

Send Error
Message

Receive Error
Message

Tag that indicates the number of the packet the local station receives.

FLLAN assigns a number called the send sequence number for each packet
thelocal station sendsto the remote station you are monitoring. Asthe local
station receives each packet, this number increments. You can monitor this
number to see whether the local station receives data packets in the correct
order. FLLAN resets this value to 0 each time the stations reconnect.

Tag that counts the number of times the local station sends or receives data
out of sequence.
Valid Entry: tag name
Valid Data Type: anaog
Tag that counts the number of times the local station could not successfully
send data to the remote station. This usually occurs when the local station
tries to send data to the remote station while the remote station is
disconnected.
Valid Entry: tag name
Valid Data Type: anaog
Tag that counts the number of times the local station could not successfully
receive data from the remote station. This usually occurs when the remote
station is disconnected and the local station is waiting for data.
Valid Entry: tag name
Valid Data Type: anaog
Name of a message tag that contains the latest error or status message for
the send link for the remote station.
Valid Entry: tag name
Valid Data Type: message
Name of a message tag that contains the latest error or status message for
the receive link for the remote station.
Valid Entry: tag name
Valid Data Type: message

To view the status on screen at run time, design and configure a graphics screen to display the

information.

If you want other FactoryLink modules to view and use thisinformation for other activities,
configure those modules’ tables. For example, you can configure Math & Logic and Alarm
Supervisor to monitor these tags and trigger an alarm whenever a remote station disconnects.
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Argument

Description

-D<ip>

Set verbose level. (#=0t0 22)

-L

Enables logging of debug information to alog file.

-R (LAN Send only)

Prevents setting LAN Send Enable/Disable tag to 1.

T

Insert timestamp at beginning of each debug statement.

-S<ip>

Closes and reopens log file every # messages.

W<

Wraps log file every # messages.

-X

Logs underlying network software’s error messages to
alogfile.
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Chapter 13. . . .
Historians

The Historian task is the interface between FactoryLink and arelational database. It processes
data requests from other FactoryLink tasks and sends them to the relational database. Data
requests from Database Logger or Data Point Logger tasks can store data in the relational
database. Data requests from Trending or Database Browser tasks can retrieve data from the
relational database.

There are historians for various relational databases, including:

» ODBC (used for SQL Server and other relational databases with ODBC support)
e Oracle

e Sybase

« dBASEIV

OPERATING PRINCIPLES

The following steps describe how a historian processes data requests for arelational database:

1. A FactoryLink task sends a data request to a mailbox historian service. This can be a
request from Database or Data Point Logging to store data in the relational database or
from atask like Trending to retrieve datafrom the relational database. FactoryLink tasks
submit their requests for datain the form of Structured Query Language (SQL) statements.
Generally, mailboxes are unidirectional: atask requesting data from the historian makesthe
request through a different mailbox than the mailbox historian usesto return data.

2. Historian reads this mailbox and processes any queued data requests. It transmits the data
request to the relational database server.

3. Therelational database returns the requested information to the historian if the request was
to retrieve data.

4. Historian returns the requested data to the requesting task.
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SETTING HISTORIAN RUN-TIME PARAMETERS

Perform the following stepsto configure a historian as part of the FactoryLink application. You
perform this procedure for each historian you want to configure.

1 Inyour server application, open System > System Configuration > System Configuration
Information in the form view.

System Configuration Information - SHARED - Historian for dBASE I¥ (R} F ( *\...[ |

Task Information

Task Name |DB4_HIST
T azk Description |Hist0rian for dBASE IV [R]
Task Flags
™ Run At Startup Flag String Y alue
I Create Session Windaw

I” Suppress Orline Configuration I Edit Flags Directly

I Suppress Task Hibemation

Task Dptions
Start Order 1 J;I Stanrt Pricrity 20

Task Executable

Executable File |bin.-"db4_hist J
Program Arguments |-dbase -m
| ¢« 15 >|>>|>"| of 25 | Delete | | |

2 Choose the type of historian you want to configure:

e For dBase IV and ODBC, browse through the System Configuration Tasks using j until
the desired task appearsin the Task Description box.

 For Oracle and Sybase, create a new task using j and perform these steps:

1) Inthe Task Name box, type:
For Oracle, OR8_HIST, OR9_HIST, or OR10HIST(depending on your version).
For Sybase, SYB_HIST.

2) Inthe Task Description box, type a description for the respective database: Historian for
Oracle or Historian for Sybase.
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3) Inthe Executable File box, type:
For Oracle, bin/or8_hist, bin/or9_hist, or bin/or10hist(depending on your version).
For Sybase, bin/syb_hist.

3 Inthe Program Arguments box, type the desired arguments. See alist of the program
arguments on page 280.

4 Under Task Flags, select the Run At Startup check box. Click Apply and exit.

ODBC HISTORIAN OVERVIEW

The ODBC ((Microsoft) Open DataBase Connectivity) historian allows FactoryLink to access
data from multiple, diverse Relational DataBase Management Systems (RDBMS). ODBC
focuses on the Application Programming Interface (API) that supports connections to various
database systems. The standard used for connecting and accessing a database is the Structured
Query Language (SQL). Software components, called drivers, link a FactoryLink application
to an RDBMS. The ODBC historian allows multiple instances of the task to runin asingle
application.

The ODBC historian enables FactoryLink to access datafrom several diverse database systems
through this single interface while the historian remains independent of any RDBMS from
which it accesses data.

The ODBC interface defines the following:

e Dynamic-link libraries (DLL) of ODBC function calls to connect to an RDBMS, execute
statements, and retrieve results

+ SQL syntax of function calls

» Standard representation for data types and the mapping between FactoryLink and RDBMS
data types

« Error codes

The following components work together to make ODBC and FactoryLink communicate:

 FactoryLink—Performs processing and callsto third-party ODBC driversto provide datato
or request data from a data source.

» Driver Manager—L oads ODBC drivers for the needed data source.

 Driver—Processes ODBC function calls, submits SQL requests to a specific data source,
and returns results to FactoryLink.

 Data Source—Contains the datathe driver accesses. Connection strings link a data sourceto
adriver.
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Considerations
Supported Drivers

The ODBC historian supports drivers for Windows platforms. These drivers handle the
connections to the various platforms relational databases run on.

ODBC defines two types of drivers:
 Single-tier—Processes both ODBC calls and SQL statements
* Multiple-tier—Processes ODBC calls and passes SQL statements to the data source

Single-tier drivers do not require additional RDBM S software; however, multiple-tier drivers
do require the purchase of RDBM S server and connectivity products. Communication with
most RDBM Ss on servers requires the installation of the RDBM S client software on the
FactoryLink client.

The following table specifies the required additional connectivity software for each driver. For
specific information regarding the additional software requirements, refer to the document on
the specific driver and the network protocol that connect to your server. For specific software
version numbers for the various products listed in the table bel ow, see the Installation Guide.

Additional Software

Driver Type Bit Requirements
Access Single-tier 32-hit None
MS SQL Server | Multiple-tier 32-bit MS SQL Server Client
Sybase Multiple-tier 32-bit Sybase Open Client-Library and
Net-Library

Conformance Levels

Drivers and their associated RDBM S provide a varying range of functionality. The ODBC
historian requires that drivers conform to the Level 1 API conformance, which determines the
ODBC procedures and SQL statements the driver supports. Use of the Level 2 API function
SQLExtendedFetch is based on whether the driver and its data source support it.

SQL Statements
The ODBC historian does not totally depend on the SQL conformance levels, but rather it tries
to map the FactoryLink datatypesto the best match provided by each data source. When adata

type maps, its SQL statement is accepted as long as the driver and data source can perform that
operation.
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Data stored on an RDBMS has an SQL data type, which may be specific to that data source. A
driver maps data source-specific SQL data typesto ODBC SQL data types and driver-specific
SQL datatypes.

Data Types Supported by ODBC Driver

For information on the data types supported by the relational database, with which the ODBC
driver istransacting, refer to the database documentation.

In the previous versions of FactoryLink, the format of the FactoryLink supported date data
type had to be a string in the format of yyyymmddhhmmss. The tag had to be defined as a
message with aminimum default length of 14 bytesto retrieve the date datatypeinto atag. If a
tag was to insert or update a database row with the date data type, then the tag also had to be a
message data type using previous format. In addition, the product now supports a direct
conversion to and from along analog tag (such as SECTIME) that equates to the el apsed
seconds since January 1, 1980 to the date data type.

Conversion Issue

If you are converting an application that has the ODBC historian configured, the conversion to
the multi-instance ODBC historian requires that you run FLCONV directly against the pre-6.6
ODBC historian configuration or a restore of a platform-specific save. Do not perform a
multiplatform restore of the application before running FLCONV.

Setting Up ODBC
The general steps for setting up ODBC with FactoryLink are:
1 Install adriver for each RDBMS FactoryLink should access.
2 Connect a data source to the driver.
3 Set up driver sources.
4 Complete the necessary FactoryLink Historian Mailbox tables.

The detailed instructions for setting up these steps are described in detail in the following
sections.

Setting up ODBC Drivers and Data Sources
The in-depth information regarding installing a supported driver, its data sources, and their

network connections are not within the scope of this guide. Refer to the documentation
associated with the specific driver you want to install.
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Drivers and Data Sources

Use the ODBC Administrator to add and delete drivers, and to add, configure, and delete data
SOUrces.

Perform the following steps to complete information for drivers and data sources:
1 Open the ODBC Administrator from the Control Panel. Click the ODBC icon.

After you install an ODBC driver, define one or more data sources for it. A data source name
provides a unique pointer to the name and location of the RDB associated with the driver.

The data sources defined for the currently installed drivers appear in the User DSN box in the
ODBC Data Source Administrator dialog box.

2 Select the driver you want to define as part of the data source definition.
3 Click Add to display the setup dialog for the selected driver.

4 Typethe DSN (Data Source Name). This same name must be used in the Historian for ODBC
Information table explained in the “Historian Information Table” on page 262.

5 For the setup instructions on each supported driver, see “ Defining Drivers’ on page 258”.
Defining Drivers

Within this section are subsections for each driver you can define and the syntax for the data
source you must enter in that screen and on the ODBC Historian Information table.

SQL Server Driver and Data Source

The SQL Server driver supportsthe SQL Server database system available from Microsoft and
Sybase.

Perform the following steps to compl ete setting up the SQL Server:
1 Enter the server name (where Microsoft SQL server database is located).
Enter the Database Name and then select Two Phase Commit when prompted.

Click OK to add the Data Source Name.

E N S EE ]

Click OK to close the ODBC Administrator.
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Microsoft Access Driver and Data Source

For detailed information, refer to the Microsoft ODBC Desktop Database Drivers Getting
Sarted guide. Perform this procedure to set up the Microsoft Access Driver and Data Source:

1 To create anew database, click Create. Choose the path drive and directory, such as
d:\flé60acc97, and database name, such as plantl.mdb. Click OK and the database is created,
which a popup message indicates.

2 To connect to an existing database, click Select and then OK for the path and database file.
3 Click OK to accept this setup. Then, click OK to close the ODBC Administrator.
Sybase System Driver and Data Source

The Sybase System driver supports the SQL Server 10 database system available from Sybase.
For information on the setup information you must enter, refer to the MERANT DataDirect
ODBC Drivers Reference guide. Perform this procedure to complete setting up the Sybase
System 10 driver and Data Source:

1 Typethe Server Name (from the SyberClient software that is already installed on the
FactoryLink Client computer).

2 Typethe Database Name, then click OK to add the Data Source Name.
3 Click OK to close the ODBC Administrator.

Historian Configuration Tables

A single historian task can service several client tasks such as the Database L ogger, Database
Browser, Trending, Alarm and Data Point Logger tasks. However, a single historian can only

process one database query at atime. This design can result in application performance issues
if not handled correctly, since some queries can be time-consuming and block the execution of
more critical queries.

The ODBC historian supports the configuration and execution of up to 10 instances of the task
in asingle application. This allows developers to selectively distribute the various database
queries required by the application across different running instances of the task. The
developer can route the more critical and high-speed queries to one historian instance and the
slower and less critical requests to another and thereby alleviate the performance issues
associated with asingle historian servicing all client queries.

For example, the execution of stored procedures through PowerSQL, large SELECT,
UPDATE, or DELETE queriesfrom DBBROWSE and PowerSQL and Historical datarequests
by Trending have the potentia to be time-consuming queries. However, the logging of records
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by the Database Logger or Data Point Logging tasks are generally afaster and moretime
critical operation. Therefore, one instance of the ODBC historian could be configured and run
to service all Database Logger queries and another to handle the PowerSQL and DBBROWSE
task queries.

The configuration for atrend chart using the Real-Time and Historical Trend Control requires
that the logging be routed to the same historian used by the trending task. The Multi-instance
ODBC historian still has potential for performance relief in this situation but would require a
slightly more complex configuration. One possibility is to use the Real-Time Trend Control if
you do not need historical data. Another possibility isto configure one chart for real-time only
that uses logging and trending through one historian instance, and another chart just for
historical viewing through another historian instance. The distribution can aso be set up so
that some of the queries from a specific client go to one historian instance while others are
routed to another instance.

Database queries are routed to a specific historian by defining a unique mailbox (or set of
mailbox) tags and database data source names for each instance and referencing these mailbox
tags and data source names in the ODBC task configuration tables.

The following rules apply to the configuration requirements across the historian instances:
1. Eachinstance of the ODBC historian must use a unique set of mailbox tags.

2. Eachinstance of the ODBC historian must use a unique set of Disable/Enable Connection,
Connection Status, and Database Error tags. If tags are used for the Connection String, they
must be unique for each historian instance.

3. Alias names could be the same in different instances of the historian since these are simply
symbolic references. However, this could cause confusion in debugging and interpretation
of run-time messages by operators; so it is discouraged.

4, Different instances of the historian may reference the same connection strings and thus
connect to the same database. However, connections to the same databases from different
historian instances will result in additional physical connections and must be considered
when configuring the user license requirements for database servers. Multiple referencesto
the same connection strings within one historian instance do not create multiple physical
connections to the database.

Historian Instance Number Table

The Historian Instance Number table is used to specify the instance numbers to be configured.
The instance numbers entered create a relationship to the specific configuration information
required by that instance in the Historian Mailbox Information and Historian Information
tables. (Running the Convert utility on an application that contains an ODBC historian
configuration updates the configuration tables and defines the existing configuration to
instance zero.)
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Accessing

In your server application, open Historians > Historian for ODBC > Historian Instance
Information for ODBC.

Field Description

Historian Instance Enter a number to specify the specific instance of the ODBC historian task
ID being configured. Thefirst instance to be configured is instance zero.

Create a separate mailbox or set of mailboxes for each instance of the
historian that isto be configured. Different historian instances may not
reference the same mailboxes.

Valid Entry: 0to9

Historian Mailbox Information Table

Historians process data requests queued to a mailbox. A single historian can service multiple
mailboxes, however, thereis no requirement to create multiple mailboxes for an instance of the
historian. Thereis also ho advantage in using multiple mailboxes from an application behavior
or performance standpoint. It is generally more efficient to use a single mailbox for each
Historian instance, regardless of the number of clients it services, than to have multiple
mailboxes. However, some developers may choose to use different mailboxes for purposes
related to application maintenance and readability. The mailboxes aHistorian services are
defined in the Historian Mailbox Information table.

Accessing

In your server application, open Historians > Historian for ODBC > Historian Instance
Information for ODBC > "your instance ID name” > Historian Mailbox for ODBC.

Field Description

Historian Mailbox Mailbox this Historian services. This name must match the name defined in
the task using Historian to process data requests.

Create a separate mailbox or set of mailboxes for each instance of the
Historian that is to be configured. Different Historian instances may not
reference the same mailboxes.

Valid Entry: tag name
Valid Data Type: mailbox
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Historian Information Table

Database connection information is defined in the Historian Information table. Add at |east one
entry for each uniquely defined database to be accessed by this Historian instance. Database
connection information may be shared by multiple client tasks. Multiple entries for the same
database connection are only necessary if separate control and monitoring of the connection
status (and the tables that define) are required through the use of the Disable/Enable
Connection, Connection Status, and Database Error tags. If the connection to a database viaits
defined alias closes for onetask, it will close for all tasks. If separate entries are defined, then
closing the connection for one alias does not affect the tasks using the other entries.

Accessing

In your server application, open Historians > Historian for ODBC > Historian Instance
Information > “your instance ID name” > Historian Information for ODBC.

Field Descriptions

Database Alias Unique name to represent a database connection. This must match the
Name database name defined in the client task using Historian to process data
requests.

Valid Entry: database connection name

Disable/Enable Tag that enables or disables the connection. When thistag is set to 1, the
Connection connection to the relational database defined in this entry is closed; when
set to 0, the connection opens.

Valid Entry: tag name
Valid Data Type: digita

Note: Database aliases should not share connection tags. Sharing connection tags
between database aliases can result in errors.

*Connection String  String required to connect to the database. The connection string
information defined in an ODBC driver setup must match what you define
in the ODBC Historian Information table. Use either a short DSN or along
DSN in the connection string as defined below.

DSN=data _source name
where

data_source_name is the Data Source Name defined in the ODBC Data
Source Administrator

for example, DSN=Access7 or
DSN=data_source name[;attribute=value[;attribute=value]..]
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where

[;attribute= value...]
provides optional pairs of information, such asauser ID
and password, used when more information or overrides
are needed to log on. The default values are those set in
driver dialogs.

for example, DSN=0Oracle NT; UID=flink; PDW=Fflink

Information specified in a connection string either adds to or overrides the
data source information defined in the Setup dialog for each driver. Thiscan
either be a constant or atag name. If you enter a constant, precede the
connection string with a single quote.

You must specify the connection string in the tag Default Value field and a
length in the Length field that accommodates the longest connection string
you might define for this tag if you enter atag name.

If the connection string exceeds the defined length, it is truncated and the
connection will not be made. Define 254 as the length for the best results.

Valid Entry: message or string constant of up to 254 characters
To connect to alocal Oracle database, enter the connection string as:
DSN=data_src;SRVR=;UID=userid;PWD=password
Connection Status Tag that is updated by the Historian that defines the state of this connection.

Note: Database aliases should not share status tags. Sharing status tags between
database aliases can result in errors.

Valid Entry: tag name
Valid Data Type: analog

Database Error Tag to receive the error value passed from the database software.

The tag should correspond to the type of error the relational database sends.
If it isanumber uselong analog; if it is text use message.

Valid Entry: tag name
Valid Data Type: longana or message

Note: TheDatabase Error tagisupdated only when afatal error isdefinedintheflhst.ini
file or if a database open connect call fails.
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Executing Multiple Instances of ODBC Historian
The following procedures are required to execute multiple instances of the ODBC Historian:

1 Anentry must be added to the System Configuration table for each instance of the Historian to
be executed.

2 Thefirst instance to run is always considered instance zero. Additional instances are 1 through
9, for atotal maximum of 10 instances.

3 The Task Namefiled for instance zero (the first instance) must be ODBCHIST. Thisisthe same
asin previous versions; existing applications do not require any modification to the System
Configuration table. The FLCONV function will make all necessary modifications. The Task
Name for each additional instance to be added is ODBCHISTn, where n is the instance number
(1-9).

4 The Program Argumentsfield in the System Configuration table should include a new
argument -Un, where n is the instance number (0-9). The argument is not required for the first
instance; if omitted, -U0 is assumed. The argument isrequired for all other instances.

5 Theentry in the Executable File field of the System Configuration table is bin/odbchist for all
instances.

Note: The correct operation of FLCONYV utility to convert the old ODBC Historian
tablesto new multipleinstance ODBCHI ST tables should be run on the earlier version
of the application, which has not been restored with the current FLREST option. To
transfer an earlier version application from another computer, you need to haveitin
the form of that version’s platform specific savefile, or a.zip file or similar format.

Administrative Duties for ODBC Historian

Some of the ongoing administrative duties required for ODBC are:

+ Adding and deleting drivers through the ODBC Administrator. You can open the ODBC
Administrator either from the Control Panel or from the ODBC program group.

» Adding, modifying, and deleting data sources through the ODBC Administrator program.
 Testing unsupported drivers using the ODBC driver conformance utility.

Maintaining Drivers and Data Sources

The Microsoft ODBC Desktop Database Drivers diskettes and documentation are included
with your ODBC Historian. Refer to the ODBC Getting Sarted manual regarding Access
Driversor the MERANT DataDirect ODBC Drivers Reference book regarding Oracle, the SQL
Servers, and Sybase System drivers to set up your ODBC drivers.
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Testing Unsupported Drivers

The ODBC Driver Conformance Test utility validatesthe level of conformance provided by an
unsupported driver meets the requirements of a supported data source. This utility isinstalled
by default in the FLINK/BIN directory during installation. This directory contains all the
FactoryLink program files. The executable program file for this utility is FLHSTDRV.EXE.

Before you start, a driver must be connected to a data source.
Perform the following steps to use the ODBC Driver Conformance Test utility:

Run the utility executable: FLHSTDRV.EXE to display the Data Sources dialog listing the SQL
data sources already set up through the ODBC Administrator.

Choose a data source from the displayed list, then click OK. A message natifies you of a
successful connection to the data source.

The FactoryLink Driver Conformance Test window is displayed behind the message. From this
window, the File pull-down menu lists the options:

» Connect
« Disconnect
 FactoryLink Driver Conformance Test

Choose the Driver Conformance Test option to run the test and display the test results:

¢ Successful—FactoryLink Auto-Test message confirmation of
Driver PASSED minimum FactoryLink conformance requirements

* Unsuccessful—Driver is not supported.
Click OK to display a chart that gives status details from the test.

If the test is unsuccessful, disconnect the current data source from the File menu and connect it
again. Or, you may want to connect to a different data source for another test.

Caution: Passing the FactoryLink Driver Conformance Test means that an ODBC
driver passed only the minimal FactoryLink conformance requirements
and it may work with the ODBC Historian. However, adriver could pass
the test and still be incompatible. There is no brief test available to certify
that adriver is supported completely. Testing of ODBC driversis
performed with each release and alist of the drivers that were tested and
certified for use with the release is provided in the Installation Guide.
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ORACLE HISTORIAN

This section provides information needed to configure the Oracle Historian.

Considerations

This section explains how to set your FactoryLink application to work with the Oracle
historian. Read this section before you configure your historian.

Network Software Needed

If you want to use the Oracle historian, refer to the release notes for the Oracle-specific
software to use.

Oracle Licenses

Oracle requires you to purchase licenses for the number of FactoryLink processes using an
Oracle database. Connection strings often use platform-defined aliasesto reference Oracle
Servers.

Calculate the number of Oracle licenses required for each Oracle database:
1. Onelicensefor the Database Administrator
2. Onelicense for each unique Oracle User Name and connection string pair

The minimum user requirement to connect FactoryLink to one Oracle server istwo user
licenses.

Note: Each historian running in the application creates a FactoryLink process. For
example, there are four historians (ODBCHIST, ODBCHIST1, ODBCHIST?2, and
ODBCHIST3) on aFactoryLink client computer 1, all talking with the Oracle server
computer, while on client computer 2, there are also four historians talking with the
sameserver computer. Evenif al eight historiansusethe sameuser nameand password,
for example, flink/flink, the server considers these as eight different processes. For
license information, check with Oracle.

Number of Cursors per User

The OPEN CURSORS parameter determines the maximum number of cursors per user. Before
you start the Oracle historian the first time, increase the value of the OPEN CURSORS
parameter to 200 or above. This setting isin the INIT.ORA file and has avalid range of 5 to 255.
For instructions for increasing the value of OPEN_CURSORS, refer to the Oracle RDBMS
Database Administrator Guide.
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A setting of 200 cursors may not be high enough for extremely large applications. When this
setting is not high enough, the following message is written to the directory defined by the
environment variablesin the log file ohmmddyy.log, where oh is the identifier for the Oracle
historian and mmddyy represents the date.

FLAPP/FLNAME/FLDOMAIN/FLUSER/log:
ORA-01000: maximum open cursors exceeded

Increase the value of the OPEN CURSORS parameter to 255.
Data Types Supported by Oracle Database

For information on the supported data types, refer to the Oracle documentation. In older
versions of FactoryLink, the format of the FactoryLink supported date data type had to be a
string in the format of yyyymmddhhmmss. The tag had to be defined as a message with a
minimum default length of 14 bytes to retrieve the date datatype into atag. If atag wasto
insert or update a database row with the date data type, then the tag also had to be a message
data type using previous format. FactoryLink now supports a direct conversion to and from a
long analog tag (such as SECTIME) that equates to the elapsed seconds since January 1, 1980
to the date data type.

Historian Mailbox Information Table

Historians process data requests queued to a mailbox. A single historian can service multiple
mailboxes; however, there is no requirement to create multiple mailboxesfor an instance of the
historian. Thereis also ho advantage in using multiple mailboxes from an application behavior
or performance standpoint. It is generally more efficient to use a single mailbox for each
historian instance, regardless of the number of clientsit services, than to have multiple
mailboxes. However, some developers may choose to use different mailboxes for purposes
related to application maintenance and readability. The mailboxes a historian services are
defined in the Historian Mailbox Information table.

Accessing

In your server application, open Historians > Historian for Oracle(R) > Historian Mailbox
Information for Oracle(R).

Field Description

Historian Mailbox Mailbox name this historian services. This name must match the name
defined in the task using historian to process data requests.
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Create a separate mailbox for each task that submits data requests except for
Database L ogging and Trending, which can share a mailbox.
Valid Entry: tag name
Valid Data Type: mailbox

Historian Information Table

Database connection information is defined in the Historian Information table. Add at |east one
entry for each uniquely defined database to be accessed by this historian instance. Database
connection information may be shared by multiple client tasks. Multiple entries for the same
database connection are only necessary if separate control and monitoring of the connection
status (and the tables that define) are required through the use of the Disable/Enable
Connection, Connection Status, and Database Error tags. If the connection to a database viaits
defined alias closes for one task, it will close for all tasks. If separate entries are defined, then
closing the connection for one alias does not affect the tasks using the other entries.

Accessing

In your server application, open Historians > Historian for Oracle(R) > Historian Information for
Oracle(R).

Field Descriptions

Database Alias Unique name to represent a database connection. This must match the
Name database name defined in the task using historian to process data requests.

Valid Entry: database connection name

Disable/ Enable Name of adigital tag that enables or disables the connection. When thistag
Connection isset to one, the connection to the relational database defined in thisentry is
closed; when set to 0, the connection opens.

Note: Database aliases should not share connection tags. Sharing connection tags
between database aliases can result in errors.

Valid Entry: tag name
Valid Data Type: digita

*QOracle User Login name required to connect to the database. This name must be avalid
Name Oracle account with connect, read/write, and create access to database
tables. This name can either be a constant or atag name.

If you enter a constant, precede the user name with a single quote.
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The tag specified must be a message tag type if you enter atag name. You
must specify alogin name in the tag Default Value field and a maximum
length of 32 in the Length field.
Valid Entry: tag name or constant
Valid Data Type: message of up to 32 characters

*Oracle Password Password required to connect to the database. This password can be either a
constant or atag name.

If you enter a constant, precede the password with a single quote.

The tag specified must be a message tag type if you enter atag name. You
must specify apassword namein the tag Default Value field and amaximum
length of 32 in the Length field.
Valid Entry: tag name or constant
Valid Data Type: message of up to 32 characters
*SQL *NET  SQL*Net connection string required to connect to the database. Leave this

Connect String  field blank if you want to use the default connection. This can either be a
constant or atag name.

If you enter a constant, precede the connection string with a single quote.

The tag specified must be a message tag type if you enter atag name. You
must specify the connection string in the tag Default Value field and alength
in the Length field that accommodates the longest connection string you
define for thistag. If the connection string exceeds the defined length, it is
truncated and the connection is not made. Define 64 as the length for the
best results.
Valid Entry: tag name or constant
Valid Data Type: message of up to 64 characters

Connection Status Tag updated by the Historian that defines the state of this connection.

Note: Database aliases should not share status tags. Sharing status tags between
database aliases can result in errors.

Valid Entry: tag name
Valid Data Type: analog

Database Error Name of atag to receive the error value passed from the database software.

The tag specified must be either long analog or message. It should
correspond to the type of error the relational database sends. If itisa
number use long analog; if it istext use message.

Valid Entry: tag name
Valid Data Type: longana, message
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Connecting Historian to an Oracle Database

Two key areas must be set for your Oracle historian to pass data requests to your Oracle
RDBMS.

Granting FactoryLink Account Oracle Access

You must grant access to the user account for the historian to exchange data with an Oracle
database, meaning the username and password, specified in the Historian Information table.
For the instructions on how to create an Oracle user account, refer to the Oracle System
Administration Guide.

The Oracle user account must have system privileges to connect to a database and delete,
update, insert, and select rows from a database table. Additionally, if the FactoryLink
application requires, this account may also need to create table and index privileges.

Setting Connection Strings

You must set the connection strings. This section provides the syntax to connect to SQL* Net
V1 and V2 clients. Refer to the SQL* Net documentation set for your Oracle server running on
your server host before you define a connection string to any platform.

SQL*Net V1 Syntax
@prefix:host_name:system ID
where
@ Marksthe start of the connection string
Isafield delimiter
prefix Represents the network transport
host_name Isthe server host
system ID Isthe Oracle system ID

Thisis an example connection string for the SQL*Net TCP/IP network protocol to aUNIX
server:

@T:FLORASRV:B

where
@ Marksthe start of the connection string
T Representsthe TCP/IP network transport

270 / FactoryLink Task Configuration Reference Guide



HISTORIANS | 13
Oracle Historian

FLORASRYV Isthe server host
B Isthe Oracle System ID

SQL*Net V2 Syntax
@alias

where
@ Marksthe start of the connection string.
alias Isan alias name defined in an SQL*Net V2 configuration file

This exampleisvalid across all platforms.
@FLORACLE where
FLORACLE Isanadliasconfigured in an SQL*Net V2 configuration file
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SYBASE HISTORIAN

This section provides information needed to configure the Sybase Historian.

Considerations

By default, 25 is the maximum number of Sybase connections allowed per process; however,
you can increase this maximum, which is limited only by system resources, by changing the
value set by the environment variable MAXDBPROCS. The Historian checks
MAXDBPROCS against the actual number of Sybase connections per process; therefore, if
you want to use more than 25 Sybase connections per process, set the environment variable
MAXDBPROCS to that value or greater.

Supported Data Types

For information on the data types supported by the Sybase database, refer to the Sybase
documentation. The Sybase Historian task does not support text and image data types.

In older versions of FactoryLink, the format of the FactoryL ink supported date datatype had to
be astring in the format of yyyymmddhhmmss. The tag had to be defined as a message with a
minimum default length of 14 bytes to retrieve the date datatype into atag. If atag wasto
insert or update a database row with the date data type, then the tag also had to be a message
data type using previous format. FactoryLink now supports a direct conversion to and from a
long analog tag (such as SECTIME) that equates to the elapsed seconds since January 1, 1980
to the date data type.

Historian Mailbox Information Table for Sybase

Historians process data requests queued to a mailbox. A single Historian can service multiple
mailboxes; however, thereis no requirement to create multiple mailboxesfor an instance of the
historian. There is also no advantage in using multiple mailboxes from an application behavior
or performance standpoint. It is generally more efficient to use a single mailbox for each
historian instance, regardless of the number of clientsit services, than to have multiple
mailboxes. However, some developers may choose to use different mailboxes for purposes
related to application maintenance and readability. The mailboxes a Historian services are
defined in the Historian Mailbox Information table.

Accessing

In your server application, open Historians > Historian for Sybase(R) > Historian Mailbox
Information for Sybase(R).
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Field Description

Historian Mailbox Mailbox name this Historian services. This name must match the name
defined in the task using Historian to process data requests.
Valid Entry: tag name
Valid Data Type: mailbox

Historian Information Table for Sybase

Database connection information is defined in the Historian Information table. Add at |east one
entry for each uniquely defined database to be accessed by this historian instance. Database
connection information may be shared by multiple client tasks. Multiple entries for the same
database connection are only necessary if separate control and monitoring of the connection
status (and the tables that define) are required through the use of the Disable/Enable
Connection, Connection Status, and Database Error tags. If the connection to a database viaits
defined alias closes for one task, it will close for al tasks. If separate entries are defined, then
closing the connection for one alias does not affect the tasks using the other entries.

Accessing

In your server application, open Historians > Historian for Sybase(R) > Historian Information for
Sybase(R).

Field Descriptions

Database Alias  Unique name to represent a database connection. This must match the
Name database name defined in the task using Historian to process data requests.

Valid Entry: database connection name

Disable/Enable Name of adigital tag that enables or disables the connection. When this tag
Connection isset to one, the connection to the relational database defined inthisentry is
closed; when set to O, the connection opens.

Note: Database aliases should not share connection tags. Sharing connection tags
between database aliases can result in errors.
Valid Entry: tag name
Valid Data Type: digital

*Server Name  Server name you want to connect to. The server nameisthe aias given to
the server in the Sybase Interfaces files. This hame can either be atag name
or a constant preceded by a single quote.

Valid Entry: tag hame or string constant of up to 32 characters
Valid Data Type: message
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*Database Name

*Server User
Name

*Server Password

Connection Status

Sybase database to use. This database must exist before restarting the
Historian at run time. This name can either be atag name or a constant
preceded by a single quote.
Valid Entry: tag name or string constant of up to 32 characters
Valid Data Type: message
Login name required to connect to the database. This name must be avalid
Sybase account with connect, read/write, and create access to database
tables. This name can either be atag name or a constant preceded by a
single quote.
Valid Entry: tag name or string constant of up to 32 characters
Valid Data Type: message
Password required to connect to the database. This password can either be a
tag name or a constant preceded by a single quote.
Valid Entry: tag name or string constant of up to 32 characters
Valid Data Type: message

Tag updated by the Historian that defines the state of this connection.

Note: Database aliases should not share status tags. Sharing status tags between
database aliases can result in errors.

Database Error

Valid Entry: tag name
Valid Data Type: anaog
Tag to receive the error value passed from the database software.

The tag specified must be one of the following types: long analog or
message. It should correspond to the type of error the relational database
sends. If it isanumber uselong analog; if it istext use message.

The database error tag is updated only when afatal error is defined in the
FLHST.INI file or if a database open connect call fails.

Valid Entry: tag name
Valid Data Type: longanaor message
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User Access to Server and Database

You must enabl e the Historian to access the Sybase database before the Historian for Sybase
can exchange data with a Sybase database.

Perform these steps to establish this connection:
1 Ingtall the Sybase SQL server.
2 Modify the interfacesfile.

3 Create Sybase databases. Create all Sybase databases for FactoryLink to use before you start
up the Historian.

4 Add login names for server users.
5 Add server usersto the database.

6 Grant permission to the FactoryLink account to use CREATE PROC and CREATE TABLE
commands.

For instructions on how you complete these steps, refer to the Sybase System Administration
Guide and Sybase Commands Reference.

Setting Sybase Interfaces File

All FactoryLink users must be able to read al interface files, which must reside in the Sybase
home directory. The Sybase home directory isthe directory where Sybaseisinstalled. Thiscan
be a Sybase product that allows you to connect remotely.

Use the following guidelines to modify the interfacesfile;

1 Verify theinterface file location is correct, based on:

« If Sybase SQL server and FactoryLink run on the same machine, the interfaces file resides
in the Sybase home directory.

« If the Sybase SQL server and FactoryLink run on a different machines, create the interfaces
filein the Sybase home directory.

2 Add one entry for each SQL server to the interfaces file when using more than one Sybase
SQL server.
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Granting Users Access to Create Commands

Authorized FactoryLink users of the Sybase server need permission to use the CREATE PROC
and CREATE TABLE commands.

Perform the following stepsto grant this permission:
1 Logintothe Sybase SQL server asthe System Administrator.
2 At the Sybase SQL server prompt, enter
use database
go
where
database Isthe name of the Sybase database FactoryLink uses.

3 At the Sybase SQL server prompt, enter
grant CREATE PROC, CREATE TABLE to username
go
where
username |sthe name of the user accessing the Sybase SQL server.
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DBASE IV HISTORIAN

ThedBASE IV Historianisfile-based. For large applications, it is recommended that you use a
standard multi-tier database, such as SQL Server, Oracle, or Sybase. For smaller applications
or applications with minimal logging requirements, the dBase IV Historian may be adequate.

This section describes how to configure connection information for dBASE 1V Historian,
which includes defining dBASE |V Mailboxes and defining dBASE 1V Connection
Information.

dBASE |V Historian Considerations

The Historian supports access to network drives located on afile server. Data types supported
by dBASE IV Historian are Character, Date, Decimal, Float, Integer, and Smallint.

In previous versions of FactoryLink, the format of the date data type had to be a string in the
format of yyyymmddhhmmss. The tag had to be defined as a message with a minimum default
length of 14 bytesto retrieve the date data type into atag. If atag wasto insert or update a
database row with the date data type, then the tag also had to be a message data type using
previous format. A direct conversion to and from along analog tag (such as SECTIME) that
equates to the elapsed seconds since January 1, 1980 to the date data type is now supported.

Historian Mailbox Information Table

Historians process data requests queued to a mailbox. A single Historian can service multiple
mailboxes, however, thereis no requirement to create multiple mailboxesfor an instance of the
historian. Thereis also ho advantage in using multiple mailboxes from an application behavior
or performance standpoint. It is generally more efficient to use a single mailbox for each
historian instance, regardless of the number of clientsit services, than to have multiple
mailboxes. However, some developers may choose to use different mailboxes for purposes
related to application maintenance and readability. The mailboxes a Historian services are
defined in the Historian Mailbox Information table.

Accessing

In your server application, open Historians > Historian for dBASE IV(R) > Historian Information
for dBASE IV.

Field Description

Historian Mailbox Mailbox this Historian services. This name must match the name defined in
the task using Historian to process data requests.

Valid Entry: mailbox name
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Historian Information Table

Database connection information is defined in the Historian Information table. Add at |east one
entry for each uniquely defined database to be accessed by this historian instance. Database
connection information may be shared by multiple client tasks. Multiple entries for the same
database connection are only necessary if separate control and monitoring of the connection
status (and the tables that define) are required through the use of the Disable/Enable
Connection, Connection Status, and Database Error tags. If the connection to a database viaits
defined alias closes for onetask, it will close for all tasks. If separate entries are defined, then
closing the connection for one alias does not affect the tasks using the other entries.

Accessing

In your server application, open Historians > Historian for dBASE IV(R) > Historian Information
for dBASE IV.

Field Descriptions

Database Alias Unique name to represent a database connection.
Name

Valid Entry: database connection name

Disable/ Enable Digital tag name that enables or disables the connection. When thistag is
Connection setto 1, the connection to the relational database defined in thisentry is
closed; when set to 0, the connection opens.

Valid Entry: tag name
Valid Data Type: digital

Note: Database aliases should not share connection tags. Sharing
connection tags between database aliases can result in errors.

Database Directory Directory path name where the database resides. This directory must exist
before starting this Historian at run time. The path can be either a constant
or atag name.

If you specify a constant, precede the constant by a single quote.

If you specify atag name, the tag specified must be of type message. You
must specify the directory path where the database residesin the tag Default
Value field and alength in the Length field that accommodates the longest
directory path you might define for this tag. If the directory path exceeds
the defined length, it is truncated and the connection cannot be made.
Define 66 as the length for the best results.

Valid Entry: tag name or string constant
Valid Data Type: message or string constant of up to 66 characters
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Name of an anal og tag to receive the connection status between the
Historian and the relational database. Refer to “ Database Disconnects and
Reconnects’ on page 280 for a description of the status values.

Connection Status

Valid Entry: tag name
Valid Data Type: analog

Note: Database aliases should not share status tags. Sharing status tags
between database aliases can result in errors.

Name of atag to receive the error value passed from the database software.
The Database Error tag is updated only when afatal error is defined in the
flnst.ini file or if a database open connect call fails.

Database Error

The tag should correspond to the type of error the relational database sends.
Valid Entry: tag name

Maintaining dBASE IV Database Files
Usetheinteractive BH_SQL and DBCHK utilities to maintain FactoryLink dBASE IV

relational databases. Users of dBASE |V files must have both read and write access. For more
information on how to use BH_SQL and DBCHK, see the Utilities Guide.

Reserved Words

The Historian uses the following reserved words with dBASE 1V. Do not use these keywords
when defining table or column names.

ALL DECIMAL INTEGER SET
ALTER DELETE INTERSECT SMALLINT
AND DESC INTO SOME
ANY DESCENDING IS SUM

ASC DISTINCT LIKE SYNONYM
ASCENDING DROP MAX TABLE
AVG EXISTS MIN UNION
BETWEEN FLOAT MINUS UNIQUE
BY FOR NOT UPDATE
CHAR FROM NULL VALUES
CHARACTER GROUP NUMBER VARCHAR
COUNT HAVING NUMERIC VIEW
CREATE IN ON WHERE
CURRENT INDEX OR

DATE INSERT ORDER

DEC INT SELECT
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DATABASE DISCONNECTS AND RECONNECTS

The state of the connection is maintained in a Connection Status tag. Possible states are
described in the following table. The state determines the acceptable actions you can take to
any table in the database accessible by FactoryLink.

Connection State Description
0 = Database Connection Indicates historian is not connected to the database. At
Inactive startup, historian writes a zero to the status tag for each

database. You can perform maintenance on the database
outside of FactoryLink while the connection isin this state.

10 = Normal connection Indicates historian is connected to database. SQL data
requests from FactoryLink tasks can be transmitted to and
from the database.

20 = Connecting to database | Request for a connection in progress.
30 = Disconnecting from Connection isin the process of being disabled. When the

database connection is disabled, the status returns to zero. You do not
want to maintain the database until the connection statusis
zero.

110 = Fatal Error Indicates the connection failed, resulting in afatal error. If

Condition/Lost Connection |you receive afatal error status, you can find out about what
caused the error from the contents of the database error tag.

Disconnects from arelational database can occur for either of the following reasons:
» They are scheduled to occur at predefined times.
A fatal error forces an unscheduled disconnect.

Scheduled Disconnects

You can schedul e disconnects on a periodic basis to perform maintenance on relational
database tables FactoryLink accesses. When you schedule a disconnect, you also have the
option of changing the connection from the database you are disabling to another database so
data requests can continue to be processed.

Configuring Scheduled Disconnects
You must configure a FactoryLink task to set the disable/enable connection tag defined on the
Historian Configuration table to 1 to initiate a disconnect. Once a connection is disabled, the

historian returns aHSDISABLED error code to the requesting tasks. All dataislost during the
period of disconnect.
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You must configure a FactoryLink task to write the connection strings required to connect to
the new database to the tags that define the connection you want to change. These tags are
specified in the Historian Configuration tables. Then write 0 to the disable/enable connection
tag defined on the Historian Configuration tables.

Unscheduled disconnects can occur because of fatal errors. Historians detect fatal error
conditions returned either by the RDBMS server or the network client software. The historian
tasks consider an error condition to be fatal when an error code generated by a database server
isfound in the Fatal Error Codeslist you defined in the FLINK/bin/flhst.ini file. For more
information on how to define these codes, see “ Setting Run-Time Fatal Error Code Values’ on
page 281.

Database Reconnect

Database reconnect provides the ability to reconnect to a database when the connection has
been lost. Historian reconnect is only valid when the task isrunning. The historian information
may not get updated after the reconnect if a screen is open when the database i s disconnected
and reconnected. If this occurs, exit and reenter the screen to refresh historian updating.
Reconnect does not work if the historian is brought down and then brought back up.

Setting Run-Time Fatal Error Code Values

You must define the range of numeric codes that qualify asfatal for Historian to detect fatal
run-time errors. If you are using ODBC, you must aso define the data sources and servers
supported by each operating system platform.

Fatal run-time error codes and ODBC support information are configured in the
FLINK/bin/flhst.ini file. This file contains a section for each historian and one or more ODBC
database server names.

Alphanumeric Error Codes in ODBC

Any ODBC aphanumeric error code must be surrounded by quotation marks. The
alphanumeric error code consists of two parts. The first part isthe ODBC “state” string. The
second part (enclosed in parentheses) is the native error produced by the database.

The following examplesillustrate the correct syntax.

List of FatalErrorCodes="08S01(0)”, “08S01(11)”,”08501(14)”
alphanumeric error
codes

State string only  FatalErrorCodes="08S01"

FactoryLink Task Configuration Reference Guide / 281



J 13 | HISTORIANS

Range of
alphanumeric error
codes

Database Disconnects and Reconnects

FatalErrorCodes="08501(0)” TO "08S01(14)”

The FLINK/bin/flhst.ini configuration fileis divided into sections. Each section represents a
different ODBC data source name for ODBC support information or a different historian for
definition of fatal error codes.

Following is an explanation of these entries:

#

[taskname]

IllegalDuplicateKey

FatalErrorCodes

SQLDescRequired
=True

A pound sign in column 1 identifies a comment that the historian task
ignores.

Name entered in the System Configuration table. For ODBC, it is adata
source.

Single value valid only for an ODBC data source. Other historiansignore
this.

Single value or arange of values considered fatal run-time errors to the
historian. The Fatal Error Codes can be asingle value or a single range of
values. It can also be alist where each value or arange is delimited by a
comma.

Reserved words ASCENDING and DESCENDING are shortened to ASC
and DESC for proper syntax usage by the database server.

Use any text editor to edit thisfile.

Following is a sample of the contents for thisfile.
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Sampleflhst.ini File
ODBCdmmr&—{ ## Microsoft Access ODBC Driver

Data source [ACCESS]
I17egalDuplicateKey=-1605
One fatal ) FatalErrorCodes="23000(-1608)"

error code

# Microsoft SQL Server ODBC Driver
[Microsoft SQL Server]
I[TTegalDuplicateKey=2601
Undefinedentrty _ FatalErrorCodes=
for fatal codes.
Historian ¢ # Oracle Version 7 ODBC driver
Task Name
[Oracle7]
I[TTegalDuplicateKey=1
List of fatal FatalErrorCodes=6000 to 6429, 6600, 6610, 7000 to 7100
codes {
# ORACLE Version 7 FactorylLink Historian
[OR7_HIST]
Rm@eoﬂmm_{ FatalErrorCodes=6000 to 6429

error codes

Note: The error code values listed in the Fatal Error Codes example are not actual
error codes. For the actual codes, refer to the RDBMS user’s manual.
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Handling Fatal Errors

If an unscheduled disconnect occurs because of afatal error, the information about what
caused the fatal error is written to the database error tag. The format of the error message
depends on the error tag data type.

If the error tag data type is message, the error message is written in the following format:
taskname:err_msg
where
taskname Isthe historian task name that initiated the error condition.
err_msg Isthetext from therelationa database server.

If the error tag data type is along anal og, the tag contains the database-dependent error code
number.

Every timethe relational database server returns an error code to the historian, the historian
tests this code against the range defined in the flhst.ini file.

When a historian determines an error is fatal, it sets the connection status tag to 110. What
happens next depends on how the FactoryLink application is configured to handle fatal errors.
Your FactoryLink application can reconnect to the database after an error has been resolved.

One approach is to have the FactoryLink application set the disable/enable connection tag to 1
to disable the connection to the database causing the error, then attempt to reconnect by setting
the disable/enable connection tag to 0.
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Database Type

Argument

Description

Common

-DATE<LT>

Set date or time format.

<f> = format string of the following tokens:
Token Description

year 4-digit year

yr 2-digit year

mo Month of year

dy Day of month

hr Hour (24-hour clock)

mi Minute

sc Second

These tokens must be separated by apipe( |), a
colon ( :), or ablank space.

Echo database errors to Run-Time Manager.

-i<ip

Maximum cursor inactivity time, in minutes, before
the historian task closesthe SQL cursor. The default
is 15 minutes. (# = 15 to 300 minutes)

-1

Set a maximum time in minutes of connection
inactivity before the historian task closes the SQL
connection. The default isto never close the
connection. (# = 15 to 4320 minutes)

-L<9> or
-1<4>

Enables logging of debug information to alog file.

By default logging is enabled. The historian always
logs errorsto the log file. The transaction islogged
if alogging level is specified.

Level 1 logs OPEN/CLOSE transactions for SQL
connections and cursors.

Level 2 logsthe EXECUTE and FETCH
transactions as well aslevel 1 transactions.

Level 3logslevel 1 and 2 transactions and also logs
the data supplied by the EXECUTE transaction.
Level 3 may generate atremendous amount of data.
Usually these levels are used for debugging a
FactoryLink application and should be removed for
normal operation.
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Database Type Argument

Description

Common -M<m>

Set execute mode. (M = BATCH|NOBATCH)

(continued) IS

Display database requests in Run-Time Manager
output window.

-TIME<F>

See -DATELT> above.

-U<p>

Set unique ID; for use with Multiple Instance
Historian. (#=0109)

-V

Set verbose level. (#=0104)

-X or -x

Adds extralinesto the log file giving times when
historian sent and received messages. The message
ID sequencesthese linesfor better cross-referencing
with similar linesin the historian task log file.

dBasel VvV -C

Checks database files for possible corruption before
opening thedBASE 1V file. Thischeck isdone only
if the dBASE IV Historian has this argument and
the computer isimproperly shut down, or if the
dBASE 1V Historian task aborts. In either situation,
some dBASE 1V fileswill not have closed properly.
Oncethe dBASE |V historian task is restarted, the
dBASE |V historian detects the improper event and
does not allow the dBASE 1V filesto open until the
BH_SQL task verifies them.

-F<ib>

Sets maximum number of file handles that the
dBASE IV historian can open concurrently. (# =40
to 200). A low value my cause significant
performance problems for applications that have
large numbers of tables/databases. Thisisdueto the
constant closing and opening of files. Increase this
valueif performance problems occur.

Allowsthe dBASE IV historian to be multiuser.
Every update, insert, and del ete causes the dBASE
IV file to be flushed to disk. This allows other
third-party software to view the dataasit is added
or modified by the dBASE IV historian.

-dbase

Generate dBasel V-compatible database files (with
extension = .dbf).
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Database Type

Argument

Description

Oracle

-otimeout<#>

Set timeout to wait on a blocked call. Default is 30.
(# = seconds)

-osleep<ip>

Set sleep time to retry a blocked call. Default is 50.
(# = milliseconds)

-omode<m>

Set Oracle DB mode. (m = NBL|DEF). For
example, -omode=NBL enables nonblocking mode.
Default is blocking. When using the nonblocking
mode, the enable/disable tag must be cycled for any
alias that experiences atimeout in order to clear out
pending results from the request on the server. It is
possible that after the historian timed out, the server
actually completed the request successfully. In this
case, the connection to the server may beleftina
state that requires the result to be passed back to the
historian. Thiswill prevent the execution of any
new SQL statements or receiving erroneous
returned data if the same SQL statement that timed
out is executed again.
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TROUBLESHOOTING

You can set two types of filesto record Historian operations: a Historian log file and a
Historian trace file. These two files will best help you and your support representative
troubleshoot your FactoryLink application.

Historian log files are accessible on disk for seven days. After seven days, old log files are
deleted. At the start of each new day, the previous day |og file closes and a new one opens.

Log filesreside in the FLAPP/FLNAME/SHARED/FLUSER/log directory. The name of alog file
follows the format of

PRMMDDYY.log

where
PR ldentifiesthe Historian name.
MM, DD, YY Aretwo-digit numeralsfor the month, day, year the log file was created.

The following table lists the prefix and sample log file names for each Historian.

Historian Prefix Log file - Sample name
Oracle oh 0h010195.log
DB IV d4 d4010195.1og
ODBC od 0d010195.1og
Sybase sy isy010195.1og

Entries continue to append to each .log file. Consequently, these files can grow and take up
large amounts of disk space. Delete the file contents or the file itself. Remove the Program
Arguments on the System Configuration Information table to stop logging for a Historian.

Note: Beawarethat, when using multiple historians, some or al transactions for the
various clients are synchronous while others are asynchronous. If a client executes a
synchronoustransaction with onehistorian andit doesnot respond for whatever reason,
the client must wait until the timeout period for that transaction to elapse before it can
process any other triggered transactions for any of the historians.

Use the following flowchart for help in troubleshooting the logging configuration.
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ODBC Driver

3
4

Display the Data Source Setup dialog and perform the following steps to troubleshoot the
ODBC driver:

Highlight your data source and click Options.
Click the Trace ODBC Calls check box to enable tracing.

By default, the Stop Tracing Automatically check box is enabled, which sets tracing to stop
automatically upon a disconnect from the data source. M ake note of the trace file location—
SQL.log. You can change thislocation.

Click Select File.

Define anew location. Click OK, and then click Close.

HISTORIAN MESSAGES

Run-Time

Messages may come from FactoryLink, a database driver, or data source. M essages
communicate a status or a condition that may or may not require an action from you.

Messages

FactoryLink Historians generally do not write error messages generated from a data source to
the Task Status tag. The Historian reports all database errorsto its log file and returns a status
code to the Historian client tasks, such as Database Browser for every Historian operation.

Errors and messages may display as your FactoryLink application runs. FactoryLink sends a
code or message to the Run-Time Manager screen for display whenever an error occursin a
Historian or a Historian-client task. You can also define an output text object to display codes
and messages on a graphics screen.

FactoryLink also sends alonger, more descriptive message to the log file when the log file
Program Argument is set. The Task Status tag islocated on the System Configuration
Information table. The datatype you assign to thistag for a Historian and any FactoryLink task
determines the type of codes written to this tag. You can assign these data types:

 Digital datatype reports these two codes
0—indicates the requested operation successfully completed
1—indicates an error occurred
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¢ Analog, longana, or float data type

A Historian may generate the following codes on the Run-Time Manager screen. These
status codes are returned to all tasks requesting data from a Historian. For alist of the
Database Browser status codes and status messages, see “ Database Browser” on page 73.

Code Error Cause Action

-1 A FactoryLink error A read or awrite to a mailbox Contact your technical

occurred. occurred for either a support representative.
Historian-client or a Historian task.

0 Successful operation with Historian operation was successful. | No action required.
no return data.

1 Successful operation with | Historian operation was successful. | No action required.
return data.

2 Unsolicited data sent to a An unsolicited fetch was performed | No action required.
Historian client task. for a Historian-client task.

3 Maximum OPEN A Historian-client task tried to Reference fewer than 10
connections exceeded. access data from more than 10 unigue database aliases for a

unigue database aliases. Historian-client task.

4 A dynamic memory Aninternal error occurredin a Contact your technical
allocation operation failed. | Historian-client task or in a support representative.

Historian task.

5 Historian-client task Aninternal error occurred withina | Contact your technical
referenced an invalid Historian-client task. support representative.
Historian connection
handle.

6 Failedto prepareaHistorian | Aninternal error occurred within a | Contact your technical
statement handle. Historian-client task. support representative.

7 Invalid stmtid returned from | 1) Historian shut down before 1) Shut down all Historian
Historian Browser or another Historian-client | client tasks running on the

task shut down. system. Then, shut down the
Historian. Then, start up the
Historian and then Browser
and all other Historian-client
tasks running on the system.
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Code Error Cause Action
8 Last row fetched, or no Historian task operation affected no | No action required. An
rows affected by SQL rows for an UPDATE, DELETE informational message only.
operation. operation or aFETCH for a An appropriate action isa
SELECT operation reached the end | FactoryLink applicationlogic
of the result table. In addition, for | decision.
Database Browser an attempt to
move past the end or before the
beginning of the result table
generates this error code.
9 A Historian database aliasis | A Historian-client task referenced a | Ensure all database aliases
invalid. Historian Database Aliasthat does | referenced by the Historian
not match any of the entries defined | client task exist in the
in the Historian Information table. | Historian Information table.
10 An operation exceeded its | 1. The mailbox specified asa 1. Occursin an OPEN
maximum timeout period. | Historian mailbox isnot listed inthe | connection call. Ensure
Historian mailbox table. mailbox existsin the
Historian mailbox table.
2. SQL operation is taking too long | 2- Set the program arguments
to perform. to -L2 -X on the Historian to
figure out how long the
database server istaking to
perform SQL operation.
Either change the SQL
statement to perform less
work or have the database
server do this operation
instead of the Historian task.
3. Historian task is busy with other | 3. Slow down the amount of
operations and is unable to service | work the Historian is doing
new Historian-client requests. by either ensuring the SQL
operations are not time-
consuming or slow down the
Database Logger to trigger
less frequently.
11 A Historian-client task The Historian task was terminated | Shut down all
passed an invalid Historian | before other Historian-client tasks. | Historian-client tasks running
connection handleto a on the system and then the

Historian.

Historian. Restart Historian
followed by all other
Historian-client tasks.

FactoryLink Task Configuration Reference Guide / 293




13 | HISTORIANS
Historian Messages

Code Error Cause Action

12 A Historian-client task 1. The Historian task was Shut down all
passed an invalid Historian | terminated before other Historian-client tasks running
statement handleto a Historian-client tasks. on the system and then the
Historian. Historian. Restart Historian

followed by all other
Historian-client tasks.

14 Historian-client task The FactoryLink application has Enable the Historian
operation failed because the | disabled the connection to the Disable/Enabletag to perform
Historian disabled the database by setting the Historian this operation.
connection to the database. | Disable/Enable tag.

16 An SQL operation is not A Historian-client task hasused an | If using dBASE 1V, consult
supported. SQL feature not supported by the | the chapter on SQL

Historian. limitations for the dBASE IV
Historian. If other Historian,
see the Historian log file for
the SQL statement and then
consult appropriate user’s
manual .

17 Historian database error. Thisisageneral error code for the | Read the accompanying
Historian. The error text string may | message displayed on the
contain more information. This Run-Time Manager screen or
code is accompanied by various inthe .LOG file and attempt
descriptive messages. to correct the problem based

on that message’s
instructions.

18 Unknown function request | Aninternal error occurred withina | Contact your technical
sent to Historian Historian-client task. support representative.

19 Triedtoinsert aduplicate | INSERT operation caused a No action required.
row. UNIQUE constraint error on the

database table.

20 Tableexists, tried to createa | CREATE TABLE operation failed | No action required.
table that already exists. because the table name already

exists in the database.

22 Table does not exist. You tried to access atable that does | No action required.
not exist in database.

23 Field does not exist. You tried to access afield that does | No action required.
not exist in database table.
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The following messages may display on the Run-Time Manager screen if an error occurs with
Historian at startup. See the Historian's .1og file for the compl ete message.

Error Message

Cause and Action

Bad CT record size in CT archive Cause: Thearchivefile *HIST.CT is corrupt.
filename Action: Deletethe archivefile *HIST.CT. Restart the application
to rebuild the archive file.
Bad CT type in CT archive filename Cause: Thearchivefile *HIST.CT is corrupt.
Action: Deletethe archivefile *HIST.CT. Restart the application
to rebuild the archive file.
Bad hist. mailbox in CT archive Cause: Thefile*HIST.CT contains an invalid tag name for a
filename mailbox tag.
Action: Delete theinvalid tag name from the Historian Mailbox
Information table and enter avalid tag name.
Can't open CT archive filename Cause: Either the archive file *HIST.CT does not exist or is
corrupt.
Action: Deleteit if thefile exists. Restart the application to
rebuild the archive file.
Can't open .LOG file Cause:  The Database Logging task can not open a.LOG file.
Action: Ensure the FLAPP/LOG directory exists.
Can't read record in CT archive Cause: Thearchivefile *HIST.CT is corrupt.
filename Action: Deletethearchivefile*HIST.CT. Restart the application to
rebuild the archivefile.
Duplicate mailboxes in CT archive Cause:  The Historian Mailbox Information table contains
filename duplicate mailbox tags.
Action: Delete the duplicate entry in the Historian Mailbox
Information table.
Invalid # number of CT types in CT Cause: The archivefile *HIST.CT is corrupt.
archive name Action: Deletethearchivefile*HIST.CT. Restart the application to
rebuild the archivefile.
No CTs in CT archive filename Cause: The Historian Tableis not configured.
Action: Complete the Historian table.
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Error Message

Cause and Action

No dbases defined in CT archive Cause: The Historian Information table is not configured.
filename Action: Complete the Historian table.
No mailboxes in CT archive filename | Cause: The Historian Mailbox Information table is not
configured.
Action: Complete the Historian Mailbox Information table.
Out of RAM Cause:  Not enough RAM to run this task.
Action: Restart thetask. If it fails again, allocate more RAM for
thistask or install more RAM.
SQLERROR: Can't function for task Cause: An SQL error occurred during the execution of an SQL
task_name due to error: error statement.
Action: Refer to the user manual for the database in use for
instructions for correcting this error.
SQLERROR: Can't function serial id Cause: An SQL error occurred during the execution of an SQL
with SQL statement: sqgl_statement for statement for a FactoryLink task.
task task_name due to error: error Action: Refer to the user manual for the database in use for

instructions for correcting this error.

Error Messages Recorded in Historian Log Files

The following messages may display in aHistorian .log file.

Error Message

Cause and Action

SQLERROR: Can't sql_function SQL Cause: An SQL error occurred during the execution of an SQL
statement sql_statement for task statement for a FactoryLink task.
task_name due to error: error Action: Refer to the documentation for the database in use for
instructions for correcting this error.
SQLERROR: Can't function unique Cause: An SQL error occurred during the execution of an SQL
index: unique_index for task statement for a FactoryLink task.
task_name due to error: error Action: Refer to the documentation for the database in use for
instructions for correcting this error.
Task initialization failed Cause: The Historian task isinstalled incorrectly.
Action: Reinstall FactoryLink.
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ODBC Driver and Data Source Messages
This section explains messages that can occur during the running of the ODBC Historian.
ODBC messages can come from the following:
 Driver manager
« Database manager
- ODBC driver

» Thedriver manager isaDLL that establishes connections with drivers, submits requests to
drivers, and returns results to applications. An error that occurs in the driver manager has
the following format:

[vendor][ODBC DLL]message
where
vendor |s Microsoft.

« An error that occurs in the database system includes the database name. For example, you
might get the following message from an Oracle data source:

[Microsoft][ODBC XXX driver][ XXX]message

If you get this type of error, you have attempted to do something incorrectly with the
database system. Check your system documentation for more information or consult your
database administrator.

« Anerror that occursin an ODBC driver has the following format:
[Microsoft][ODBC XXX driver]message
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MODES

Math and Logic

The Math and Logic task performs mathematical and logical operations on tagsin the
Real-Time Database. The results are stored in tags for use by other tasks. Two modes
(interpreted and compiled) are available, permitting users to optimize applications for
maximum performance. The Math and L ogic functions include the following types of
operations:

 Arithmetic * Relational

e Logica  Trigonometric

» Exponential  Logarithmic

 String Manipulation « |f-Then-Else or While Functions

 User-defined C Routines (compiled mode)

The Math and Logic task:

+ Usesastructured, BASIC-like syntax

 Executesin the background with no operator intervention at run t